OnTime

User Guide

Your reference guide for getting the most out of OnTime

October 2020 Edition
Copyright Information

Information in this document, including URL and other Internet Web site references, is subject to change without notice. The example companies, organizations, products, people, and events depicted herein are fictitious. No association with any real company, organization, product, person, or event is intended or should be inferred. Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no part of this document may be reproduced, stored in, or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of Vesigo Studios.

Vesigo may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in this document. Except as expressly provided in any written license agreement from Vesigo, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

© 2020 Vesigo Studios. All rights reserved.

The names of actual companies and products mentioned herein may be the trademarks of their respective owners.
**Technical Support Options**

**Product Name:** OnTime

**OEM distributed:** If the product came installed with a computer or device or bundled with another software application, the hardware manufacturer or software vendor provides technical support and assistance for this software. Please contact the manufacturer directly for support.

**Support Info Online:** ontime360.com/support

**OnTime Subscriptions:** Product support may be included with your Vesigo Studios OnTime subscription. Please visit ontime360.com/support for details.

**Conditions:** Vesigo Studios support services are subject to then-current prices, terms, and conditions, which are subject to change without notice.

---

### Professional Support Options

<table>
<thead>
<tr>
<th>Support Option</th>
<th>Benefits of Service</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Self-Support</strong></td>
<td>• Knowledge Base articles</td>
</tr>
<tr>
<td>For self-help tools and content specific to OnTime, visit ontime360.com/support</td>
<td>• FAQs</td>
</tr>
<tr>
<td></td>
<td>• Support Webcasts</td>
</tr>
<tr>
<td></td>
<td>• Many other online resources</td>
</tr>
<tr>
<td><strong>Incident-based support</strong></td>
<td>• Issues that cannot be resolved in the community forums</td>
</tr>
<tr>
<td>Assisted Support from Vesigo Studios for break/fix solutions</td>
<td>• Business critical support issues</td>
</tr>
<tr>
<td>Submit your incident online at <a href="http://www.ontime360.com/support">www.ontime360.com/support</a></td>
<td>• Quick fix needs</td>
</tr>
<tr>
<td>Phone support: 541-326-4200</td>
<td></td>
</tr>
<tr>
<td><strong>OnTime Advisory Services</strong></td>
<td>• Installation and configuration services</td>
</tr>
<tr>
<td>Short-term and proactive assistance for specific design, development, or deployment issues via phone.</td>
<td>• Deployment and migration services</td>
</tr>
<tr>
<td>(541) 326-4200</td>
<td>• Performance optimization services</td>
</tr>
<tr>
<td></td>
<td>• Proactive fault-tolerance planning services</td>
</tr>
</tbody>
</table>
# Table of Contents

Copyright Information .......................................................................................................................................................................................... i

Technical Support Options ............................................................................................................................................................................... ii

Welcome to OnTime ............................................................................................................................................................................................ 1

Your Feedback is Important ......................................................................................................................................................................... 1

Finding the Necessary Information ........................................................................................................................................................... 2

Overview of OnTime ....................................................................................................................................................................................... 3

Dates and Time in OnTime ...................................................................................................................................................................... 3

Security ............................................................................................................................................................................................................ 4

Working Online and Offline .................................................................................................................................................................... 4

Before Beginning .............................................................................................................................................................................................. 5

System Requirements ................................................................................................................................................................................ 5

Chapter 1: Download and Install OnTime Software ................................................................................................................................ 7

Installing on Windows 7, Windows 8, or Windows 10 .................................................................................................................. 8

To Install OnTime Management Suite ............................................................................................................................................... 10

To Install OnTime Dispatch .................................................................................................................................................................... 10

To Install OnTime Mobile for Android .............................................................................................................................................. 10

To Install OnTime Mobile for iOS ........................................................................................................................................................ 10

To Install OnTime Mobile for Windows Mobile ............................................................................................................................ 11

Chapter 2: Start OnTime for the First Time ............................................................................................................................................... 12

Configuring a Firewall .................................................................................................................................................................................. 13

Getting Familiar with the Program Look and Feel ............................................................................................................................ 14

The Ribbon ................................................................................................................................................................................................... 15

The Navigation Bar ................................................................................................................................................................................... 17

The Status Bar ............................................................................................................................................................................................. 19
Chapter 3: Setting Up an OnTime Account

Step 1: Add Users

Add a New User
General Information
Employment
Mobile Settings
Permissions
Account Type
Comments
Billing Considerations Regarding Users

Step 2: Add Locations and Zones

How to Add Locations
How to Add Zones

Step 3: Add Customers

To Add Customers Manually
To Add Customers in Bulk

Step 4: Configure Pricing

To Setup Pricing in OnTime
Remember These Steps for Pricing Setup

Step 5: Setup Notifications

To Create a New Workflow Action
Setup Driver Notifications
Checking the Status of Notifications

Step 6: Configure Company Settings

Step 7: Test, Test, Test

Testing Dispatcher Tasks
Testing Driver Tasks ................................................................................................................................. 70
Testing Notifications ................................................................................................................................. 71
Testing Prices ........................................................................................................................................... 72
Testing Customer Tasks .......................................................................................................................... 73
Testing Billing .......................................................................................................................................... 74
Congratulations, You’re Set Up! ............................................................................................................... 76

Chapter 4: OnTime Management Suite .................................................................................................. 77

Configuring Preferences ......................................................................................................................... 77
General Options ..................................................................................................................................... 77
Price Sets .................................................................................................................................................. 98
Price Set Editor ...................................................................................................................................... 98
Price Modifiers ..................................................................................................................................... 105
Classification of Modifiers ...................................................................................................................... 105
Types of Modifiers ................................................................................................................................. 105
Adjusting Prices with Actions .................................................................................................................. 105
Defining an Increment .............................................................................................................................. 106
Watch Values .......................................................................................................................................... 106
Value ......................................................................................................................................................... 107
Ranges ....................................................................................................................................................... 107
Where to Start Calculating ......................................................................................................................... 108
Additional Multiplication .......................................................................................................................... 109
Zone Based Lookup Tables .................................................................................................................... 109
Grouping Price Modifiers ........................................................................................................................ 111
Testing Modifiers .................................................................................................................................. 113
Dimensional Weight ............................................................................................................................... 116
How to Enable Dimensional Weighing ................................................................................................. 116
To Create a New Invoice ...................................................................................................................................................................... 136
To Make Changes to an Existing Invoice ...................................................................................................................................... 138
To Remove an Order from an Invoice ............................................................................................................................................ 138
Viewing and Sending Invoices .......................................................................................................................................................... 138
Posting Invoices to QuickBooks ....................................................................................................................................................... 138
Processing Received Payments ......................................................................................................................................................... 139
Posting Payments to QuickBooks .................................................................................................................................................... 139
Locations......................................................................................................................................................................................................... 141
Routes.............................................................................................................................................................................................................. 143
To Create a New Route ........................................................................................................................................................................ 143
Managing Routes ................................................................................................................................................................................... 145
Scheduling Routes ................................................................................................................................................................................. 146
Reports ............................................................................................................................................................................................................ 149
The Reports Area .................................................................................................................................................................................... 149
Modifying Existing Reports ................................................................................................................................................................ 149
Authoring Custom Reports ................................................................................................................................................................. 155
Zones................................................................................................................................................................................................................ 164
Merging Zones ........................................................................................................................................................................................ 164
Time Clock Features ............................................................................................................................................................................ 166
To Edit a User’s Time Sheet: ............................................................................................................................................................... 166
Time Clock Features in OnTime Dispatch ..................................................................................................................................... 166
Time Clock Features in OnTime Mobile ......................................................................................................................................... 167
Accessing Time Clock Data................................................................................................................................................................ 168
Employees, Subcontractors, Agents, and Partners ........................................................................................................................ 169
Importing Data .................................................................................................................................................................................... 170
How to Import a File to OnTime:...................................................................................................................................................... 170
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exporting Data</td>
<td>172</td>
</tr>
<tr>
<td>User Defined Fields</td>
<td>173</td>
</tr>
<tr>
<td>To Setup the User Defined Field List</td>
<td>173</td>
</tr>
<tr>
<td>Workflow Designer</td>
<td>175</td>
</tr>
<tr>
<td>Email and SMS Notifications</td>
<td>175</td>
</tr>
<tr>
<td>Webhook (HTTP POST)</td>
<td>175</td>
</tr>
<tr>
<td>Chapter 5: OnTime Dispatch</td>
<td>179</td>
</tr>
<tr>
<td>Orders</td>
<td>179</td>
</tr>
<tr>
<td>General</td>
<td>179</td>
</tr>
<tr>
<td>Additional Details</td>
<td>180</td>
</tr>
<tr>
<td>Map Driver</td>
<td>181</td>
</tr>
<tr>
<td>Map Route</td>
<td>181</td>
</tr>
<tr>
<td>Order Entry through OnTime Dispatch</td>
<td>181</td>
</tr>
<tr>
<td>Unassigned Shipments</td>
<td>182</td>
</tr>
<tr>
<td>Dispatching Options</td>
<td>183</td>
</tr>
<tr>
<td>Driver List</td>
<td>183</td>
</tr>
<tr>
<td>Driver Positions</td>
<td>183</td>
</tr>
<tr>
<td>Unassigned Orders</td>
<td>184</td>
</tr>
<tr>
<td>Messages</td>
<td>184</td>
</tr>
<tr>
<td>To Send a Message</td>
<td>184</td>
</tr>
<tr>
<td>Messages to Drivers</td>
<td>184</td>
</tr>
<tr>
<td>Program Options</td>
<td>185</td>
</tr>
<tr>
<td>General</td>
<td>185</td>
</tr>
<tr>
<td>Startup</td>
<td>186</td>
</tr>
<tr>
<td>Mapping</td>
<td>186</td>
</tr>
<tr>
<td>Tracking</td>
<td>186</td>
</tr>
</tbody>
</table>
Chapter 6: OnTime Customer Web Portal ........................................................................................................................................... 188
  Customizing the OnTime Customer Web Portal .......................................................................................................................... 188
    Change the Layout............................................................................................................................................................................. 188
    Change the Style.................................................................................................................................................................................. 189
    Making Changes to the Master Page and CSS Files....................................................................................................................... 189

Chapter 7: OnTime Mobile ......................................................................................................................................................................... 190
  Using OnTime Mobile for iOS ............................................................................................................................................................ 190
    To Install OnTime Mobile for iOS.................................................................................................................................................. 190
  Using OnTime Mobile for Android ................................................................................................................................................... 190
    To Install OnTime Mobile for Android........................................................................................................................................ 190
  Using OnTime Mobile Web ..................................................................................................................................................................... 190
  Using OnTime Mobile WAP Edition .................................................................................................................................................. 191
  Using OnTime Mobile for Windows Mobile ..................................................................................................................................... 191
    The Home Screen View in OnTime Mobile for Windows Mobile.................................................................................................. 192
  Time Clock Features in OnTime Mobile ......................................................................................................................................... 192

Chapter 8: Become Familiar with OnTime's Advanced Features ................................................................................................... 194
  Tracking and Modifying Orders ............................................................................................................................................................ 194
    Overview of the Layout........................................................................................................................................................................ 194
    Searching the Tracking View ........................................................................................................................................................... 198
    Working with Shipments in the Tracking View .............................................................................................................................. 209
  Reporting ........................................................................................................................................................................................................ 221
    Locating Reports in OnTime .............................................................................................................................................................. 221
    Customize Reports ............................................................................................................................................................................... 223
    Authoring Custom Reports .............................................................................................................................................................. 224
Welcome to OnTime

Welcome to OnTime, the comprehensive suite of logistics tools for shippers and carriers. This user manual covers OnTime’s individual applications and offers an overview of how all of those applications work together to unify OnTime supported businesses.

Applications covered include:

- OnTime Management Suite
- OnTime Dispatch
- OnTime Customer Web Portal
- OnTime Mobile for iOS
- OnTime Mobile for Android
- OnTime Mobile Web
- OnTime Mobile for Windows Mobile
- OnTime Mobile for Windows Phone
- OnTime Mobile for Blackberry
- OnTime Mobile WAP Edition

Your Feedback is Important

At Vesigo Studios, we believe that the success of OnTime is directly related to the success of our customers and we appreciate feedback from our customers. If a problem with OnTime arises, let us know and we will work to resolve the issue. If OnTime could work more efficiently, please convey any suggestions and we will consider implementing them. If a new feature for OnTime is imagined, we would be happy to consider adding it.

OnTime customers can submit feedback at any time through our website. Visit https://www.ontime360.com/support.aspx for a list of the ways to contact us. Every bit of feedback that we receive is cataloged for consideration. Approved suggestions may be implemented into a future version of OnTime.
Finding the Necessary Information

**OnTime on the Web**
The OnTime website offers product tours, sample modules, tutorials, tips and tricks, and in-depth articles about using OnTime. Information regarding software updates, new components, and service releases is also available on the website. Answers to frequently asked questions (FAQs), Knowledge Base articles, and other support information are on this site.

To connect to the website from within OnTime, point to the **Help** tab and click **OnTime Web Site**. The OnTime website can be found at [https://www.ontime360.com/](https://www.ontime360.com/)

**Online Help in the OnTime Applications**
In **OnTime Dispatch** and **OnTime Management Suite** click on the help button located in the upper right-hand corner of the application.

Understand Text Conventions in the **OnTime User’s Guide**

The **OnTime User’s Guide** covers the fundamentals of OnTime, focusing on business scenarios that are expected to be encountered most often. The guide uses several conventions to help to identify information:

<table>
<thead>
<tr>
<th>Text Types</th>
<th>Where</th>
<th>Type of Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAPITALS</td>
<td>Anywhere</td>
<td>Keyboard keys</td>
</tr>
<tr>
<td><strong>Bold text</strong></td>
<td>In the text</td>
<td>Elements on your screen</td>
</tr>
<tr>
<td><em>Italic text</em></td>
<td>In the text</td>
<td>Glossary terms, book titles, path names, note text</td>
</tr>
<tr>
<td><strong>Bold italic text</strong></td>
<td>Beneath figures or in the margins</td>
<td>Glossary terms</td>
</tr>
</tbody>
</table>
Overview of OnTime

OnTime greatly reduces operating expenses and overhead by centralizing data processing and storage at our secured data center, eliminating the expense and headache normally incur when operating networks, servers, and I.T. staff. With the proliferation of high speed internet connections and proprietary technologies in OnTime, the power and features of a system that traditionally costs thousands of dollars each month is available for only a couple hundred. This shift in business technology is often referred to as cloud computing; OnTime was the first to bring cloud computing to the industry.

OnTime stores all data on the user’s local computer; however, the data is also synchronized to a secured set of servers in OnTime’s data center. Information stored on OnTime’s servers may be synchronized with other computers within the user’s business. This feature allows multiple users to access the same information in OnTime from the office or from home. Because all applications in OnTime synchronize with the same database, everyone will see the same information at approximately the same time.

Vesigo Studios, the makers of OnTime, take care to back up the data stored on the servers and strive to keep a 99.99% network uptime across all services. These precautions ensure that data is protected and accessible to users at all times.

Dates and Time in OnTime

Dates and times displayed in OnTime are translated into the user’s local time zone based on both OnTime account settings and Windows Operating System settings. Be sure to set your local time zone – OnTime stores dates and times in Universal Coordinated Time to ensure accuracy across time zones and over time.
Security

Data connections to and from the server are secured with 256-bit TLS encryption.

All data on the Windows Mobile device and desktop are stored in encrypted databases. WAP enabled devices are automatically logged out after a configurable period of time to ensure protection even if a driver loses his phone.

Three-tier architecture on the server and across the software prevents data from being exposed to hackers on the internet. The OnTime Customer Web Portal is protected with multiple layers of security between services to reduce surface area attacks on the site.

For more information about OnTime’s security, please contact technical support at (541) 326-4200 or clientservices@ontime360.com.

Working Online and Offline

OnTime’s Smart Client Technology combines the productivity and performance of desktop applications with the real time connectivity of the Internet. The OnTime Dispatch and Management tools are applications that automatically exchange real-time data over the Internet to other users, partners and customers. If connection to the Internet is temporarily lost, OnTime’s Smart Client will default to offline mode. Real-time updates may be lost for a short time; however, many of OnTime’s functions will still be accessible.
Before Beginning

This section will help with successful installation and setup of OnTime. Start by identifying the system requirements of devices from which OnTime will be operated.

**Note:** No extra charge is incurred by installing OnTime software to additional machines including home, office, and portable computers.

**System Requirements**

Ensure that each device OnTime will be installed on meets the system requirements outlined below.

**OnTime Management Suite and OnTime Dispatch**

- A PC running Windows 7 with Service Pack 1 or later (32-bit or 64-bit)
- 1 gigabyte (GB) available memory
- Up to 4 gigabytes (GB) available disk space
- Display at 1280 x 800 resolution or higher

**OnTime Mobile for Android**

- An Android device running Android OS version 4.4 or higher
- Access to Google Play

**OnTime Mobile for iOS**

- An iPad, iPhone, or iPod Touch running iOS version 8 or higher
- Access to the App Store

**OnTime Mobile for Windows Mobile**

- Windows Mobile 2003, 2003 SE, 5, 6
- Internet connection for real-time data access
- 5 MB free space on device or storage card. Additional space required for company data
- Touch screen for digital signature capture
- Barcode reader for automated scanning

**OnTime Mobile for BlackBerry**

- A BlackBerry device running BlackBerry OS 5 or higher
OnTime Mobile for Windows Phone

- A Windows Phone with access to the Market

OnTime Mobile Web

- A smartphone with a web browser capable of running JavaScript

OnTime Mobile WAP Edition

- Any WAP enabled device with a data connection
- Or any mobile device with a web browser that can access the internet
Chapter 1: Download and Install OnTime Software

Start by downloading the latest version of the appropriate application from the following web page: www.ontime360.com/download.aspx

- Managers should download OnTime Management Suite
- Dispatchers should download OnTime Dispatch
- Drivers and field personnel with iOS devices should download OnTime Mobile for iOS
- Drivers and field personnel with Android devices should download OnTime Mobile for Android
- Drivers and field personnel with Windows Mobile devices and phones will want to download OnTime Mobile for Windows Mobile

**Note:** The OnTime Management Suite download includes both the Management Suite and Dispatch programs. Dispatch need not be downloaded separately if Management Suite has already been downloaded. OnTime Dispatch is made available as a separate installation if OnTime Management Suite is not installed on the computer.

**Note:** OnTime Mobile for Windows Mobile is for Windows Mobile devices only. This program will not work on other phones or mobile operating systems. Remember that Windows Mobile is not the same as the newer Windows Phone, which requires a different application.

**Note:** Close all other programs and turn off virus-protection software to prevent installation conflicts.
Installing on Windows 7, Windows 8, or Windows 10

Installing OnTime software on Windows 7, Windows 8, or Windows 10 may require administrative privileges which are sometimes blocked by User Account Control (UAC). OnTime software can be installed on Windows Vista, 7, or 8, with or without UAC turned on:

1. Download the OnTime software
2. Start the installation by right-clicking on the setup file and choosing **Run as administrator**:

3. Setup will initialize
4. If UAC is enabled, the following prompt will appear. If it does, choose **Yes** to allow

UAC prompt as it appears under Windows 7
UAC prompt as it appears under Windows 8 and 10

5. Continue setup as usual by following the onscreen prompts
To Install OnTime Management Suite

1. Download the setup file
2. Open the setup file
3. Follow the prompts to complete the installation process
4. Once installation is complete, OnTime Management Suite may open automatically (based on a choice made during installation). If it does not, go to Start menu > All Programs > OnTime System > OnTime Management Suite

A login screen will appear requesting Company ID, User Name, and Password. These are initially provided by Vesigo Studios upon setup of a new OnTime hosted account. Please refer to these credentials from Vesigo Studios when logging in for the first time. Other users must be assigned credentials by the company’s OnTime Administrator from within OnTime Management Suite.

To Install OnTime Dispatch

1. Download the setup file
2. Open the setup file
3. Follow the prompts to complete the installation process
4. Once installation is complete, OnTime Dispatch may open automatically (based on a choice made during installation). If it does not, go to Start menu > All Programs > OnTime System > OnTime Dispatch

A login screen will appear requesting Company ID, User Name, and Password. Enter the appropriate credentials and proceed to use OnTime Dispatch.

To Install OnTime Mobile for Android

1. Start Google Play on your device
2. Choose the option to search for an app and search for: OnTime 360
3. You should find OnTime Mobile within the list of search results. Open the OnTime Mobile product page and tap the INSTALL button
4. Once installed, launch OnTime Mobile from your list of installed apps. Once OnTime Mobile starts up, sign in with your driver credentials

To Install OnTime Mobile for iOS

1. Start the App Store on your device
2. Choose the option to search for an app and search for: OnTime 360
3. You should find OnTime Mobile within the list of search results. Open the OnTime Mobile product page and tap the GET button
4. Once installed, open OnTime Mobile. Once OnTime Mobile starts up, sign in with your driver credentials

Note: Some iPad and iPod Touch models do not include full GPS capabilities.
To Install OnTime Mobile for Windows Mobile

*OnTime Mobile for Windows Mobile* may be installed through a computer using ActiveSync, which is usually accomplished via USB cable. Alternately, the setup program may be downloaded and installed directly on the desired mobile device.

To Install OnTime Mobile for Windows Mobile from the Desktop

1. Connect a Windows Mobile device to a desktop computer with the appropriate sync cable
2. Download the OnTime Mobile for Windows Mobile setup file
3. Open the setup file
4. The program will begin the installation process. A dialog box will appear.
5. To save the application to a storage card, click No on this screen. To save the application to the device, select the desired location.
6. Click on the drop-down menu that appears to see all storage choices
7. Select the desired type of storage
8. Installation will occur. Complete any further steps required by the device.
9. Click OK.
10. Start *OnTime Mobile for Windows Mobile*. If it does not open automatically, go to the Start menu > Programs > OnTime Mobile.
11. A login screen will appear asking for a Company ID, User Name, and Password. Enter the appropriate credentials and proceed to use OnTime Mobile.

To Install OnTime Mobile for Windows Mobile Directly on the Device

1. Open a web browser on the mobile device
2. Navigate to http://ppc.ontimesystem.com
3. Tap the Download Now link to download the latest version of *OnTime Mobile for Windows Mobile*
4. Open the downloaded file
5. The setup program will launch. Follow the prompts to complete the installation.
6. Start *OnTime Mobile for Windows Mobile*. If it does not open automatically, go to the Start menu > Programs > OnTime Mobile.
7. A login screen will appear asking for a Company ID, User Name, and Password. Enter the appropriate credentials and proceed to use OnTime Mobile.
Chapter 2: Start OnTime for the First Time

*OnTime Management Suite* should be the first program ran. Using this program, OnTime may be configured to meet the needs of a specific business. All of the OnTime programs will present a login screen at start up.

![Login Screen](image)

Example: The log in screen for OnTime Management Suite

Log in using the appropriate **Company ID**, **User Name**, and **Password**. These will be provided in an email from Vesigo Studios during the initial account set-up.

The **Remember password** option will save the credentials. We do not recommend selecting this option on a public computer because others may be able to log in to the program using the saved credentials.

The option **Automatically sign in at startup** will automatically sign in the saved user. To turn this option off and change users, go to **General Options** > **Start up**. Uncheck the option to **Automatically sign in**, save changes, and restart the program.

Three common troubleshooting tips for signing in:

Check that the company ID, user name, and password correct. Passwords are case sensitive.

Check that the internet connection is working properly. **Tip**: Try to open a web browser and navigate to the OnTime web site at [www.ontime360.com](http://www.ontime360.com).

Check that security software or a firewall is not blocking OnTime. For more information on security issues affecting sign in, see the following section.
Configuring a Firewall

Because signing into OnTime requires logging into a web service, issues with computers' security or firewall programs may arise. Some computers have the firewall locked down very tight and will deny any program, including OnTime, the ability to communicate via the Internet. In such cases, a window such as this may appear when trying to sign in:

![Networking Help Window]

Most of these security programs have an easy way to "trust" a program, or allow a program to communicate with the internet. If so, enable OnTime as a trusted or allowed program. If such a setting on the firewall is unavailable, contact the security software vendor for more instructions.

If the problem persists, try disabling all security software and firewalls temporarily to see if that resolves the problem. If after performing these steps log in is still impossible, contact OnTime Technical Support.

**Technical Note:** OnTime makes use of standard HTTP traffic over port 80. No special ports are required outside of port 80. If a software firewall blocks OnTime, it is probably not on the whitelist of trusted programs.
Getting Familiar with the Program Look and Feel

OnTime is designed using the same layout principles as Microsoft Office applications, which often helps new OnTime users to easily acquaint themselves with the program.

In OnTime Management Suite and OnTime Dispatch, a ribbon appears across the top, offering access to common tasks. Navigation buttons that provide access to various areas of OnTime are visible along the lower left-hand side. Clicking on one of these navigation buttons will change the view to display information pertaining to the selected section.
The Ribbon

The ribbon across the top is contextual (it displays only appropriate commands).

For instance, the Home tab is always shown, but from the order entry form an additional tab with commands related to order entry is also visible.

Ribbon without context

Ribbon in Order Entry context

Double-clicking on a tab within the ribbon will shrink that tab. The ribbon can be minimized by clicking the button on the right-hand side (see below).

Ribbon fully visible

Commands will still be accessible by clicking on the tab, temporarily dropping the ribbon down.
To access the additional options and commands in the menu illustrated below, click the **File** button in the upper left-hand corner:

The File menu

Any command from the ribbon may be placed in the Quick Access Toolbar, located above the **File** menu. To associate a command with the toolbar, right-click on the appropriate button in the ribbon and choose **Add to Quick Access Toolbar**:

A shortcut to the chosen command will be added to the Quick Access Toolbar as shown below:
The Navigation Bar

The navigation bar appears in a vertical list along the left-hand side:

The navigation bar can explore different areas of the program without opening additional windows. Clicking on a navigation bar button will prompt OnTime to open the selected area in the region to the right.
To resize the navigation bar, use the resizing bars as shown here:

To completely collapse the navigation bar, click the minimize button at the top of the navigation bar:
To re-gain access to the navigation bar, click the header test, as illustrated below:

![Diagram of navigation bar and status bar]

The Status Bar

The status bar is along the bottom of the application window:

![Status bar screenshot]

The status bar provides the following information:

- The number of items displayed in the currently displayed list
- The OnTime account currently logged in to
- The current connection and synchronization status of the program with the OnTime service
Chapter 3: Setting Up an OnTime Account

Complete the following steps to appropriately setup a new OnTime account.

Step 1: Add Users

Add any person or entity who should have access to OnTime, including employees, subcontractors, agents, and partners. Remember that each subscription level comes with an included number of users and exceeding that number will incur extra fees.

Add a New User

1. Navigate to the Users area by clicking the Users button in the navigation bar
2. Click the New User button in the upper left-hand corner:

![Image showing how to add a new user]

3. Set up the new user by entering the appropriate information into the resulting window
General Information

The General section allows common information about the selected user to be entered. For example:

Sample user account

Notable fields:

- Fill out the Email and SMS gateway fields to send messages to the user in the field. The SMS gateway should be the email address version of the user’s mobile device number. For instance, with AT&T this might be in the format of 5553339999@txt.att.net. If the service provider’s email format is unknown, utilize a search engine or contact the appropriate service provider.
- Check the Allow user to receive updates via SMS text message to send SMS text message notifications to the user when events occur in OnTime.
  - Note: This may incur additional fees from the user’s cellular carrier.
- Set the Time zone to match the location of the user.
To associate an image with the user, click on the **User Image** button and locate the desired image from the hard drive.

Set the **User name** and **Password** fields. The user will need these credentials to log in to OnTime and its programs. The **User name** and **Password** may be changed in this window at any time.

If the user is an administrator, check the **Administrator or Manager (OnTime Management Suite)** to allow access to **OnTime Management Suite**.

If the user is a dispatcher, check the **Dispatcher or Customer Service Rep (OnTime Dispatch)** box to allow access to **OnTime Dispatch**.

If the user is a driver, check the **Courier/Driver (OnTime Mobile)** box to allow access to **OnTime Mobile**.

**Employment**

This section helps OnTime to track the time and activity of users.

Open the **Employment** section and fill out the necessary fields. Be sure to enter the appropriate rates for whether a user is acting as a driver or as a dispatcher.
Click on the name of a rate to view a description indicating that rate’s function. Rate values are compounded, meaning that each one will be used to calculate a grand total, allowing for more complex payment methods.

Sample user compensation

**Note:** The **Employment** section is part of higher subscription plans. If the fields within this section are inaccessible, consider upgrading to OnTime Professional or higher.

**Mobile Settings**

The **Mobile** section allows access to settings that control the experience of mobile users in the field. OnTime allows every user to have individualized settings to suit personal needs and preferences.

Select the options needed for each user:
Mobile App Options

- [ ] Start location tracking (GPS) on sign in if available
- [X] Allow access to unassigned orders
- [ ] Allow order prices to be displayed
- [ ] Allow modification of order details
- [ ] Allow access to previous signatures
- [X] Allow customer lookup in Windows Mobile 6
- [X] Allow access to clock in and clock out
- [ ] Allow transferring of orders
- [ ] Require vehicle when clocking in and clocking out

My Orders list type: Let user choose

Mobile App Synchronization

Note: The following settings affect the OnTime Mobile apps for iOS and Android only. The user of the mobile app must have their Availability setting turned on for these settings to take effect. When the user’s Availability setting is turned off, timed synchronization of data and GPS tracking are deactivated.

Synchronize the mobile app with the OnTime service at least every:

- 2 minutes when the app is active
- 10 minutes when the app is running in the background

Transmit device location (GPS) at least every 60 seconds
Record device location (GPS) at least every 60 seconds
- **Start location tracking (GPS) on sign in if available:** At startup, OnTime Mobile will attempt transmission of the user’s position via GPS (if GPS is available in a compatible format on the mobile device). We recommend selecting this option to track the positions of drivers.
- **Allow access to unassigned orders:** Order that have not been assigned to a driver will be displayed on the user’s mobile device. This option will allow the user to accept orders that have not been dispatched to another user.
- **Allow order prices to be displayed:** Allows the user to view the total price of an order.
- **Allow modification of order details:** Allows the user to edit certain properties of orders, directly from a mobile device. Editable fields include: Requested by, Quantity, Weight, Height, Width, Length, Status labels, Description, and Comments.
- **Allow access to previous signatures:** Allows the user to access previous signatures captured at a collection or delivery location. Only available in OnTime Mobile Web and OnTime Mobile for Windows Mobile.
- **Allow access to clock in and clock out:** Allows the user to use time clock features within OnTime Mobile.
• **Allow transferring of orders:** When enabled, users will be able to transfer, or reassign, orders from themselves to another driver.

• **Require vehicle when clocking in and clocking out:** Enable this option to require that drivers specify the vehicle used when clocking in and out.

• **Require contact name when collecting or delivering orders:** Enable this option to require that drivers specify the name of the contact when collecting or delivering orders.

• **My Orders list type:** Determines the style of list used to display the My Orders list on OnTime Mobile for Android and OnTime Mobile for iOS. Let user choose will allow the user to choose the visual style from within the app’s Options view. Always show as orders will display the list as orders, with one row per order. Always show as individual stops will display each stop required, with one row per stop. Orders generally consist of two stops, collection and delivery. As a result, the individual stops list type will result in a list that is longer. When used in conjunction with OnTime’s route optimization features, the list of individual stops can be sorted in the optimal order.

• **Proximity check at collection:** With this option enabled, OnTime Mobile for Android and OnTime Mobile for iOS will check if the position of the driver is within an acceptable proximity to the actual collection location. Show will display an alert verifying that the user is near the location. Show and require to be within acceptable proximity will display an alert verifying and require that the user is within the acceptable distance of the location. The user will not be able to mark the order as collected unless they are within the acceptable proximity. Disable will completely disable the proximity check and block any alerts from appearing.

• **Proximity check at delivery:** With this option enabled, OnTime Mobile for Android and OnTime Mobile for iOS will check if the position of the driver is within an acceptable proximity to the actual delivery location. Show will display an alert verifying that the user is near the location. Show and require to be within acceptable proximity will display an alert verifying and require that the user is within the acceptable distance of the location. The user will not be able to mark the order as delivered unless they are within the acceptable proximity. Disable will completely disable the proximity check and block any alerts from appearing.

• **Current acceptable proximity:** The number of meters a user can be from a location and still considered within proximity. This value can be set within General Options > General > Mapping.

• **Allow customer lookup in Windows Mobile 6:** Allows the user to search for customer contact details from within the legacy Windows Mobile for Windows Mobile application.

**Mobile App Synchronization:** Adjust these values to customize the synchronization experience for each user of OnTime Mobile for Android or OnTime Mobile for iOS. Because each user’s mobile device is different, adjusting these values can help balance battery life and performance on a device-by-device basis. These settings may vary due to mobile OS settings, such as power management.
Permissions

Permissions determine which features a user can use within OnTime Management Suite or OnTime Dispatch. To prevent a user from using a certain feature, uncheck that item in the list.

Account Type

This section defines the type of user account. Full User Account is the default and recommended setting. Inactive User Account can be used for users that are no longer active with the company.

Comments

The Comments tab presents a text field where private comments about the user may be entered. The contents of this field are not used in other areas of OnTime.
Billing Considerations Regarding Users

- Remember that each subscription level comes with an included number of users and exceeding that number may incur additional fees.
- Customers (the shippers) are not considered users. OnTime allows for an unlimited number of customers.

Situations when a User Account is not Billable

Any OnTime user that will not log into the software can be set as an Inactive User Account type. This signals OnTime to allow the user to exist, but prevents the system from counting that user as a billable user account.

If you have any questions on how the addition of users will affect the pricing on your monthly OnTime bill, feel free to contact OnTime Sales for consultation.
Step 2: Add Locations and Zones

How to Add Locations

OnTime helps to keep track of addresses serviced by maintaining a list of locations. These addresses are tagged with valuable information, such as the associated zone and the longitude/latitude coordinates. All addresses used by OnTime are stored in the Locations list.

To Access the Locations List

1. Click the Locations navigation button
2. Select Locations as the view type:

To Add Locations Manually

1. Click the New Location button in the upper left-hand corner
2. Enter the name and address of the location

TIP: Save time by entering the first part of an address into the yellow search box:
The address will be properly formatted and geocoded, allowing for distance calculation to and from the address. For example, by typing in the street and city, OnTime automatically formats and fills out the whole address:

![Address entry example](image1)

If an ambiguous address is typed in, OnTime may find multiple matches. In such cases, click on the search icon to view all possible matches:

![Address search results](image2)

OnTime will automatically attempt to recommend the appropriate zone after a postal code is entered.

**Note:** If zone-to-zone pricing is being used, select a zone for each address. Addresses that are not assigned to a zone may be inaccurately priced.

**To Add Locations in Bulk**

- Import a list of locations from an Excel or CSV file via the **Import Data** option from the **Data** tab in the ribbon. More information on how to use this feature is available later in the Importing Data section of Chapter 4.
How to Add Zones

Setting up a list of zones will be an important step for companies using zone-to-zone pricing. The name of a zone and any postal codes associated with it may be entered into OnTime.

Tip: A list of all zip codes in a particular area can be downloaded through OnTime (United States only).

To Access the Zone List

1. Click the Locations navigation button
2. Select Zones as the view type:

Note: Many couriers prefer to use distance based pricing over zone-to-zone based pricing. The setup and maintenance of distance based pricing generally consists of entering a mathematical formula. Zone-to-zone pricing requires the setup and maintenance of large grids of prices. We recommend distance based pricing for users who are unsure of which method to use to generate pricing and who can rely on distance.

To Add Zones Manually

1. Click the New Zone button
2. Enter the desired name for the new zone
3. Enter a postal code to be associated with the zone. Separate multiple postal codes with commas.
To Add Zones in Bulk

- Import a list of zones from an Excel or CSV file via the Import Data option from the Data tab in the ribbon. More information on how to use this feature is available later in the Importing Data section of Chapter 4.
Step 3: Add Customers

OnTime stores valuable information about customers such as a personal profile, pricing, and account balance. This information will allow for customers to manage their accounts online and for dispatchers to place orders more efficiently. The customer list may be accessed by clicking on the Customers navigation bar button.

To Add Customers Manually

- Click the New Customer button and enter appropriate contact information for the customer.
- To distribute the customer’s invoice to multiple departments, enter the associated names under the Departments section.
- Sub accounts for customers can be made in the Contacts section. More information on this feature is available in the Contacts section of Chapter 4.
- Skip the Notifications section for now. More information on creating those is available in Step 5: Setup Notifications in this Chapter.
- The Price Sets section will list the pricing that should be assigned to this customer. Skip this for now as we’ll be adding price sets during Step 4: Configure Pricing.
- Set the billing email address under the Billing section. This email address will later be used to email invoices to the customer.
- If necessary, change the preferred pricing method under the Billing section. The three methods to choose from are distance based pricing (default), zone to zone based pricing, and flat rate pricing.
- If appropriate click the Use billing cycle checkbox and configure the cycle’s schedule. At the end of each cycle, OnTime Management Suite will automatically notify the user to generate invoices based on all activity within that cycle.

Sample billing cycle schedule set to the last day of every calendar month.
Fill out all of the fields within the Web Portal section to allow the customer access to the OnTime Customer Web Portal: All fields here should be filled out in order for the customer to gain access to the web portal. The check box for granting access must be checked. The email address used is actually the email address from the General section. (Alternatively, the account number may be used if more appropriate.) The time zone drop down box allows you date and times to be set to be converted to the customer’s local time.

The Map section shows an interactive map of the customer’s address as specified on the General tab:

The Comment section contains a large text box for entering in miscellaneous information about the customer. Comments are kept private and are never displayed to the customer.
To Add Customers in Bulk

A list of customers from an Excel or CSV file may be imported via the Import Data option from the Data tab in the ribbon. More information on how to use this feature is available later in the Importing Data section of Chapter 4.

**Note:** Only general customer information may be imported. Specialized information for the customer, such as web portal access and billing cycles, must be set up manually.
Step 4: Configure Pricing

OnTime offers a flexible approach to pricing to help to calculate prices during order entry. In OnTime, pricing is bundled into price sets. Price sets represent contracted rates with a customer and the level of service associated with those prices. On the public facing side (to your dispatchers and customers), price sets are referred to as service levels.

To Setup Pricing in OnTime

1. Create a price set
2. Establish the base price
3. Create any necessary optional charges (price modifiers)
4. Link the price modifiers to the appropriate price sets
5. Link the price sets to appropriate customers

Creating a Price Set

To create a price set:

1. Navigate to the Prices area
2. Set the view to Price Sets:

3. Click the New Price Set button in the upper left-hand corner to create a new price set
4. Enter a **Name** to identify the price set to employees internally
5. Enter a **Service level** name to identify the price set to dispatchers and customers
6. Set the **Type** to **Customer**
7. Leave the **Percent of base price eligible for commission** (the amount of the service level used to calculate workers’ commission) at 100% for now
8. Enter **Dispatcher notes**, which will appear to dispatchers who select this service level in the *OnTime Dispatch* application
9. Enter **Customer Notes**, which will appear to customers who select this service level in the *OnTime Customer Web Portal*

Sample price set

**Set the Schedule**

*OnTime* allows for flexible schedules to be attached to price sets. For example:

Sample price set schedule (Next day service, excluding weekends, delivered by 10 AM – must be received by 2 PM)
The upper portion of the schedule specifies the dates and times that the price set will be made available. Choices include:

- **Never**: The price set will never be made available
- **Anytime**: The price set will always be made available
- **Weekly**: The price set has a starting and ending day of the week, along with times for each day. For example: Monday thru Friday, 9:00 AM to 5:00 PM
- **On specific dates**: The price set has a starting and ending date and time

**Note:** The schedule affects customers and dispatchers. Normally, the current time is used to determine if the schedule attached to a price set allows the customer to select that price set. If the current date and time is outside of the schedule, the price set will not appear in the list of service levels in the order entry screen. Dispatchers using OnTime Dispatch will see available price sets based on the date into the **date submitted** field.

When "weekly" or “on specific dates” has been selected as an option, additional fields will appear. To specify multiple entries into any of the resulting fields, click on the link labeled **Add another schedule**. For example:

- Monday – Friday, 6:00 AM to 5:00 PM
- Saturday, 6:00 AM to 2:00 PM
- Sunday, 10:00 AM to 2:00 PM

To adjust and maintain a schedule on any price set, modify the days and times as desired.

To remove one of the rows in the schedule, click the delete icon on the right-hand side of the schedule row:
The *due date offset* is the amount of time between when the order is placed and when it should be delivered. A properly configured due date offset will prevent dispatchers and customers from setting up delivery times earlier than can be guaranteed. This offset can be expressed in two ways:

- By a certain amount of time
  (Example: At any time of day, the customer will have their package delivered in 2 hours)
- By a certain time of day
  (Example: At any time of day, the customer will have the package delivered by 5:00 PM on the next business day)

Here’s how the two above examples would be setup in OnTime:

### At any time of day, the customer will have their package delivered in 2 hours

![Schedule]

### At any time of day, the customer will have the package delivered by 5:00 PM on the next business day

![Schedule]

If offsetting the due date is unnecessary, leave the **hours** and **minutes** set to zero.

At this point, a new service level has been defined and pricing should be added. Three primary methods may be used to establish a base price: zone-to-zone, distance, and flat rate.

**Note:** Prices in OnTime are calculated by calculating the base price and then calculating additional options using that base price.
Establish Zone-to-Zone Prices

OnTime offers a way to input zone-to-zone prices, allowing for simplified price generation based on a fixed amount between two points.

Zone base prices are displayed as a grid, with “from” zones across the top and “to” zones down the left-hand side. To specify a price between two zones, locate the point on the grid where the two zones intersect and enter the desired price into that cell.

Sample zone-to-zone price grid

For help specifying different amounts between zones based on direction, look at the bottom of the grid for information regarding the direction of the currently selected cell:
OnTime can help to significantly speed up the input of these prices using a few tools:

- **Reciprocal Pricing:** If an amount is entered into a cell connecting location (A) to location (B), OnTime will automatically input the same amount into the corresponding cell that connects location (B) to location (A). This feature is on by default. This feature does not apply when pasting multiple values at once.
- **Additional Actions > Fill Empty Cells With:** Automatically inputs a chosen amount into all empty cells. To use this feature, enter the desired amount (without the currency symbol) and then click OK.
- **Additional Actions > Adjust All Values:** If a grid is populated with prices and the values need to be increased or decreased enter the desired adjustment amount (without the currency or percentage symbol), choose how to apply the value (as a fixed number or a percentage), and click OK. The cells will automatically adjust accordingly. To decrease the prices, preface the amount with a negative symbol (for example: -1.50).

**Note:** Only cells that have a value will be adjusted.

**Establish Distance Based Prices**

Many OnTime users prefer distance based pricing because it tends to be easier to maintain, change, and grow than zone-to-zone based pricing.

Two things are needed to make distance based pricing work well:

1. A way to get an accurate measurement of the distance between the two points of delivery (*Acquiring the Distance* section, below)
2. A formula to calculate the price based on the distance (*Calculating the Cost for Distance* section, below)

**Acquiring the Distance**

OnTime helps to automatically determine the distance between locations. OnTime begins this process with the most accurate methods, progressing to more dependable but less accurate methods:

1. OnTime checks for previously delivered orders between the two. If a matching order is found with an associated distance, that distance will be used. If there are multiple matches, the most recent distance will be used.
2. OnTime geocodes the two addresses and plots them on a map. Distance is then measured using preferred roads.
3. OnTime geocodes the center positions of the two postal or ZIP codes on a map. Distance is then measured using preferred roads.
4. OnTime geocodes the center positions of the two postal or ZIP codes on a map. Distance is then measured as a straight line.

OnTime processes this information quickly. A progress indicator displays may be viewed in *OnTime Dispatch*:
This process is performed automatically when two addresses are entered into the order entry form. To get a distance based price on only ZIP codes, click the **Find Distances** button in *OnTime Dispatch*:

A window with space to enter two postal codes will appear. Enter the desired codes and then specify how to measure the distance in-between. Click **OK**. The calculated distance will be automatically entered into the **Distance** field on the order entry form.

To map the driving route between the two locations and acquire turn-by-turn directions for drivers, enter two full addresses into the order entry form and click the **Map Route** button:
The resulting map will offer visual confirmation that the calculated route and corresponding mileage are correct. Copy the turn-by-turn directions into the comments section of the order by clicking copy directions to order.

Sample route map

**Calculating the Cost for Distance**

Many couriers are familiar with the idea of creating a formula in a spreadsheet, such as Excel, to calculate the cost of a delivery based on the distance. Common scenarios include a flat per mile/kilometer rate or a minimum charge plus additional per mile/kilometer charges over a certain threshold. OnTime comfortably handles the same methods for calculating the cost of a delivery as programs such as Excel.

Price modifiers are a flexible way of implementing formulas for distance based pricing. Price modifiers may be compounded or nested to achieve the desired results. (The subject of price modifiers will be discussed in more detail later.)
Examples

To create a mileage price modifier:

1. Navigate to the Prices area
2. Set the view to Price Modifiers:

3. Click the New Price Modifier button in the upper left corner to open a new price modifier.
To create a flat per mile rate:

1. Enter in the required information:

   ![Price Modifier](image)

   2. Click **OK** to save

   The above example will effectively set up a pricing that charges $1.50 for every mile/kilometer over zero miles/kilometers. On a 10 mile/kilometer delivery, this modifier would calculate to $15.00.

To create a minimum charge plus additional per mile/kilometer charges over a certain threshold:

This method of pricing has two aspects: a flat minimum charge and an incremental charge (on top). This complexity is easily handled by creating two price modifiers that handle each of the two aspects and then a third modifier that will *group* the two into one and add them together. Here’s how that’s done:

1. Create the first modifier to establish the minimum charge:

   ![Price Modifier](image)
2. Click **OK** to save. This modifier will generate a price of $10.00 no matter what.

3. Create the second modifier to establish the additional per mile/kilometer charges:

![Price Modifier dialog box](image)

4. Click **OK** to save. This modifier will generate a charge of $1.50 per mile/kilometer for every mile/kilometer over 10 miles/kilometers.

Now that the two modifiers have been created, the next step is to combine them into one.

1. Right-click inside the price modifiers list and choose **New Price Modifier Group**:

![New Price Modifier Group option](image)
2. Modifiers are grouped in this window by dragging them from the list on the right to the list on the left. Create the modifier group:

![Price Modifier Groups](image)

3. Click **OK** to save.

The end result: OnTime will always charge $10.00 as the base price and will add $1.50 for every mile/kilometer over 10 miles/kilometers. On a 20 mile/kilometer delivery, this calculation would be $25.00.

Of course, OnTime is not limited to these examples. Thousands of different combinations may be employed to accommodate your business’ unique pricing methods.

Once price modifiers have been created, attach them to a price set; when a customer selects that service level, OnTime will know which price modifiers to use to calculate the price. If price modifiers are not linked to a price set, the pricing will not appear in *OnTime Dispatch* or the *OnTime Customer Web Portal*. 
How to Link Price Modifiers to Price Sets:

1. Enter the **price sets** list view:

2. Open the desired price set
3. Navigate to the **Price Modifiers** section
4. Locate the appropriate distance based price modifier in the list and link it to the price set by checking the box on the left:

If a **price modifier group** is being linked, individual price modifiers that make up that group do not need to be individually linked. Simply link the group itself and OnTime will automatically ensure that the necessary calculations take place.
5. The icon next to the charge looks like a small map. This icon indicates that the price modifier is a special modifier in charge of calculating the distance pricing.

6. Click OK to save the price set.

Combining both zone based pricing and distance based pricing into a single price set is possible in OnTime. Feel free to specify both so that your dispatchers will have additional flexibility when generating prices.

**Using a Flat Amount as a Base Price**

Flat amounts are entered by the dispatcher at the time of order entry. The **flat amount** field is available in *OnTime Dispatch* on the order entry form:

![Flat Amount Example](image)

**Creating Additional Charges**

Accessorial charges or price modifiers may include things such as fuel surcharges, POD charges, wait time, and dimensional weight. In OnTime, optional or accessorial charges are built using **price modifiers**. Price modifiers may be grouped to create complex calculations.

**Note:** Re-adjusting any price modifier will prompt all of the pricing linked to that modifier to be automatically updated. Changing one of these price modifiers can easily realign and update your total pricing. This feature is especially useful for charges that tend to change often, such as fuel surcharges.
To create a price modifier, enter the **Prices** area and select **Price Modifiers** as the view:

Click the **New Price Modifier** button in the upper left-hand corner to open a new price modifier.

- Enter a **name** for the price modifier. This name will appear to customers and dispatchers under the heading **service levels**.
- Choose the price modifier’s **type**. This option will usually be set to **General Option**.
- Set the category to Customer Price Set.
- Leave the **Percent of base price eligible for commission** (the amount of the service level used to calculate workers’ commission) at 100% for now.
- **Action** indicates the type of calculation that will be used to determine the price. More information on these types of actions is available later in the Price Modifiers section of Chapter 4.
- The **increment** box will be enabled if the modifier’s **action** is set to an incremental type, which specifies what the increment will be when counting. This value will usually be one (1) to count 1, 2, 3, 4, 5 ...
- If appropriate, set the **watch value** to indicate the field to be used in the calculation. More information on these types of actions is available later in the Price Modifiers section of Chapter 4.
- Set the **value** (the amount to charge in the calculation) for the modifier.
- Thresholds and ranges may be set using the “**start applying after**” and “**stop applying before**” boxes (when the modifier’s action is set to an overage type). The “**start calculating after**” box allows the amount at which the pricing calculation should start to be specified. This option is useful when the range of pricing is different from the amount that you want to start calculating from.
• If the modifier’s action is set to an incremental overage type, the system will automatically access the value amount over and over again based on the input specified by the watch value. In some cases, an additional set of multiplication must be involved. In such cases, set the multiply by field. Unless 2 sets of multiplication must be done, we recommend leaving the multiply by field set to none.

### Examples

A price modifier that will charge a customer if the driver is required to wait before a package is ready for collection:

In this example the first 5 minutes will be free, and $10 will be charged for every 15 minutes that the driver waits.

Here is what this example modifier would look like:

![Price Modifier](image)

Notice that the watch value is set to Custom Amount. This selection will allow an exact time period to be entered.
Here is a test of the modifier with the assumption that the order has a base price of $20 and the driver waited for 15 minutes total:

![Test Price Modifier](image)

The charge is correctly calculated at $10, plus the base price of $20, for a total of $30.

Let's consider a more sophisticated example with grouped price modifiers. In this example, we'll use a charge for insurance. Here's the pricing formula:

Minimum charge of $2 for insurance, covering up to $100 of declared value after which the charge is $1.25 per $100 of declared value.

In this case we will need two modifiers: one to define the $2 minimum charge and a second to calculate the additional $1.25 charge.

Here's what the $2 minimum charge modifier would look like:

![Price Modifier: Insurance - Base](image)
Notice that a flat amount type is used with a $2 value.

Here is the modifier that defines the $1.25 charge:

We are telling OnTime to examine the declared value on the order, and to only start accessing this charge if the declared value is over $100. If so, then we want OnTime to count in $100 increments, charging $1.25 for each one. We also request that the system starts this calculation after $100, including the $2 charge.

To group these two price modifiers together, we will right-click inside the price modifiers list and choose **New Price Modifier Group**:

In the resulting window, we drag and drop the two modifiers we just created: “Insurance – Base” and “Insurance – Incremental” from the list on the right to the list on the left.

We’ll use the **name** of “Insurance” to allow customers to easily understand what the charge represents.

The type will be a general option.
The **behavior** will be **use the sum of all modifiers**. This specification will tell OnTime to calculate each modifier in the group and add up the results.

The **Percent of base price eligible for commission** refers to the amount of this price modifier that should be used when calculating commission to workers. We will leave this at 100%.

Here's the final result:

![Price Modifier Groups](image)

OnTime will now automatically calculate the pricing for insurance without the dispatcher or customer doing more than filling out the **declared value** field.

Groups may be used to effectively automate entire pricing structures. Groups may be placed within groups, which will allow pricing to be very advanced.

**Testing Price Modifiers**

Do not leave the testing of pricing to customers. OnTime includes a testing area to help to ensure modifiers are calculating as expected.

To test a price modifier, fill out the fields required. For instance, to test a fuel surcharge, fill out the base price and mileage fields. Clicking the **Test Modifier** button will display an alert that details which fields need data included for the test to properly run.
Example

Testing a fuel surcharge that adds $0.25 per mile for every mile driven over 5 miles:

To test, we’ll click the button to show the testing area:

In the testing area, we indicate that the base price of the shipment is $20 and that the distance driven is 12 miles. After filling out those fields we click the **Test Modifier** button and view the results:

The results are shown on the right-hand side. The first line indicates whether the modifier applies: if so, a green checkmark appears indicating that the 12 miles is greater than the 5 mile threshold.
If we enter 5 miles in the test, the results change:

<table>
<thead>
<tr>
<th>Test Price Modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base price: 20</td>
</tr>
<tr>
<td>Distance: 5</td>
</tr>
</tbody>
</table>

Because a distance of 5 miles is outside of the range specified for this modifier, this value will not apply and OnTime returns a price of $0.

Returning to the previous example of 12 miles:

<table>
<thead>
<tr>
<th>Test Price Modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base price: 20</td>
</tr>
<tr>
<td>Distance: 12</td>
</tr>
<tr>
<td>Quantity:</td>
</tr>
<tr>
<td>Weight:</td>
</tr>
<tr>
<td>Dimensions: H</td>
</tr>
<tr>
<td>Declared value:</td>
</tr>
</tbody>
</table>

The results detail how the price of the fuel surcharge is calculated. Different values are color coded to display how the numbers are used; offering insight into the way OnTime calculates price modifiers. We can experiment with the setup of price modifiers and continually test results until the calculation is perfected, instilling confidence that pricing will work as intended.

**Downloading Sample Price Modifiers**

Sample price modifiers are provided by OnTime free of charge. Access price modifiers by clicking the Download Samples Modifiers link:
Sample modifiers will show price modifiers that may closely match your requirements, helping to understand how the modifiers are constructed, and how to change them to fit specific needs.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensional Weight</td>
<td>Adds $5.00 for each unit of dimensional weight calculated at a factor of 172.8.</td>
</tr>
<tr>
<td>Fuel Surcharge</td>
<td>Adds $0.25 for each mile driven.</td>
</tr>
<tr>
<td>Fuel Surcharge</td>
<td>Adds 15% of the base price to the order.</td>
</tr>
</tbody>
</table>
| Insurance           | Charges a base fee of $2.00 for up to a $100 declared value, after which the cost is $1.00 for each $100 l...

- To preview a price modifier, double-click it in the list
- To download a sample modifier to your list, select the desired modifier and click the **Download and Install** button

**Sharing Price Modifiers**

Modifiers may be shared with other couriers or saved as a backup by right-clicking the mouse on the desired modifier and selecting **Save As**. Specify a file name and click **Save**. The successfully exported, standalone file may then be sent to others.

To import a price modifier file (OTPM), click on the **Import Price Modifier** link on the left-hand side:

Open the file desired for import to display it in the list.

**Linking Modifiers to Price Sets**

To allow a price modifier to appear in the list of options available under a specific service level, the modifier must be linked to the appropriate price sets. These price modifiers (or options) are separate from base prices, which allow price modifiers to be reused across multiple price sets.
This functionality within OnTime can help to reduce. For instance, if fuel prices were to fluctuate, only the one relevant price modifier would need to be modified for all price sets linked to that fuel surcharge to be updated.

To link price modifiers to price sets:

1. Enter the **Prices** area
2. Set the view to **Price Sets**:

3. Open the price set created earlier
4. Navigate to the **Price Modifiers** tab
5. Locate a price modifier in the list and link it to the price set by checking the box on the left:
Note: For price modifier groups, individual price modifiers do not need to be linked. Link the group itself and OnTime will automatically ensure that the necessary calculations take place.

6. To have an option selected by default (may be unselected later), ensure that the Initial Selection box for that price modifier is checked:

7. To make an option be mandatory (always selected), ensure that the Required box for that price modifier is checked as shown here:

8. Click OK to save and close the price set
9. Repeat this process to have these modifiers appear in any other price sets

Linking Price Sets to Customers

OnTime can help to assign price sets to all customers, groups of customers, or individual customers:

- Open the desired price set
- Choose the Customers section
- Place a check mark next to the name of each customer to be linked to the price set:
Remember These Steps for Pricing Setup

1. Create a price set
2. Establish the base price
3. Create any necessary optional charges (price modifiers)
4. Link the price modifiers to the appropriate price sets
5. Link the price sets to appropriate customers
Step 5: Setup Notifications

Notifications that go out to dispatchers, drivers, customers, and others can be customized within OnTime. These notifications may contain a variety of information and can be sent out as emails and/or text messages. Notifications may be configured in the OnTime Workflow Designer.

Once it is setup, OnTime Workflow will send out the appropriate notifications automatically 24 hours a day, 7 days a week. No manual intervention is required.

With template messages, the content in the email message will change each time. This flexibility is vital for messages such as proof of delivery (POD) notifications where the date, time, and recipients name must be dynamic.

OnTime Workflow creates templates by offering special fields. These special fields are inserted into the message as placeholders and then substituted with the actual information from the shipment before being sent.

To Create a New Workflow Action

1. Go to the Home tab on the ribbon and choose Workflow Designer.

2. Click on the New button, which acts as a template for the new notification.
3. Give the notification a name.
4. Choose the desired event to trigger the notification.
5. The action indicates the type of notification that should be used.
6. **Special fields** may be entered to specify dynamic content within a notification. **Special fields** are in special tags with orange text. OnTime display a list of special fields when the button labeled **Insert Special Field** is clicked. You will receive a dialog that looks like this:

![Dynamic Data Fields]

Choose the field that contains the information to be inserted into the message.

### Examples

We are creating a POD for customers and we want to open it with the words:

<table>
<thead>
<tr>
<th>Dear Valued Customer,</th>
</tr>
</thead>
</table>

Our message will look like this in the template:

<table>
<thead>
<tr>
<th>Subject: Delivery Complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dear Valued Customer,</td>
</tr>
</tbody>
</table>
But that is too impersonal; we insert the customer’s name so that it reads like this:

Dear Fred Smith,

In that case, we will insert a special field like this:

![Dynamic Data Fields]

We changed the **Context** to **Customer** to locate the customer information associated with the order. From there we select the **Name** field, which indicates the primary contact’s name at that company. Our message changes to this:

![Subject: Delivery Complete]

We could leave it at that, but what if we don’t have a contact name for a customer? The notification will be missing the name, looking like this:

Dear,

Fortunately, OnTime offers a safety net for situations like this where the original data is missing or not available. This safety net is the **default** value.
In the example below, we have specified that the contact name be used, but in case that the name is not available, the default value, “Valued Customer” will be used:

Now our message will contain the special field along with a default. When this message is sent out, when a contact name is available it may read like this:

Dear Fred Smith,

And when no contact name is available, it will read like this:

Dear Valued Customer,
Here is a sample of what a proof of delivery (POD) notification may look like in final form:

<table>
<thead>
<tr>
<th>Workflow Notification Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name:</strong> Delivery Notification to Customer</td>
</tr>
<tr>
<td><strong>Scope:</strong> Only selected customers can trigger this</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
</tr>
<tr>
<td><strong>Area:</strong> Orders</td>
</tr>
<tr>
<td><strong>Event:</strong> Order delivered</td>
</tr>
<tr>
<td><strong>Action:</strong> Send Email</td>
</tr>
<tr>
<td><strong>Content</strong></td>
</tr>
<tr>
<td><strong>From:</strong> Vesigo Studios <a href="mailto:notify@ontimesystem.net">notify@ontimesystem.net</a></td>
</tr>
<tr>
<td><strong>Reply to:</strong> Dispatcher Email</td>
</tr>
<tr>
<td><strong>To:</strong> Customer Email</td>
</tr>
<tr>
<td><strong>Cc:</strong></td>
</tr>
<tr>
<td><strong>Bcc:</strong></td>
</tr>
<tr>
<td><strong>Subject:</strong> Delivery Complete: Order Tracking Number</td>
</tr>
</tbody>
</table>

Dear [Customer Name],

Your shipment has been delivered by [Driver First Name] [Driver Last Name], one of our qualified drivers. The tracking number for the shipment is: [Order Tracking Number]

This order was shipped under the following service level: [Order Service Level]

[Order Acquired From]

[Order Scheduled Collection Date]

[Order Actual Collection Date]

There are thousands of different combinations of notifications that may be created with this workflow system. These **special fields** may be used in any field of the message, including the **From, To, CC, and BCC** fields.
**Setup Driver Notifications**

Using the same steps used above (in To Create a New Workflow Action), we can create a notification that will be sent out to drivers every time that an order is assigned to them.

**Example**

We will send the message to drivers as an SMS text message. Because text messages are usually restricted to 160 characters or less, we'll keep it very brief:

This setup will send a message to the driver’s SMS gateway address (email formatted number such as 5553339999@txt.att.net) and will contain limited information about where the shipment is going and what it is.

Once entered, this workflow will activate every time a driver is assigned to a shipment and the message will go out only to the driver being assigned.
Checking the Status of Notifications

Because OnTime Workflow allows thousands of notifications to be sent automatically throughout the day, sometimes messages may have problems preventing them from being sent. Any and all issues with mailing notifications are listed under **Pending Notifications**, available under the **Home** tab of the ribbon:

![Pending Notifications](image)

This window will show any problems with messages including:

- The order involved
- The number of times the message attempted to send
- The error encountered when sending
- The workflow action (or notification) involved

![Notification Status](image)

By default, OnTime will immediately attempt to send the message 10 times; if these attempts are unsuccessful, the message will be attempted once an hour.

Once the error is corrected, forcibly resend all the messages in the queue by clicking the **Process All Messages Now** button. To remove a message from the queue and ensure that delivery attempts are no longer made, right-click the desired message(s) and choose **Remove Item**.
Step 6: Configure Company Settings

Most company settings can be found from OnTime Management Suite under the General Options button in the ribbon:

- The business information specified in the General section is used throughout the system. Most notifications will fail if the email address is unspecified.
- Set the primary time zone to the local time zone.

- Under the Order Entry section, choose how to generate tracking numbers. By default, random numbering is used, but sequential tracking numbers may be selected instead.
• Enter the **Personalization** section to make some changes to default terms such as shipment, package, or customer. Be sure to enter and capitalize the singular and plural forms. For example, to change the term order to delivery, enter:

![Terminology screenshot](image)

- Setting the default time zone for drivers connecting with mobile devices will allow the correct dates and times to be displayed in *OnTime Mobile*. This setting may be altered by selecting the **Home** tab from the ribbon and clicking the **Mobile Options** button.

![Time Zone screenshot](image)
Step 7: Test, Test, Test

All configurations within OnTime should be thoroughly tested before being made available to customers and teammates.

We recommend passing several orders through the system in order to ensure that:

- Dispatchers and drivers have the information needed
- Notifications are sent out properly
- Pricing works as expected
- Customers have a good experience
- Billing flows smoothly

The following sections explore some suggestions to ensure that these primary areas are tested.

Testing Dispatcher Tasks

- Test that the dispatcher will be able to log into OnTime Dispatch using his user name and password
- Setup the dispatcher with an email address in their user account profile. Several areas of OnTime depend on sending out messages from dispatchers and require a return email address. Use a common email address if all dispatchers will be sharing a common address.
- Have dispatchers try entering in a few orders to ensure they are comfortable with the process of submitting new orders.

Testing Driver Tasks

- Test that the driver will be able to log into OnTime Mobile using his user name and password. If the mobile device that the driver is using is available, try installing the application and logging in as the driver on that mobile device.
- If SMS text messages will be used to send notifications to drivers, ensure that each driver has the SMS Gateway field filled out (under user profile) with the address for the applicable mobile device. If that field is not filled out properly, the driver will fail to receive automated notifications.
- Try to send a few notifications and check if the driver properly receives the tests. Do this before sending the driver out into the field.
- If the driver will be in a different time zone than the company’s primary time zone, set the time zone under the driver’s user profile. Otherwise times and dates may appear inaccurate for that driver.
- Test the compatibility of devices with OnTime Mobile. Some mobile devices support digital signature capture and GPS, while others do not. Be sure that the devices you use will be compatible with whichever features are most important to your company. For detailed information regarding compatibility, contact OnTime Technical Support.
- Provide some time for drivers to become familiar with the flow of the OnTime Mobile software by passing a few test orders through the system.
Note: If tracking time and activity of drivers will be important to your company, ensure that drivers are using the time clock features responsibly. If the driver is not clocking in and out, OnTime will not be able to accurately determine their activity.

Testing Notifications

Notifications are setup primarily under the OnTime Workflow Designer. This method offers a very flexible and powerful approach to sending notifications; however, that flexibility can leave room for mistakes.

- Use default values where appropriate. That way if the information in the special field is not available, the default can be used, which is especially important when addressing the “from” and “to” fields in an email or text message.
- Check the notification status window occasionally to ensure that all notifications are going out properly. Any problems will be shown there along with hints as to what the problem may be.

Try putting your email or text message address in the CC or BCC fields of the workflow notification. That will help ensure that the content going out to customers or drivers is accurate, because you will receive a copy each time. Once you are confident in the reliability of that notification, simply remove your address from the CC or BCC fields.
- When using SMS text messaging or paging to send to drivers, check with the mobile provider for any additional charges that the driver may incur for text messages received. If you plan on using this method frequently, drivers should have unlimited text messaging plans, eliminating the possibility of overage charges from the mobile providers.
• Sometimes a notification may be delayed before going through to the recipient. There can be many reasons for this, including networking congestion with the mobile provider.

**Note:** Typically, there can be anywhere from 0 to 5 minutes before an SMS notification is received by the recipient. If you have delays longer than that, contact your mobile provider.

**Note:** Mobile providers do not always guarantee that a text message sent to a mobile device will actually get there. It’s always a good idea to call and confirm an important assignment with your driver rather than relying solely on an SMS text message.

**Testing Prices**

OnTime offers the most powerful and flexible pricing engine in the courier software market. Be sure to test out pricing to ensure that the different specifications customers may require are possible.

• When using zone-to-zone pricing, make sure that locations entered into OnTime are associated with a zone. If locations are left unassociated, the postal code from the location will be used to match a zone, decreasing the accuracy of pricing.

• When using distance based pricing, make sure that the price set has been properly configured to use a distance based price modifier. If the price set is not configured, the distance base price will appear as $0.00, no matter the distance.
• Accessorial charges, or price modifiers, have a testing harness included. Several different scenarios may be simulated to test the modifier’s evaluation.

![Test Price Modifier](image)

Testing a fuel surcharge price modifier

• Create a test customer for and then link that customer to the price sets are being tested. Then, using the OnTime Dispatch program, create new orders while watching the pricing. Altering entries on the order entry form will cause the price to be recalculated. For instance, if you wanted to test your distance rate, just adjust the distance field up and down to see how the price will be affected.
• Try submitting a few of these test orders into the system to ensure that pricing continues to operate as intended.
• Test pricing structure by creating test orders in OnTime Dispatch to start simplifying pricing. Removing redundancies and excess options from order entry will help customers and dispatchers to better use and understand pricing.

**Testing Customer Tasks**

• Create a fake customer for testing purposes. Use this customer to test pricing and other configurations before allowing access to real customers.
• When adding a customer to OnTime, be sure to double check their pricing and billing options. You don’t want to give the wrong rates to the wrong customer by accident.
• When adding a customer that will have access to the OnTime Customer Web Portal, always try logging in as that customer to ensure that everything is setup properly. The easiest way to do this is by clicking on the link shown here:

Log in as that customer gives you the opportunity to see exactly what your customer will see. In the web portal, try entering in a few test orders to ensure that the pricing and options are clearly described for the customer. Dispatchers and customer support representatives who do this test often become familiar with the customer experience on the Web Portal and can provide optimal customer support.

**Testing Billing**

An important part of every business is the billing of customers. If the pricing structure has been well tested, billing will likely go smoothly; however, if the pricing structure is complicated to begin with, invoices may be difficult for customers to understand.

Here are some tips to ensure that billing goes smoothly:

• If customers are on different billing cycles, setup their schedules as soon as possible. OnTime cannot know a customer’s billing cycle until it is defined.

• Print an invoice to check if visual customization is desired. If so, make the desired changes in the Report Designer.

• Invoices, by default, should print out so that the address displays through a #10 windowed envelope. If you need to use a different envelope type or will be printing the invoices on pre-printed forms, customize the invoice’s layout (using the Report Designer) and test to ensure print layout is correct.
• To reset an invoice back to its original state, click **Reset**:

![Reset button](image)

• If payments will be processed through OnTime to track customer balances, enter the payment received in OnTime. The connection with QuickBooks will not pull payment information from QuickBooks into OnTime. OnTime will only push payment information out to QuickBooks.

• Test OnTime’s connection to QuickBooks by sending a few invoices or payments over. Verify in QuickBooks that the information (invoice or payment) has been properly entered.

• To have information from invoices sent to QuickBooks in a certain manner, configure the options:

![QuickBooks Options](image)

• Create a test customer and attempt to test the emailing, printing, or faxing of invoices to that customer.  
*Note: Faxing incurs an additional fee to use.*
To inquire about a specific testing issue, feel free to contact OnTime Customer Support for assistance before placing the system into production.

Congratulations, You’re Set Up!

We’ve covered the basics of getting OnTime setup for your company and you can start using it in your operations:

- Step 1: Add Users
- Step 2: Add Locations and Zones
- Step 3: Add Customers
- Step 4: Configure Pricing
- Step 5: Setup Notifications
- Step 6: Configure Company Settings
- Step 7: Test, Test, Test

Remember, there are hundreds of other features in OnTime that you’ll discover over time. The remainder of this user guide explains most of those features in detail.
Chapter 4: OnTime Management Suite

OnTime Management Suite is the application used by managers to administer the OnTime company account. This chapter contains information about the features and functions in OnTime Management Suite.

Configuring Preferences

Most preferences are controlled from within OnTime Management Suite. The following sections will discuss these areas.

General Options

The general options area allows for the modification of multiple OnTime preferences. Many of the settings altered within the general options area will affect every user in OnTime. To access the general options section, click the General Options button under the Home tab of the ribbon:

A drop down menu will appear with shortcuts to several categories of settings. We’ll start with General.
General

Company Information

Fill out the company information accurately; these values are used throughout the OnTime company account. The email address will oftentimes be used as a return address for notifications and alerts. If the email address is missing or invalid, messages may fail to send.

General

Set the Primary time zone to the time zone of the business headquarters.

Set the Primary culture to the language and region of the business headquarters.

Startup

Show Start Page: When enabled, the program will always startup with the Start view selected. Otherwise, the last selected view before the program was previously shut down will be displayed.

Check for program updates: The program will automatically notify you of available updates each time the program is started.

Check for OnTime Extension updates: If OnTime Extensions are installed from the extension directory, the program will check if any updates to the installed extensions are available.

Automatically sign in: If checked, the program will automatically sign in when starting up the program. Uncheck this box to prevent the program from signing in automatically, such as when there is a need to log in under a different user account.

Mapping

The Routing service may be either Google Maps or Bing Maps. The mapping unit may be set to either miles or kilometers, whichever is most appropriate. The country/region should be set to the most relevant location. The choices are:

- North America and the Caribbean
- Asia/Pacific
- Europe
- Other

Automatically geocode addresses when added or modified: Enable this setting to automatically geocode new addresses or existing addresses that have been modified. This can help confirm accurate placement of locations on a map, ensuring more accurate distance calculations.

Disable geocoding accuracy: When enabled, the accuracy when recognizing addresses on the map is reduced. In turn, this can cause inaccurate distance calculations. Disabling geocoding accuracy may be useful in regions where street addresses are not always available or specific enough.
Use previously calculated route distances: When enabled, this setting will use the distance previously calculated between two locations. This helps ensure consistent distance calculations and is also faster than waiting for mapping services to calculate the distance. It is recommended to leave this setting enabled.

Home location: This setting is used during route optimization. Set the home location to a location record that represents the starting point for most drivers. For example, business headquarters, a warehouse, or a hub.

Default stop duration: This setting is used during route optimization. Set the default stop duration to a number that represent the average number of minutes a driver is expected to spend while at a stop. This allows the route optimizer to factor in the time spent at stops. The stop duration can also be set on individual location records, but in cases where the stop duration is not set on a location record, this default value will be used.

Dispatching

Group driver list by: This affects the grouping of the driver list within the Dispatching view of OnTime Dispatch. Choices include:

- None: No grouping is applied.
- Availability status: Based on driver availability (as set by a driver in OnTime Mobile), the driver list will group users by Available and Not Available.
- Mobile app sign in status: Based on whether or not the driver is currently signed in to OnTime Mobile, the driver list will group users by Signed In and Signed Out.
- Time clock status: Based on whether or not the driver is currently clocked in via OnTime Mobile, the driver list will group users by Clocked In and Clocked Out.

Reports

Where possible show multiple selection reports as: Many reports within OnTime may be generated on more than one record at a time by selecting multiple records. This setting controls whether the reports are displayed as a single document or multiple documents. Choices include:

- A single document: When multiple records are selected, the generated reports will merge all pages into a single document and, in the case of a preview, a single preview window.
- Multiple documents: When multiple records are selected, the generated reports will keep all pages separate and, in the case of a preview, multiple preview windows will appear.

Users

User Password Policy: Enforce password policies for all user accounts. Select the options that meet your organization’s criteria for appropriate passwords. Once set, all new and changed passwords will need to meet the criteria set. This setting will not retroactively flag existing passwords, only new and changed passwords.
Program Updates

Update channel: Choose between three different update channels:

- **Preview Release**: Get program updates as soon as they are released. This is a good setting if you would like to get access to the latest features and fixes available.
- **Current Release**: Get program updates that have received more testing and are of higher quality. This setting is appropriate for most users.
- **Deferred Release**: Get program updates less frequently.

This setting applies only to the local computer.

Personalization

General

Color theme: The user interface of the program may be adjusted to use different color schemes, based on personal preference. Available color schemes are **Colorful**, **Light**, **Dark**, and **White**.

Row spacing: This sets the height of rows across many of the lists in OnTime. Choices include **Narrow**, **Normal**, and **Wide**.

To reset the user interface to its default settings, click the link labeled **Reset primary user interface layout**.

Use 24-hour clock formatted time: When enabled, all times will show in 24-hour format instead of the default 12-hour time format, which shows time in AM and PM. For example: 13:00 instead of 1:00 PM. After changing this setting, OnTime must be restarted for the setting to take effect.

Pay sounds: Uncheck the box play sounds to silence sound effects when events occur.

To use customized sound effects, click the option labeled **Play custom sound when new items arrive** and select a WAV audio file. Return to the default sound effects at any time by selecting the option labeled **Use default sound**.
**Terminology**

The terminology used within OnTime may be changed to further custom tailor the system. Entries are case sensitive; capitalize where necessary.

For example, to change the term shipment to delivery, enter:

![Terminology Table]

Save and sync with the OnTime server to propagate the changes across the organization. Some programs may need to be restarted to see the changes.

**Order Entry**

**General**

Require that dispatched shipments contain a delivery location will require dispatchers using OnTime Dispatch to specify both a pickup and delivery address before submitting the order. For on-demand orders, the pickup location is always required.

Use same day delivery cut off time: This option will cause OnTime Dispatch to automatically set the due date of orders to the next day if the time of day is past the specified time of day. Set the cut off time to the time of day that you would like this to occur.

Apply price set due date offset as: This option applies to the offset in delivery time for price sets. Two options are available:

- **Time between pickup and delivery due dates**: This option will take the amount of time specified in the offset and ensures that the latest delivery arrival time (or due date) is later than the latest pickup arrival time by at least the amount specified in the offset.

- **Time inside of pickup and delivery windows**: This option will take the amount of time specified in the offset and will ensures that much time exists between the earliest and latest arrival times for both pickup and delivery locations. This option will usually result in the pickup and delivery times being the same, but with a large window of time for each.

Warn when due date offset is not valid: when enabled, a warning will appear to the user if the due date for the order is set to a time earlier than the calculated offset time.

Apply price set schedule to: Each price set can implement a schedule indicating when the price set is available for customer use. This sets the type of date relative to the schedule. Choices include:
• **Current date and time**: Schedule will always behave relative to the current date and time.
• **Collection date and time**: Schedule will always behave relative to the latest collection date and time.
• **Delivery date and time**: Schedule will always behave relative to the latest delivery date and time.

**Preform zone recommendation by referencing**: OnTime can recommend that a location be assigned to a specific zone, based on the location’s postal code. Choices include:

- **All zones**: All zones within the account will be referenced when making a recommendation.
- **Only zones in selected price set**: Price sets can be configured to limit the zones that are serviced. This setting will reference only zones within the currently selected price set when making a recommendation.

**Recommend zone based on**: OnTime can recommend that a location be assigned to a specific zone, based on the location’s postal code. This recommendation is based on a comparison of the location’s postal code with the postal code(s) listed under each zone. This setting controls how the comparison takes place. Choices include:

- **Exact match**: Only exact matches between the two postal codes will be used. This works best for the ZIP Code system within the United States. If there are multiple matches, the first zone alphabetically is chosen.
- **Best match (left-to-right traversal)**: The best match possible between the two postal codes will be used. This works by comparing each letter or number in the postal code, starting with the first, or leftmost, character. The comparison continues with each character to the right until only one matching zone is remaining. This works well for postal code systems, such as in Canada, where the geographic location becomes more specific with each character from left to right. If there are multiple final matches, the first zone alphabetically is chosen.

**Always use recommended zones when calculating prices**: If zone based pricing is used, turn this setting on to use zone recommendations when calculating against locations that do not yet have a zone formally applied. If this setting is turned off, both the collection and delivery location must have zones previously set in order for pricing to calculate.

**Show customer comments**: Customer records have a section for private comments, such as notes or instructions regarding the customer. Enabling this option will allow that information to be displayed to dispatchers in the order entry form in OnTime Dispatch. These comments are never shown to the customer and will not appear on the OnTime Customer Web Portal.

**Show location comments**: Location records have a section for private comments, such as notes or instructions regarding the location. Enabling this option will allow that information to be displayed to dispatchers in the order entry form in OnTime Dispatch. These comments are never shown to the customer and will not appear on the OnTime Customer Web Portal.

**Configure Required Fields**: Click this button to view a list of fields that may be made mandatory. Place a check box next to each field that should be required and then click **OK** to save the changes. The selected fields will be required in OnTime Dispatch and the OnTime Customer Web Portal before order submission. This option makes global changes. To make fields required for a specific customer only, see the required fields option under that customer’s record.
**Tracking Number Generation**

OnTime generates a unique tracking number for each order entered into the system. These tracking numbers can be generated in two ways:

- **Sequential numbering**: The tracking number is a number (maximum of 9 digits) that will always be at least one numeric value higher than the previously generated tracking number. Because unauthorized persons may be able to guess, or predict, sequential tracking numbers, large carriers such as UPS, FedEx, and the USPS do not use sequential numbering.

- **Random numbering**: Each tracking number will be randomly generated. Unauthorized persons will have less than a one in one billion chance of predicting a tracking number with this system. Randomly numbered tracking numbers can be generated faster than sequential numbering, especially in offline scenarios.

If using sequential numbering, the next tracking number may be seeded by clicking the blue link and entering in a number. The next order submitted will use this number + 1.

Tracking numbers may be reformatted to fit individual business needs. The **tracking number mask** defines the format of the tracking number for on-demand shipments. A tracking number mask can include alpha-numeric characters including symbols such as dashes. The pound symbol (#) is used as a place holder for a randomly generated number, determined by the **tracking number digit length**. This number can be a maximum of 9 digits long. Be sure to use longer tracking numbers that change often for consistent variety.

Consider this example:

<table>
<thead>
<tr>
<th>Use sequential numbering</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current tracking number:</strong> 12258</td>
</tr>
<tr>
<td><strong>Note:</strong> Also applies to tracking numbers assigned to scheduled route stops.</td>
</tr>
</tbody>
</table>

In this case a random 9-digit number is generated. That number will be placed where the hash symbols (#) appear in the mask.

We’ve added “TN” and some dashes (-) to the tracking number to help break it up and make it more readable. If the random 9-digit number generated is 123456789, the final tracking number will look like:

TN-123-456-789

**Orders On Hold**

When orders are placed on hold in OnTime Dispatch, a unique reference number (called an on hold number) is generated for the dispatcher to give the customer. Orders that are placed on hold may be assigned a random
number using a custom format. Use the same procedure as above to customize the appearance. The following example could result in a on hold reference number formatted as: Q12-345

<table>
<thead>
<tr>
<th>Hold number digit length:</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold number mask:</td>
<td>Q##-###</td>
</tr>
</tbody>
</table>

**Tracking**

This section contains settings which relate to the Tracking view within *OnTime Management Suite* and *OnTime Dispatch*.

**General**

**Automatically optimize the number of days of data displayed in the Tracking view:** The number of orders displayed in the Tracking view can grow larger over time. To ensure optimal performance, keep this option enabled. To override this optimization and manually set the number of days’ worth of data to display, uncheck this option and enter a value for **Manually set the number of days of data displayed**.

**Limit searching and filtering to data displayed:** When selected, this option will limit searching and filtering to orders within the “number of days of data displayed.” When this option is disabled, searching or filtering will reference ALL orders and will ignore the “number of days of data displayed.” Performance can be significantly improved by enabling this option.

**Process workflow events when changing status:** When turned on, this setting will trigger workflow events when changing the status of an order from within the Tracking view. If turned off, workflow events will not trigger.

**Color Coding**

Three colors can be defined which correspond to time spans in relation to deadlines:

- **Orders past the collection time** will change the color of a shipment’s row when the time goes beyond the window for picking up the shipment.
- **Orders past the delivery due date** will change the color of a shipment's row when the time goes beyond the window for delivering the shipment.
- **Orders within XX hours of the due date** is a custom field which will change the color of a shipment’s row when the time gets to be within the number of specified hours of the latest time in the window for delivering the shipment.
Customers

General

Customer Password Policy: Enforce password policies for all customer accounts. Select the options that meet your organization’s criteria for appropriate passwords. Once set, all new and changed passwords will need to meet the criteria set. This setting will not retroactively flag existing passwords, only new and changed passwords.

Generate random customer account number when creating new customers: When this setting is enabled, new customer accounts will be assigned an automatically generated account number using the pattern defined by the Account number mask. This mask can include alpha-numeric characters including symbols such as dashes. The pound symbol (#) is used as a place holder for a randomly generated number, determined by the Account number digit length. This number can be a maximum of 9 digits long.

Consider this example:

In this case a random 6-digit number is generated. That number will be placed where the hash symbols (#) appear in the mask.

We’ve added “CA” and some dashes (-) to the account number to help break it up and make it more readable. If the random 6-digit number generated is 123456, the final account number will look like:

CA-123-456
Billing

Preferences

The current invoice number will be shown as a blue link. In OnTime, the invoice numbers are sequential. To seed this number to be a higher value for the next invoice, click on the blue link and adjust the invoice number.

Include older and missed orders in billing cycles: A billing cycle is normally defined as a specific span of time between two dates. Checking this option will allow OnTime to gather orders into the current billing cycle, ensuring that nothing is missed when invoicing customers.

Email Invoices

The Email Template button allows access to the template used to send invoices by email. Include a subject line to be used within the message. In the main text box, the body of the message may be composed. The following Special Fields can be inserted as placeholders into both the subject line and the body of the message:

- Customer name will be replaced by the name of the appropriate customer.
- Contact name will be replaced by the contact name of the appropriate customer.
- Report date will be replaced by the date that the invoice was generated.
- Invoice number will be replaced by the invoice number.

Invoices emailed to customers are attached to the message as a PDF file. To instruct the customer about this, select Adobe PDF Instructions and a short paragraph describing how to install Adobe Reader will be included in the email.

Connections

This section allows for modification of settings relating to how OnTime connects to other applications and services.

Email Server

OnTime gives the option to choose different mail servers to send out notifications and email messages: either OnTime’s mail server or another accessible mail server.

The OnTime mail server will automatically ensure that messages are sent out; however, the sender’s address may appear as notify@ontimesystem.net or notify@ontime360.com. To have greater control over messages and to customize the sender’s address, use your own email account or your own mail server.

The appropriate Internet Service Provider, webmaster, or server administrator should be able to provide the information requested in this section. The email server and account fields must be filled out accurately before messages can be sent.

- Server name is the SMTP server that is used to send email.
- Server port should be set to the port number provided by the mail server administrator.
• **Use Windows Authentication** should only be enabled when hosting OnTime on the same local network as the mail server, such as a dedicated instance of OnTime. If the OnTime server is located on the same domain as the SMTP server, and the currently logged in Windows user has permission, then the **Use Windows authentication** can be checked to provide the credentials automatically. Normally this setting should be left unchecked.

• **User name** and **Password** are needed if the SMTP server requires authentication. If authentication is not required, then **User name** and **Password** should be left blank.

Here's an example of how this might look when configuring OnTime to relay through a Gmail account:

![Configuration screen](image)

Use the **Test Email Server Connection** to send a test email from the OnTime services using the mail server settings specified. A prompt will appear asking where the test email should be sent. If, after clicking the **Send Test Message** button, the mail message is received, this indicates that the mail server settings are configured correctly.
**Note:** Before testing the mail server settings, be sure to save the settings and allow them to synchronize to the OnTime servers. This test is performed from the server. If the mail server settings are not saved to the OnTime server, the test will not be accurate.

**Online API**

The OnTime API makes it possible to connect an OnTime account to different software and services. To keep the API secure, be sure to keep the box labeled *Allow anonymous access to secured API methods* unchecked.

Allow secure access to the API by using **API keys**. If another program or a programmer needs access to the OnTime API, you can generate a key just for them. These API keys can also be revoked at anytime if you no longer want a program or person to access the API. Additionally, permissions are assigned to each key so that you can limit the functions that a program or person can access. Create a new API key by clicking the **New** button.

When creating or modifying an API key, the following properties are available:

- Ensure that the checkbox labeled **This key is active** is checked. If not checked, the key will remain in the system but will not allow access to the API.
- **Assigned to**: The name of the person or program that will make use of the API key.
- **Key**: The actual API key used by programs or people to access the account’s API. Use the **Generate Key** button to create secure, unique key. A specific format is required, so typing random characters will not work.
- **Permissions**: An account’s API can be further secured by only allowing certain permissions to a key. By default, all permissions are denied. **Allow** the proper permissions so that the person or program using the key will be limited to accessing only necessary portions of the API.
Example API key with permission to read, create, and update orders.

**Extensions**

OnTime Extensions act as plug-ins or add-ins within OnTime Management Suite or OnTime Dispatch. By default, these extensions may be installed and used. However, if such extensions are not desired, installation and operation of these extensions can be disabled at a global level using these settings.

**Allow Extensions to be installed on PCs under this account:** Check this box to block installation of new extensions on any computer logged into the account.

**Allow Extensions to run on PCs under this account:** Check this box to block the use of any installed extension on any computer logged into the account.

**Accounting Software**

OnTime can communicate with QuickBooks desktop versions, 2002 Professional and higher. QuickBooks Enterprise is also supported. QuickBooks must be installed on the same machine as OnTime Management Suite for communication to succeed.
QuickBooks can work with multiple company data files. Due to this, the first step in connecting with QuickBooks is to specify the company data file to which OnTime should connect. This can be done in two primary ways:

**Use company file currently opened in QuickBooks**: If QuickBooks is already opened to the desired company file, OnTime automatically connect to that same company file. This is the most typical setting.

**Use a specific QuickBooks company file**: If multiple company files are used, this option makes it possible to specify the file path of the desired company file.

![QuickBooks Pro](qb.png)

**Test Connection to QuickBooks**: Once the preferred company file option is set, click this button to test the configuration. If the test appears to take a long time to complete (longer than 30 seconds), be sure to check for a permission prompt within QuickBooks. If this is the first time OnTime is connecting to the company file, QuickBooks will prompt for permission to allow the connection. Also allow any software firewall prompts since OnTime and QuickBooks connect securely across a type of local network connection.
Example QuickBooks permissions prompt.

**Note:** QuickBooks Online is also supported via an OnTime Extension available in the extension directory.

**Mobile**

**General**

If drivers cannot use the *OnTime Mobile* apps, they may be able to access similar features through a web browser on their mobile devices. The website addresses for *OnTime Mobile Web* and *OnTime Mobile WAP Edition* are displayed for the account.

**Allow OnTime Mobile for Windows Mobile access for this account:** If enabled, this setting will allow users of Windows Mobile devices to use the *OnTime Mobile for Windows Mobile* app. This is uncommon and should be left disabled, or unchecked, for improved security.
**Time Zone**

**Default mobile time zone**: Some mobile devices may not provide time zone information. In this case, this setting will be used as the default time zone for mobile devices running *OnTime Mobile Web* or *OnTime Mobile WAP Edition*.

**Routes**

This section contains options pertaining to route stops added to the Routes area of *OnTime Management Suite*.

**Route Stop Scheduler**

The automated Route Scheduler attempts to automatically submit all scheduled route stops once a day, at the specified time of day.

**Enable automated Route Scheduler**: Enable this setting to cause the route scheduler to submit route stops each day at the specified time. To pause route stop scheduling, disable this option.

**Generate orders from route stops scheduled for the current day at**: This represents the time of day, in local time, that the route scheduler should start.

**Note**: New days begin at 12:00 AM, midnight. Only route stops with schedules that are due to occur *that day* will be submitted. Other route stops will be ignored. As a result, a time of 12:00 AM or soon thereafter is highly recommended. A good setting is 2:00 AM.

**Note**: The automated route scheduler checks for adjustments to the time of day every 3 hours; therefore, adjustments to these settings may take as long as 3 hours to take effect.

**Set scheduled orders as dispatched by**: Each order submitted within OnTime is associated with a user account, making it easier to search orders later. Use this setting to specify the user account to associate with orders submitted by the route scheduler.

Route stops submitted by the route scheduler can be assigned unique tracking numbers to differentiate them from orders submitted by other means. These unique tracking numbers follow the pattern set by the *Route stop generated order tracking number mask*. This mask can include alpha-numeric characters including symbols such as dashes. The pound symbol (#) is used as a place holder for a randomly generated number, determined by the *Route stop generated order tracking number digit length*. This number can be a maximum of 9 digits long.

Consider this example:

<table>
<thead>
<tr>
<th>Route stop generated order tracking number digit length:</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route stop generated order tracking number mask:</td>
<td>RS-###-####-##</td>
</tr>
</tbody>
</table>

In this case a random 9-digit number is generated. That number will be placed where the hash symbols (#) appear in the mask.
We’ve added “RS” and some dashes (-) to the tracking number to help break it up and make it more readable. If the random 9-digit number generated is 123456789, the final route stop tracking number will look like:

RS-123-456-789

**Route Stops**

To manually schedule route stops, click on the **Schedule Route Items** button. A list of routes stops yet to be scheduled for that day will appear. Check the items in the list that should be scheduled and then click the **Schedule Now** button.

To view the results of either a manual or automated scheduling, click the **View Scheduling Log** button. The items scheduled, the routes they originated from, and the tracking numbers that were assigned to the shipments will be displayed.

**Vehicles**

This section contains options that affect vehicle maintenance alerts.

**Maintenance**

The **Remind me** option allows for reminders that cause a green flag to appear in the Maintenance Alerts area. Set the number of days and miles/kilometers to the desired values that match vehicle maintenance policies.

**Customer Web Portal**

This section contains several options regarding the behavior and appearance of the **OnTime Customer Web Portal**. These settings are global, meaning that every customer is affected by the adjustments.

**General**

**OnTime Customer Web Portal URL**: Displays the website address of the **OnTime Customer Web Portal** associated with the account.

**Dispatch orders under the following user identity**: Choose a user from the list with which all orders submitted through the **OnTime Customer Web Portal** will be associated as the order’s dispatcher.

**Allow orders to be cancelled when in “Submitted” status**: If enabled. visitors to the web portal can cancel orders, as long as the order has not progress beyond the submitted status.

**Allow orders to be cancelled when in “In Transit” status**: If enabled. visitors to the web portal can cancel orders, as long as the order has not progress beyond the in transit status.

**Order cancellation notes**: Add custom noted that will appear above the option to cancel an order. If additional formatting of the comments is desired, the notes field supports HTML tags.
Allow customers to edit their profile: When enabled, visitors to the web portal can edit their profile information when logged in.

**Login**

Allow visitors to create an account based on the Template Customer: This option allows customers to create their own accounts for the OnTime Customer Web Portal. Ensure that this option is checked if customers should be allowed to create an account for themselves.

Set template customer: If the above option is enabled, choose a Template Customer from the list of customers. If a Template Customer is not specified, visitors to the web portal will not be able to create an account for themselves.

What is a Template Customer?

When a customer account is created within OnTime, settings such as pricing, billing preferences, notifications, and more are required. If these settings are not configured, the customer account will not function properly. How are these settings configured when a visitor is the one creating the customer account?

Setting up a Template Customer make it possible to pre-assigned these settings, while the visitor enters only basic values, such as contact information. A Template Customer can be created and assigned from the Customers list of OnTime Management Suite.

New account description text: If the option for customers to create their own account is enabled, the text entered in this box will be displayed above the button used by customers to create accounts.

Welcome text: Use this option to add custom text to the log in page.

**Tracking**

Show filter bar: This option controls whether or not the filter bar appears on the tracking page. The filter bar allows the customer to filter (or search) for specific text, dates, or numbers.

Maximum number of rows to display: The speed at which the tracking grid returns results may be increased by limiting the number of orders displayed. A lower number can cause the tracking grid to perform faster than a higher number. If the tracking grid returns more orders than the maximum number, then only the maximum number, as sorted by top most recent (date submitted), are displayed.

Checked columns will appear in the tracking grid: Check the columns that should appear within the tracking grid on the tracking page. Checking too many columns may crowd the horizontal view of the tracking grid.
**Order Entry**

**Allow user to calculate pricing if available:** If this option is selected, the OnTime Customer Web Portal will calculate prices in a similar way to OnTime Dispatch. We recommend leaving this option off until all pricing has been calibrated and tested. If the web portal has trouble arriving at a price for some reason, a message will appear that pricing is not available.

**Allow user to submit order even if price cannot be fully calculated:** In some cases, if an order’s price cannot be calculated, this can indicate a problem with the order. If this option is enabled, the user will still be able to submit the order even if the price fails to calculate.

**Allow users to add new locations:** When enabled, users will be able to add new locations when entering orders.

**Display the following selected user defined fields in the dispatch form:** OnTime allows up to 50 user defined fields. Already setup user defined fields will appear in this list. Check the any additional fields to be displayed to customers on the order entry page.

**Address Book**

**Allow user to edit linked locations:** Check this option to allow customers to edit linked addresses. One address may be linked to multiple customers; ensure that this option is only selected if free editing of linked addresses by customers will not cause conflict.

**Allow users to import bulk addresses:** This option allows customers to add new locations into their address books via bulk import from CSV (comma separated value) files.

**Allow users to add new locations:** This option allows customers to add new location entries into their address book.

**Report Templates**

**Report templates** include the shipping label, waybill, and bill of lading reports. These same reports are available in OnTime Management Suite under the Tracking view. Customizations made to reports from within the Tracking view may be displayed in the OnTime Customer Web Portal by clicking the corresponding blue link labeled **Upload current template.** To set the report on the web portal back to its default state, click the link labeled **Reset to default template.**

**Output format:** Determines the file format in which the report will be presented to the user.

**Invoices**

**Allow customer invoices to be visible online:** If enabled, a new section of the site named **Invoices** will appear on the web portal. Invoices that have been published from OnTime Management Suite will appear under this section for customers to see.
Appearance

The layout and style of the OnTime Customer Web Portal can be altered dramatically.

**Basic Customization:** This option allows for quick and simple changes to the appearance of the web portal.

- **Show company name:** If enabled, the company name as it appears under the General Options will appear at the top of each page.
- **Show tag line:** Add custom text that will appear directly under the company name. This text will appear on each page.
- **Show custom header image:** When selected, choose an image file to be used. This image will appear in the upper left corner of each page.

**Note:** If **Show custom header image** is selected, the company name and tag line will be automatically disabled.

**Advanced Customization:** This option allows for significantly more control over the layout and style of each page. However, an understanding of HTML and CSS are required to make these adjustments.

- **Edit Master Page and CSS:** When clicked, this setting will be presented as two text areas. The **Master Page** tab displays the layout template for every page in the site. Adjusting the HTML contained in this box will affect the layout of elements on each web page. The **CSS** tab displays the styles used for every page in the site. Adjusting the CSS values contained in this box will affect the styles inherited by elements on each web page.

**Use 24-hour clock formatted time:** When enabled, all times on the web portal will show in 24-hour format instead of the default 12-hour time format, which shows time in AM and PM. For example: 13:00 instead of 1:00 PM.

Synchronization

To allow OnTime the unique ability to work in both an online and offline state, data added and changed on one computer is synchronized with all computers running OnTime within the organization. This section provides options regarding how synchronization works on a particular computer.

- **How do you want to keep this computer in sync with OnTime**
  - **Automatically:** Any changes made will be automatically sent to everyone.
  - **Let me manually control when synchronization occurs:** This option causes a synchronization button to appear in the ribbon, allowing manual control over when synchronization with the OnTime service occurs.

- **Optimize synchronization with the server for**
  - **Slow Internet connections:** Select this option for slower or unstable internet connections. Information is transmitted in smaller chunks to improve reliability, but can slow down synchronization.
  - **Fast Internet connections:** Select this option for faster and stable internet connections, such as DSL or cable. Information is moved in larger chunks, which improves the speed of synchronization.

- **If you and another user change the same record at the same time and there is a conflict**
In a system such as OnTime, two or more people could edit the same record of data at the same time. While OnTime usually automatically resolves this conflict, sometimes a decision needs to be made regarding whose version of the data should be used. Users may use three options to determine when OnTime automatically assesses conflict and when the program prompts the user to decide a course of action:

- **Ask me in each case**: A dialog box showing the two versions of data will appear every time that a conflict occurs. Select this option to stop OnTime from automatically resolving these conflicts.

- **Always use the changes on the server**: If a conflict occurs, the changes made by others will always take precedence. Your changes will be overwritten.

**Check for unsynchronized changes when closing OnTime**: If enabled, this will quickly check for any changes made locally that have not yet been synchronized to others. If pending changes are found, an alert will appear.

**Verify data consistency after each synchronization**: If enabled, a verification scan is ran after each synchronization event occurs. This setting may degrade the performance of OnTime. In some cases, this can help improve synchronization reliability when using an unreliable internet connection.
Price Sets

Price sets are the foundation for calculating prices and defining service levels. Price sets take on different names depending upon context. To shippers and dispatchers, the terms “Level of Service” and “Service Level” are used to describe price sets. Some other software may refer to price sets as “Cost Centers” or “Ratings”.

To calculate pricing, OnTime generally performs two steps:

1. Calculate a base price
2. Modify that base price using price modifiers

A base price can be calculated based on zone-to-zone rates, distance rates, or a flat rate.

Price sets are defined at a global level, meaning that a price set may be created once and then associated with one or more customers. If that price set is altered in the future, these changes are immediately applied to all associated customers.

Price sets also allow for accessorial charges to be included. These accessorial charges may include any item that goes beyond the standard or basic services that every shipment receives. Examples include signature capture, COD, fuel surcharge, and wait time.

Price Set Editor

Price sets are created or modified using the Price Set Editor. The following section details options available in this editor.

General

Enter a Name to identify the price set internally. This name will only be seen by the OnTime team, not customers.

Enter a Service level name to identify to dispatchers and customers.

Set the Type to indicate where the price set will be used within OnTime. Choices include:

- **Customer**: The price set will be used to calculate pricing for customers. This is the default and most common setting.
- **Dispatcher/Driver**: The price set will be used to compensate employees. This type of price set used specifically to pay a worker based on the zones in which they have made deliveries. This is an uncommon setting.

**Percent of base price eligible for commission**: The percentage of the price set’s calculated base price that will be available for a worker’s commission rate. Normally this setting should remain at 100%. The following formula is used when calculating the amount eligible for commission:

\[(\text{Base Price}) \times (\text{Percent of base price eligible for commission})\]
Example: If a price set’s base price is $10, it's percent eligible for commission is set to 50%, and the employee's commission rate is set to 25%, the employee would be compensated $1.25. The following formula is used:

\[(\$10 \times 0.5) \times 0.25 = \$1.25\]

**Return distance based pricing is zone based does not apply or returns zero:** If enable, this setting will attempt to calculate a base price based on distance when a zone based price is desired but not available. This setting has no effect is distance based or flat rate pricing is the preferred method.

**Display in the OnTime Customer Web Portal:** If disabled, the price set will not appear within the OnTime Customer Web Portal.

**Dispatcher notes:** Text entered in this box will appear within the OnTime Dispatch application under the order entry screen when changing service levels. These notes can contain useful instructions or reminders for dispatchers as they choose a service level.

**Customer Notes:** Text entered in this box will appear within the OnTime Customer Web Portal. under the order entry page when changing service levels. These notes can contain useful instructions or reminders for customers as they choose a service level.

Sample price set

**Schedule**

OnTime allows flexible schedules to be attached to price sets. These schedules may include when a service level can be used and when a shipment's due date should be set.
Sample price set schedule (Next day service, excluding weekends, delivered by 10 AM)

The upper portion of the schedule specifies the dates and times that the price set will be made available. Choices include:

- **Never**: The price set will never be made available
- **Anytime**: The price set will always be made available
- **Weekly**: The price set has a starting and ending day of the week, along with times for each day. For example: Monday thru Friday, 9:00 AM to 5:00 PM
- **On specific dates**: The price set has a starting and ending date and time

Note: The schedule affects customers and dispatchers. Normally, the current time is used to determine if the schedule attached to a price set allows the customer to select that price set. If the current date and time is outside of the schedule, the price set will not appear in the list of service levels in the order entry screen. Dispatchers using OnTime Dispatch will see available price sets based on the date into the date submitted field.

Note: For examples, refer to Chapter Two > How to Setup an OnTime Account > Step 4: Configure Pricing > Set the Schedule.

**Zone Base Prices**

OnTime offers a way to input zone-to-zone base prices, allowing for simplified price generation based on a fixed amount between two points. Zone base prices are displayed as a grid, with origin zones across the top and destination zones down the left-hand side. To specify a price between two zones, locate the point on the grid where the two zones intersect and enter the desired price into that cell.
Sample zone-to-zone price grid

For help specifying different amounts between zones based on direction, look at the bottom of the grid for a hint regarding the direction of the currently selected cell:

Pricing Input Tools

OnTime can help to significantly speed up the input of these prices using a few tools:

- **Reciprocal Pricing:** If an amount is entered into a cell connecting location (A) to location (B), OnTime will automatically input the same amount into the corresponding cell that connects location (B) to location (A). This feature is on by default.
- **Additional Actions > Fill Empty Cells With:** Automatically inputs a chosen amount into all empty cells. To use this feature, enter the desired amount (without the currency symbol) and then click OK.
• **Additional Actions > Adjust All Values:** If a grid is populated with prices and the values need to be increased or decreased enter the desired adjustment amount (without the currency or percentage symbol), choose how to apply the value (as a fixed number or a percentage), and click **OK**. The cells will automatically adjust accordingly. To decrease the prices, preface the amount with a negative symbol (for example: -1.50). Note: Only cells that have a value will be adjusted.

**Price Modifiers**

Price sets may contain as many modifiers as needed. All available modifiers will be listed. Simply check the ones that should be linked to the price set:

1. Locate a price modifier in the list and link it to the price set by checking the box on the left:

![Price Set Editor](Image)

**Note:** For **price modifier groups**, individual price modifiers do not need to be linked. Link the group itself and OnTime will automatically ensure that the necessary calculations take place.

2. To have an option selected by default (may be unselected later), ensure that the **Initial Selection** box for that price modifier is checked:

3. To make an option be mandatory (always selected), ensure that the **Required** box for that price modifier is checked as shown here:

4. Click **OK** to save and close the price set
5. Repeat this process to have these modifiers appear in any other price sets
6. If the price modifier being linked has an action of *flat percentage*, the price for percentage calculation may be set. If your price modifier is set to access a 15% fuel surcharge, OnTime needs to know which prices in the order should be added up *before* calculating the 15%. This functionality allows distance and vehicle type charges to be included, but excludes non-fuel related activities, such as wait time.

When a price modifier that has an action of flat percentage is selected, a button will appear in the special column, as shown here:

![Set % button]

7. Click the **Set %** button to tell OnTime which items should be included in the percentage calculation by checking the appropriate boxes:

![Base Price for Flat Percentage dialog]

8. Click **OK** to save your preferences.
9. Click **OK** to save and close the price set.
10. Repeat this process for any other price sets that you would like these modifiers to appear in.
When a modifier is added to a price set, it will appear to the dispatcher as part of a list of available modifiers. The dispatcher will be able to select which modifiers need to be applied to a particular order.

Price sets can only contain one of certain types of modifiers. The restricted modifiers are signature capture, collect on delivery (COD), and distance base price. More than one of these types of modifiers can be created and used in the system; however, only one of each can be added to any price set.

**Selected Zones**

Some price sets do not need pricing information to be defined for each and every possible zone combination. The selected zones area allows limitation of the number of zones associated with a price set.

Ensure that the price set references select zones. Associate zones with the price set by selecting the desired zone(s) in the list. If a price is requested for zones that are not part of a price set, a zero (0) value will be returned. When configured to reference select zones, the grid in the Zone Base Prices area will only display selected zones.

When set to reference all zones, no restriction will be placed on the zones available to the price set.

**Customers**

This section displays a list of all customers. Check marks will appear next to the names of customers that are currently linked to the price set. Place a check next to each customer who should have access to the price set.
Price Modifiers

A price modifier (or accessorial charges) adjusts a given base price, making modifiers an excellent choice for any extras, such as a fuel surcharge or an additional weight charge.

Modifiers are created at a global level, meaning that once one is created, it can be used anywhere in OnTime and can be applied to any customer. This functionality saves the time of re-creating the same modifier for each customer, also allowing a modifier to change across multiple price sets, which is especially helpful in the case of frequently changing global accessorial charges such as fuel surcharges.

Classification of Modifiers

Modifiers can be classified into two categories: customer and driver.

Both categories are used in a similar manner to change pricing, but the driver category is designed to work with employee/sub-contractor pay and the customer category for customer billing.

Types of Modifiers

Different types of modifiers accomplish different tasks. The different types include:

- **General Option**: The modifier will appear to the dispatcher in the check box list of available options for the service level/price set selected.
- **Signature Capture**: This type is tied directly to the check box on the order form labeled digital signature capture. Modifiers of this type will not appear to dispatchers in the check box list of standard options.
- **Collect on Delivery (C.O.D.)**: This type is tied directly to the check box on the order form labeled collect on delivery. Modifiers of this type will not appear to dispatchers in the check box list of standard options.
- **Distance base price**: This type is tied directly to the distance base price on the order form. Modifiers of this type will not appear to dispatchers in the check box list of standard options.

A distance modifier type is useful in cases where the base price needs to be accessed based on distance instead of or in addition to zone-to-zone pricing. Because OnTime calculates the total cost of an order as a base price, plus adjustments from any selected modifiers, the special distance modifier type acts as a base price on top of which all other modifiers are applied. The distance base price is defined as a price modifier, allowing for the creation of several pricing scenarios for distance based orders.

Adjusting Prices with Actions

The action property of a price modifier indicates the type of math that will be applied when calculating the cost of that modifier. The cost of the modifier is always based on the base price of the order, which can be defined on a zone-to-zone, distance, or flat rate basis. The price of a modifier is not compounded against other modifiers.

- **Flat Amount**: A specific amount to apply to the base price if the modifier is selected at time of order and can be a positive or negative number and may contain decimal places. Examples: 10, -10, 9.95
- **Flat Percentage**: A percentage to apply to the base price if the modifier is selected at time of order and can be a positive or negative number and may contain decimal places. Examples: 10, -10, 9.95

- **Flat Overage Amount**: A specific amount to apply to the base price if the modifier is selected at time of order and the **watch value** field exceeds the value specified by the **threshold** field. This value can be a positive or negative number and may contain decimal places. The charge calculated by this modifier action is only applied once upon exceeding the threshold.

- **Flat Overage Percentage**: A percentage to apply to the base price if the modifier is selected at time of order and the **watch value** field exceeds the value specified by the **threshold** field. This value can be a positive or negative number and may contain decimal places. The charge calculated by this modifier action is only applied once upon exceeding the threshold.

- **Incremental Overage Amount**: A specific amount to apply to the base price if the modifier is selected at time of order and the **watch value** field exceeds the value specified by the **threshold** field. This value can be a positive or negative number and may contain decimal places. The charge calculated by this modifier action is applied every time the threshold is exceeded by one (1).

- **Incremental Overage Percentage**: A percentage to apply to the base price if the modifier is selected at time of order and the **watch value** field exceeds the value specified by the **threshold** field. This value can be a positive or negative number and may contain decimal places. The charge calculated by this modifier action is applied every time the threshold is exceeded by one (1).

### Defining an Increment

The **increment** field is available for use of an *incremental overage* action. The **increment** defines the amount by which to count the **watch value**. An **increment** is usually one (1), but can be changed to whatever amount is needed. Up to three decimal places are supported, making an increment value such as 12.345 possible.

#### Example

If you had a charge for additional weight and assessed the charge in 5 pound increments, you would set the **increment** to 5. When examining the total input, only the whole number of increments will be returned.

In the example above, if the weight were 10 pounds then the result would be 2, because only 2 increments of 5 are possible within 10.

What would happen if the weight were not evenly divisible by the **increment**, let’s say 18? In that case, only the whole number of increments is returned. A value of 3 would be returned because that is the maximum number of times that the **increment** of 5 can be divided into 18.

### Watch Values

A **watch value** is the field on the order form that a modifier will look to when performing its calculations. These fields may be the weight, quantity, distance, or volume of a shipment and are compared with the **range** to determine if the price modifier should be assessed. This ensures that a modifier only generates a price if specific criteria are met.
• **Weight**: The weight field on the order form.
• **Quantity**: The calculated total quantity of the shipment. This value may include additional quantity if the dispatcher adds items to a shipment.
• **Distance**: The distance field on the order form.
• **Height**: The height field on the order form.
• **Width**: The width field on the order form.
• **Depth**: The depth field on the order form.
• **Cubic Dimensions**: The calculated volume of the shipment. This value may include additional volume if the dispatcher adds items to a shipment. To generate a volume, the height, width, and depth need to all be set to a value greater than zero.
• **Declared Value**: The declared value field on the order form.
• **Base Price**: The base price that was selected and calculated for the order.
• **Custom Amount**: In this case a special field will appear allowing the dispatcher to enter a numeric value that can be arbitrarily entered. This type of watch value should be specified when none of the standard inputs apply.

### Value

The value field is the amount used to calculate a price. This field usually represents the amount to charge for the price modifier. The value can be a positive or negative numeric value and may contain decimal places. In most cases, the value will be an amount of money. Consider these examples:

- **Action** is set to **Flat Amount** and **value** is set to $5.00. The result will always be $5.00.
- **Action** is set to **Incremental Overage Amount** for weight, **increment** is set to 1, and **value** is set to $2.00. With a weight of 5 pounds, the result will be $10.00 (5 X $2).

If percentage actions are used, then value becomes the percentage to be used. The percentage should be expressed as the actual amount desired, not a fraction of one (1). In other words, to specify fifty percent (50%) we would enter “50” and not “0.50”. Here is an example:

- **Action** is set to **Flat Percentage** and **value** is set to 7.5. If the base price of the order is $10.00, then the result would be $0.75.

### Ranges

When using overage actions, a range can be specified to indicate when a price modifier should be used and when it should be ignored. The range works in conjunction with the field that is selected for the watch value.

For example, if we set the watch value to distance, the starting range to 10 and the ending of the range to none, then if the distance calculated were 8 miles, the price modifier would be ignored because the distance is not within the range (not at least 10 miles). The range can be positive or negative numeric values and may contain decimal places.

- **Range (start applying after)**: This option (first text box) specifies the starting point for the range. The input will need to be greater than this starting point. Anything equal to or lesser than will be ignored.
• **Range (stop applying before):** This option (second text box) specifies the ending point for the range. The input will need to be lesser than this ending point. Anything equal to or greater than will be ignored. You can also specify “None” as a value. This value indicates that there is no upper limit on the range. If a number is entered into the box, you can change it to None by selecting the contents of the box and pressing the backspace key until the box is completely empty. When you move to another box, the ending point will then show None.

**Where to Start Calculating**

**Start calculating after:** This field specifies the starting point for pricing calculations. Whereas the range discussed in the last section determines when a price modifier should be used, this field determines at which point or level a price modifier should begin its calculations.

Consider the following fuel surcharge example:

<table>
<thead>
<tr>
<th>Action: Incremental Overage Amount</th>
<th>Range:</th>
<th>Increment:</th>
<th>Distance</th>
<th>Start calculating after:</th>
<th>Multiply by:</th>
</tr>
</thead>
</table>

Include up to 5 miles in the base price of an order. If the distance is over 5 miles, start charging $0.25 per mile from the very start (or zero miles).

Notice that the start calculating after box is set to zero (0). This value instructs OnTime to start calculating the fuel surcharge from the very first mile, instead of waiting until after the 5th mile.

Let’s run a test on this, using 6 miles:

\[
(6.00 > 5.00) \text{ and } (6.00 < \infty)
\]

\[
0.25 \times (6.00 - 0.00) = 1.50
\]

\[
1.50 + 0.00 = 1.50
\]

The charge of $0.25 is for all 6 miles, not just 1. As a result, the fuel surcharge is accessed at $1.50 (6 X $0.25).

**Remember:** If the starting calculation point needs to match the range starting point, be sure to set both of them the same.


**Additional Multiplication**

At times, adding another layer of multiplication to a price modifier may be necessary. For instance, if the customer should be charged $1/km and the shipment should be multiplied by weight.

In such cases, use the **multiply by** list to specify a field from which to gather the amount for additional multiplication. This feature can be very helpful in zone-to-zone based pricing, in which a price modifier must be calculated based on a zone figure.

**Warning:** Be careful when setting this option to something other than "None". Unless used properly, an additional layer of multiplication can cause prices to be wildly inaccurate. This inaccuracy is usually caused when using an incremental **action** type because these already perform multiplication against the **watch value**. Always test price modifiers before making them available to customers.

**Zone Based Lookup Tables**

The **Zone Based Lookup Tables** are very useful for companies who calculate pricing using zones. Normally, a price modifier has a single, fixed value against which calculation take place. When a varying amount against which to calculate – an amount that changes based on the zones involved – is required, use a **Zone Based Lookup Table** with the price modifier to achieve the desired results.

For example, a weight charge may sometimes be a flat amount per pound no matter where the shipment is going. In other cases, the per-pound rate should change based on the zones involved. OnTime’s **Zone Based Lookup Table** makes this scenario easy to implement.

**To Create and Use a Zone Based Lookup Table**

1. Click on the **Zone Lookup Tables** button in the ribbon under the **Home** tab:
2. From the zone lookup table management window, click the **New** button:

![Zone Lookup Tables](image)

3. The resulting window will allow a **name** to be assigned to the table and rates may be filled out. Select the cell in the grid where two desired zones intersect and place your rate. When an order is entered with those two zones, the intersecting rate will be returned from the lookup table:

![Price Set Editor](image)

4. Go back to the price modifiers; when you change the **multiply by** field to **Zone Based Lookup Table**, another list will appear allowing you to choose from your list of lookup tables:

![Multiply by](image)
The example we considered earlier (in Zone Based Lookup Tables) with a variable rate on weight charges would look like this:

![Screenshot of OnTime User Interface](image)

In this example, the weight is counted up, starting from zero (0). It's then multiplied by $1.00 as specified in the value field. Because we’re multiplying by 1, the amount will still be the same number as the weight. OnTime then pulls the appropriate rate from the **Zone Based Lookup Table** and multiplies that rate against the weight. Now it’s easy to have different rates for every zone you service.

Zone Based Lookup Tables referenced in a price modifier may include a default value. If specified, the **Zone lookup default value** will be used when zone matches are not found in the lookup table or when a match is found, but the corresponding cell in the table is blank.

**Note:** The testing area does not test price modifiers that use Zone Based Lookup Tables.

**Grouping Price Modifiers**

Sometimes, we must have the ability to evaluate two or more price modifiers and use the price of the highest or lowest. This ability is available via the creation of a **new group**. A price modifier group allows you to add as many modifiers as you want and then choose to use the highest, lowest, or summed price that is evaluated.
To Create a New Group

1. Right-click inside the price modifiers list and choose **New Price Modifier Group**.

2. Modifiers can be grouped in this window by dragging them from the list on the right to the list on the left. Create the modifier group as shown below and click **OK** to save it:

3. Address the following options, as appropriate:
   - **Name**: This is the name of the group. It will appear to everyone, including customers, as the price modifier name.
   - **Type**: As with normal price modifiers, this type instructs OnTime where the modifier should be used when creating orders.
   - **Behavior**: Since OnTime calculates each modifier in the group separately, the question is what to do with those calculations in the end. The behavior list allows you to select from three actions:
     - **Use the highest priced modifier**: After calculating all applicable modifiers in the group, the amount of the highest modifier will be returned.
     - **Use the lowest priced modifier**: After calculating all applicable modifiers in the group, the amount of the lowest modifier will be returned.
- **Use the sum of all modifiers**: After calculating all applicable modifiers in the group, the amounts of all modifiers are added up and returned.

**Note**: Only applicable modifiers are calculated and considered in a group. The most common reason for a modifier in the group to not be applicable is because the values are outside of the range.

- **Percent eligible for commission**: OnTime allows a commission to be assigned to any user in the form of a percentage. If that user is involved in the delivery of a shipment, that percentage is calculated against the cost of that shipment.
  - Setting this value to less than 100% will mean that the user will get a lesser amount than normal from this price modifier.
  - For example, if the user is an employee and should not receive a part of the fuel surcharge, set that value to 0%. In that case the driver would get commission on everything in the order except the fuel surcharge, in which case he will get no commission at all.

**Testing Modifiers**

Do not leave the testing of pricing to customers. OnTime includes a testing area that helps to ensure modifiers are calculating as expected.

To test a price modifier, fill in the fields required for the test. For instance, testing a fuel surcharge requires that the base price and mileage fields are filled to properly test.

**Note**: If you’re not sure which fields need to be filled out, click the **Test Modifier** button and it will alert you if more fields need data.

**Example**

This example represents a fuel surcharge that accesses $0.25 per mile for every mile driven over 5 miles. To test this, we’ll click the button to show the testing area:
In the testing area, we indicate that the base price of the shipment is $20 and that the distance driven is 12.

After filling out those fields we click the **Test Modifier** button and notice the results:

The results are visible on the right side. The first line indicates if the modifier applies. If so, a green checkmark appears indicating that the 12 miles is greater than the 5 mile threshold.

If we enter only 5 miles in the test, the results change:
Because 5 miles is outside of the range specified for this modifier, it will not apply and OnTime returns a price of $0.

Returning to the previous example of 12 miles:

<table>
<thead>
<tr>
<th>Test Price Modifier</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base price:</strong></td>
</tr>
<tr>
<td><strong>Distance:</strong></td>
</tr>
<tr>
<td><strong>Quantity:</strong></td>
</tr>
<tr>
<td><strong>Weight:</strong></td>
</tr>
<tr>
<td><strong>Dimensions:</strong></td>
</tr>
<tr>
<td><strong>Declared value:</strong></td>
</tr>
</tbody>
</table>

(12.00 > 5.00) and (12.00 < ∞)

\[
0.25 \times (12.00 - 5.00) = 1.75
\]

+ 20.00

Total: $21.75

The results detail how the price of the fuel surcharge is calculated. Different values are color coded to show how the numbers are used; offering insight into the way OnTime calculates price modifiers. As a result, the setup of price modifiers can be experimenting with and continually tested until the calculation is perfected, giving you confidence that your pricing will work as intended.
Dimensional Weight

Shipping costs are generally influenced by the weight of the cargo being transported; however, certain kinds of cargo make charging strictly by actual weight impractical and unprofitable. For instance, cargo that is large and bulky but has a relatively low actual weight, such as foam drinking cups.

Using dimensional weight (as opposed to actual weight) solves this problem by assuming a nominal density for cargo and increasing the billable weight to compensate for the extra volume.

OnTime allows carriers to use dimensional weight as part of their billing calculations. Dimensional weight has been integrated into the standard modifier system to enable maximum flexibility when defining the dimensional weighing system to be used by a carrier. Defining dimensional weight as a modifier enables dispatchers to determine quickly if an order should apply actual or dimensional weight charges.

How to Enable Dimensional Weighing

Dimensional weighing is enabled from the price modifiers area of OnTime Management Suite.

Note: Dimensional weight calculations are supported in all modifier actions except for flat amount and flat percentage.

1. Select the desired action and a list of Watch Values will become available
2. Select Cubic Dimensions from that list to specify the current modifier as a dimensional weight modifier.
   Once Cubic Dimensions is selected, the Start calculating after field will be renamed DIM factor. This change means that the dimensional factor for this modifier can be entered.

Dimensional Factor

The Dimensional Factor (DIM Factor) is a mathematical factor that is used to calculate the dimensional weight of a package. The DIM Factor represents the allowed volume of a package per unit of weight.

OnTime compares the DIM Factor specified in a dimensional modifier with the DIM Factor of an order. The DIM Factor of an order is calculated by dividing one weight unit into one cubic volume unit.
**Note:** OnTime allows any measurement units to be entered into the dimensions field. The calculations do not change between metric to imperial units.

### Example

If a dispatcher enters the measurements of a package as 12 x 20 x 8 (Inches) the **DIM Factor** is calculated as follows:

\[
\frac{12'' \times 20'' \times 8''}{1 \text{ lb}} = \frac{1920 \text{ in}^3}{1 \text{ lb}} = 1920 \frac{\text{in}^3}{\text{lb}}
\]

This **DIM Factor** is then compared to the **DIM Factor** that was defined in the dimensional modifier using the modifier action specified. The **DIM Factor** in the modifier can be derived from any volume to weight ratio that is necessary.

In **OnTime Management Suite**, the **Tools** tab in the ribbon contains a tool labeled **Calculate DIM Factor**.

![DIM Factor Generator](image)

**Dimensional Factor Generator**

This tool can assist in determining a **DIM Factor** based on any desired system of measurements or volume to weight ratios. Alternatively, a carrier may use a previously defined DIM Factor.
Using Dimensional Weight in a Price Modifier

**Note:** Dimensional weight calculations are supported in all modifier actions except for flat amount and flat percentage.

1. Select the desired action and a list of Watch Values will become available.
2. Select Cubic Dimensions from that list to specify the current modifier as a dimensional weight modifier. Once Cubic Dimensions is selected, the Start calculating after field will be renamed DIM factor. This change means that the dimensional factor for this modifier can be entered.

OnTime effectively converts the volume of a shipment into dimensional weight units, allowing the price to be assessed based on the number of virtual kilos or pounds. OnTime offers an easy way to work with dimensional weight, allowing the creation modifiers that work in the same way as actual weight.

**Example**

Below is a price modifier based on dimensional weight which will access $5.00 for each kilo or pound of dimensional weight (which we arrive at by using a DIM Factor of 192):

The modifier is tested by putting a volume of 12x12x12, which equals a cubic volume of 1,728, which, when divided by the DIM factor, turns into 9 dimensional kilos or pounds. Nine times $5.00 gives us a dimensional weight charge of $45.00:
Vehicles

Organizing vehicles in OnTime allows for individual users’ mileage to be tracked. Additionally, maintenance schedules can be determined and drivers’ vehicles will be compared to shipment requirements before dispatching.

Managing Vehicles Types

Vehicle types categorize vehicles in a fleet. Organizing by type can help to assign an order to the driver that has the appropriate vehicle type to accommodate the delivery.

To Add a Vehicle Type

1. Click on Vehicle Types from the Home tab on the ribbon:

2. From the Vehicle Types management window, click the New button:

3. Enter a type of vehicle in the Name text box. Repeat for additional vehicle types.

Overview of Vehicle Maintenance Items

OnTime can effectively manage maintenance schedules, ensuring that vehicles receive preventative care as required. To allow OnTime this ability, setup maintenance items at a global level and then associate those items with the appropriate vehicles.

Maintenance items are tracked in relation to the associated vehicles’ mileage since last maintenance or time passed since last maintenance. OnTime will issue an alert when maintenance is due for a particular vehicle.
Managing Vehicle Maintenance Items

Maintenance items are scheduled activities, such as oil changes and tune ups.

To Add a Vehicle Maintenance Item

1. Click on Vehicle Maintenance Items from the Home tab on the ribbon:

2. From the resulting vehicle maintenance items management window, click the New button:

3. Enter a Name for the new item.
4. Enter the number of miles that may be logged in between maintenance due dates as the Distance Interval.
5. Enter the number of days that may pass in between maintenance due dates as the Days Between Service.
6. Check the whichever comes first option if you would like either the Distance Interval or Days Between Service to determine service based on which occurs earliest. Uncheck the whichever comes first option if you would like either the Distance Interval or Days Between Service to determine service based on which occurs latest.
7. Repeat these steps for any maintenance items that need to be added.

An example of an oil change where the maintenance occurs every 3,000 miles/kilometers or 3 months, whichever comes first

**To Associate a Predefined Maintenance Item with a Vehicle**

1. From the vehicle list, open the desired vehicle
2. Choose the **Maintenance** tab and click the **Add** button
3. Choose the maintenance item to be associated from the list and click **OK**
4. Click **OK** again to save the association to the vehicle

**To View Maintenance Due for Vehicles**

1. Click on the link labeled **View Current Maintenance Due** as shown here:
To Record Maintenance Performed on a Vehicle

1. From the vehicle list, open the desired vehicle
2. Choose the Maintenance tab and select the maintenance item that represents the maintenance performed
3. Click the Record Maintenance button
4. Enter the odometer reading and date when the maintenance was performed, along with any related notes
5. Click OK to save the record to the vehicle
Users

Users represent any person (manager, dispatcher, driver, etc.) or entity (depot, warehouse, etc.) employed by a business who should have access to that business’s OnTime account.

Note: Users do not include customers or shippers. Only people and entities who work for the company are considered users.

Any number of users can be setup under an OnTime account; however, if the allotted number of user accounts has been exceeded, additional monthly charges will be represented by the total number of billable users. Check the OnTime web site or contact Technical Support for information on the number of users allotted to certain accounts.

Additional user accounts are assessed on the first of each month; therefore, try to remove users before the end of the month and add new users after the first of the month.

User Properties

Each user account is comprised of multiple sections, including General, Employment, Mobile Options, Permissions, Account Type, and Comments.

General Section

General

- **First Name** and **Last Name**: Enter the user’s name into the **First name** and **Last name** fields. If two names are not appropriate, enter the user’s name into the **last name** field.
- **Email**: Enter the user’s email address to send notifications.
- **SMS gateway**: Enter the email to SMS gateway address for the user’s mobile device. This address is usually the mobile device’s phone number, plus the carrier’s domain for relaying text messages. For example, on AT&T, the SMS gateway address might be: 5415551234@txt.att.net. Utilize a search engine or contact the user’s mobile provider if this information is not readily available.
- **Mobile number**: Enter the user’s cellular phone number.
- **Allow user to receive instant updates via SMS text messages**: Check for the user to receive a text message when events related to the user occur within OnTime.
- **Time zone**: Select the time zone that the user operates within.
- **User Image**: Select an appropriate image file to associate with the user’s account.

Note: Checking the **Allow user to receive instant updates via SMS text messages** option can incur additional text message charges on users’ mobile bills.
Security and Access

- **User name**: Enter a user name for the user. This name will be used to sign in to OnTime.
- **Password**: Enter a password for the user. This password will be used to sign in to OnTime
- **Roles**:
  - **Manager or Administrator**: Select this option to allow the user access to the *OnTime Management Suite* program and administrator related activities
  - **Dispatcher or Customer Service Rep**: Select this option to allow the user access to the *OnTime Dispatch* program and dispatcher/order entry related activities
  - **Courier/Driver**: Select this option to allow the user access to the *OnTime Mobile* programs and driver related activities

Employment Section

Information entered into the Employment tab can be used to generate a compensation report, which can be utilized during payroll.

General

- **Start date**: The date the user was added to the system or hired as an employee
- **Type**: The type of worker the user represents
  - **Employee**: Indicates that the user is an employee
  - **National identification number (SSN)**: Enter the user’s identifying number for tax purposes. For example, in the United States enter the user’s social security number
  - **Independent Contractor**: Indicates that the user is a subcontractor
  - **Contracted Company**: Indicates that the user represents an agent or partner company
    - **Company name**: If the user represents a company, the name of the company
    - **Employer identification number (EIN)**: In the case of an agent or partner business, enter the employer identification number

Compensation Rates

Note: User compensation is divided into two parts: dispatching orders or delivering orders. One, none, or both sections may be filled out, depending on the particular user’s duties.

- **Dispatcher Hourly Rate**: Enter the hourly wage that the user is paid as a dispatcher. Leave set to zero (0) if the dispatcher is not paid an hourly wage.
- **Dispatcher Per-Order Rate**: Enter the amount that the user is paid per order dispatched. Leave set to zero (0) if the dispatcher is not paid by order.
- **Driver Commission Rate (%)**: Enter the percentage of the total cost of an order that the driver is paid as a commission. Leave set to zero (0) if the driver is not paid on commission.
- **Driver Compensation Price Set**: Enter the name of the customized price set to be used for automatic zone-to-zone compensation calculations. Leave set to "None" if the driver is not paid using this method. (For more information, see the Price Sets section in Chapter 4.)
• **Driver Distance Rate:** Enter the amount that the user is paid per mile/kilometer driven. Leave set to zero (0) if driver is not paid by distance.

• **Driver Hourly Rate:** Enter the hourly wage that the user is paid as a driver. Leave set to zero (0) if the driver is not paid an hourly wage.

• **Driver Per-Delivery Rate:** Enter the amount that the user is paid per completed delivery, or order. Leave set to zero (0) if driver is not paid a per delivery rate. Note: If an order is split between two drivers (one collects and the other delivers), only 50% of the per-delivery rate will be compensated to the driver.

**Mobile Options Section**

These options control the way that users experience *OnTime Mobile*.

**Mobile App Options**

![Sample Mobile Settings](image)

• **Start location tracking (GPS) on sign in if available**: At startup, *OnTime Mobile* will attempt transmission of the user’s position via GPS (if GPS is available in a compatible format on the mobile device). We recommend selecting this option to track the positions of drivers.

• **Allow access to unassigned orders**: Orders that have not been assigned to a driver will be displayed on the user’s mobile device. This option will allow the user to accept orders that have not been dispatched to another user.

• **Allow order prices to be displayed**: Allows the user to view the total price of an order.

• **Allow modification of order details**: Allows the user to edit certain properties of orders, directly from a mobile device. Editable fields include: Requested by, Quantity, Weight, Height, Width, Length, Status labels, Description, and Comments.

• **Allow access to previous signatures**: Allows the user to access previous signatures captured at a collection or delivery location. Only available in *OnTime Mobile Web* and *OnTime Mobile for Windows Mobile*.

• **Allow access to clock in and clock out**: Allows the user to use time clock features within *OnTime Mobile*.

• **Allow transferring of orders**: When enabled, users will be able to transfer, or reassign, orders from themselves to another driver.

• **Require vehicle when clocking in and clocking out**: Enable this option to require that drivers specify the vehicle used when clocking in and out.

• **Require contact name when collecting or delivering orders**: Enable this option to require that drivers specify the name of the contact when collecting or delivering orders.

• **My Orders list type**: Determines the style of list used to display the My Orders list on *OnTime Mobile for Android* and *OnTime Mobile for iOS*. Let user choose will allow the user to choose the visual style from within the app’s Options view. Always show as orders will display the list as orders, with one row per order. Always show as individual stops will display each stop required, with one row per stop. Orders generally consist of two stops, collection and delivery. As a result, the individual stops list type will result in a list that is longer. When used in conjunction with OnTime’s route optimization features, the list of individual stops can be sorted in the optimal order.

• **Proximity check at collection**: With this option enabled, *OnTime Mobile for Android* and *OnTime Mobile for iOS* will check if the position of the driver is within an acceptable proximity to the actual collection location. Show will display an alert verifying that the user is near the location. Show and require to be within acceptable proximity will display an alert verifying and require that the user is within the acceptable distance of the location. The user will not be able to mark the order as collected unless they are within the acceptable proximity. Disable will completely disable the proximity check and block any alerts from appearing.

• **Proximity check at delivery**: With this option enabled, *OnTime Mobile for Android* and *OnTime Mobile for iOS* will check if the position of the driver is within an acceptable proximity to the actual delivery location. Show will display an alert verifying that the user is near the location. Show and require to be within acceptable proximity will display an alert verifying and require that the user is within the acceptable distance of the location. The user will not be able to mark the order as delivered unless they are within the acceptable proximity. Disable will completely disable the proximity check and block any alerts from appearing.

• **Current acceptable proximity**: The number of meters a user can be from a location and still considered within proximity. This value can be set within General Options > General > Mapping.
- **Allow customer lookup in Windows Mobile 6**: Allows the user to search for customer contact details from within the legacy *Windows Mobile for Windows Mobile* application.

**Mobile App Synchronization**

**Mobile App Synchronization**: Adjust these values to customize the synchronization experience for each user of *OnTime Mobile for Android* or *OnTime Mobile for iOS*. Because each user’s mobile device is different, adjusting these values can help balance battery life and performance on a device-by-device basis. These settings may vary due to mobile OS settings, such as power management.

**Permissions Section**

Permissions determine which features a user can use within OnTime Management Suite or OnTime Dispatch. To prevent a user from using a certain feature, uncheck that item in the list.

**Account Type Section**

**Account Type**

This setting determines the type of user account. Any normal, active account should be set to **Full User Account**. Users who are no longer with the company may be deactivated by setting them to **Inactive User Account**.

Inactive user accounts cannot be used to log in to OnTime programs. Inactive accounts are not counted as billable users, meaning that you will not be charged for users assigned to this type so long as they were assigned as inactive for the entire billing cycle.
Comments Section

The **Comments** box provides a place to make notes about the user. These comments are private.

History Section

This section will display all changes made to the selected user account.

**Editing andRemoving a User**

Double-click a specific user on the list to edit that user. All edits made will take effect system wide. Right-click a specific user on the list and choose **Delete** to remove that user. Removing a user will not delete information linked to the user.
Customers

OnTime has a sophisticated customer account feature which allows price adjustments, order confirmation preferences, price set assignments, billing cycles, and department association.

General

This tab is for basic customer information that is used for orders placed within OnTime.

- **Name:** Enter the customer’s name (a business or personal name)
- **Contact:** Enter the name of the primary contact at this customer’s location
- **Account #:** Enter the customer’s account number. If appropriate, this number is used by the customer to log in to the online customer portal
- **Phone:** Enter the customer’s phone number
- **Fax:** Enter the customer’s fax number. Filling out this section allows invoices to be faxed
- **Email:** Enter the customer’s email address. This email address will receive notifications and, if appropriate, be used by the customer to log in to the online customer portal
- **Street 1:** Enter the first line of the customer’s address
- **Street 2:** Enter the second line of the customer’s address. Use this field for apartment or suite numbers
- **City:** Enter the city of the customer’s address
- **State:** Enter the state of the customer’s address
- **Postal code:** Enter the postal code of the customer’s address
- **Country:** Enter the country of the customer’s address
- **Website:** Enter the customer’s website address
- **Categories:** Enter a list of categories that the customer may belong to. Separate items with commas. This list is used for reference only
- **This customer is active:** If this option is unselected, the customer will not be able to log in to the OnTime Customer Web Portal. Dispatchers will be alerted in OnTime Dispatch when attempting to create a new order for an inactive customer
- **Create a location record for this customer:** This option is available when creating a new customer account. If checked, a corresponding location record will be created
- **Configure Required Fields:** Click this button to view a list of fields that can be made mandatory. To require a field to be filled upon order entry, place a check box next the desired field(s). Click **OK** to save the changes. The selected fields will be required in both OnTime Dispatch and the OnTime Customer Web Portal before an order may be submitted for the associated customer. Setting the required fields here takes effects the configured customer only. Other customers will not be required to fill out the same fields.

**Note:** If globally required fields have been setup from the General Options area, those fields will be merged with required fields for a specific customer.
Departments

This section is used to manage departments used by the customer. These departments will appear in the order entry forms, allowing the customer to indicate which department is involved in the order. This information is used on the invoice report to group the invoice by department.

Contacts

This section is used to manage the contacts, or subaccounts, under a customer. Creating additional contacts under a customer account allows the customer to have various individuals place orders and receive notifications personally, instead of at the company level.

An email address and password are requested for each new contact. These credentials can be used by the contact to log in to the OnTime Customer Web Portal. Orders placed by a logged in contact will remain associated with that contact. Notifications regarding that order will be sent to the contact’s email address.

Notifications

OnTime allows specific notifications to be sent to specific customers. Custom information, such as proof of delivery, may be included in these individualized notifications. When creating these notifications as templates in the OnTime Workflow Designer, one of the options is to set the scope. Set the scope is set to “Customers” to have the notification template available in this list. Check the notifications that you would like to have relayed to the customer.

Price Sets

To make one price set the default for new orders, right-click the desired price set and select Set as Default Selection. A green check mark will appear next to the default price set.
Billing

This section is used to set billing options for the customer.

- **Use billing cycle**: Enable this checkbox to set how often billing occurs for the customer. The results will be displayed in the billing area of the program. Turning on this option will display a flexible scheduling window. For example, if you would like the billing cycle to be once a month, ending on the last day of the month, the schedule would appear like this:

![Billing Cycle Schedule](image)

**Note:** Billing cycles may only occur once per period. For example, a schedule of once every 2 weeks may be set, but not a schedule of twice a month on the 1st and 15th.

- **Adjust billing cycle schedule**: Select this option to modify the schedule for the billing cycle
- **Current balance**: Displays the current total amount due for the selected customer. The balance is calculated by adding up all invoices and subtracting all payments for the customer
- **Send invoices via**: Use these check boxes to set preferences regarding invoices sent to the customer
- **Billing email**: Enter the email address to which invoices will be sent
- **Adjustment**: If desired, enter a positive or negative value (representing a percentage) to adjust the price by. A negative value can be indicated by placing a negative symbol (-) before the number
- **Reference number**: The number in this field is the default reference number. This number will be automatically placed on new orders for the customer
- **Purchase order number**: The number in this field is the default purchase order number. This number will be automatically placed on new orders for the customer.
- **Preferred pricing method**: Set this preference to correctly correspond with the specific customer’s pricing type. The pricing type can be changed in *OnTime Dispatch* upon order entry; however, this value is not adjustable from the *Customer Web Portal*. The default for all new customers is **distance based**
- **Default invoice template**: Any number of custom invoice templates can be created within OnTime. This setting assigns one of those custom invoice templates to the selected customer
• **Credit card information**: This section lists the credit card information for the selected customer. This data is stored in an encrypted state, but may be viewed by anyone who has access to customers in *OnTime Management Suite*. This data is stored for reference only and is not used to process payments through OnTime.

**The Importance of Customer Credit Card Protection**

If you store, process, or transmit credit card payments, your business could be liable for fines or other damages if your customers’ credit card information is ever stolen or compromised.

The merchant is responsible for the security of any credit card information that is stored, processed, or transmitted within OnTime.

OnTime, as a payment application program that handles payment cards, must comply with the requirements for securing cardholder data.

Security standards are governed by the PCI DSS (Payment Card Industry Data Security Standard) to make sure that payment card data is protected and secure. Failing to comply with these standards can lead to a security breach that could result in significant fines. See the Visa Cardholder Information Security Program for further details.

As a merchant, you are required to maintain secure credit card information handling standards within OnTime as well as outside of OnTime. Please review the steps involved in complying with the standards as outlined in the Payment Card Industry (PCI) Data Security Standard (DSS).

**Web Portal**

To log in to the *OnTime Customer Web Portal*, the customer must have the following fields filled.

- **Grant this customer access to the OnTime Customer Web Portal**: Check this box to allow the customer to log in.
- **Email**: This section contains the email address from the *General* section of the customer’s record. This email address can only be changed in the General section.
- **Password**: Enter the password used by the customer to log in.
- **Time zone**: Set the time zone for the customer.
- **Log in to the web portal as this customer**: Select this option to launch a web browser, open the *OnTime Customer Web Portal*, and log in as the selected customer.
- **Send customer a link to the Customer Web Portal via email**: Select this option to compose an email in the default email program. The email will contain the web site address, user name, and address that the customer will need to access the *OnTime Customer Web Portal*. A default email program, such as Microsoft Outlook, must be installed and configured correctly for this option to work.

**Note**: The *OnTime Customer Web Portal* is only available to Enterprise level subscribers. See Chapter 6: *OnTime Customer Web Portal* for more information about this feature.
Map

This section displays a map of the customer’s location based on the address listed in the General section.

Comments

The Comments box provides a place to make notes about the customer. These comments are kept private and are never displayed to the customer.

Billing

OnTime can help to organize billing across thousands of customers. Billing procedures that can take days to complete may be automated within OnTime by utilizing such features as billing cycles and batch mailing.

The Billing section contains five areas:

Summary

The Summary area provides an overview of the Billing section. Total Completed billing cycles and Unbilled items are provided, as well as shortcuts to specific parts of Billing.
Summary of orders to be billed

- **Completed billing cycles**: The total number of billing cycles assigned to customers that have ended and are ready to be processed
- **Unbilled items**: The total number of orders that have been submitted, but not marked as billed to the customer

**Billing Cycles**

The **Billing Cycles** list displays customers who are assigned to a billing cycle that has been completed at least once. The list shows the last time that a bill was generated for the customer and all orders involved in the billing cycles were marked as billed.

The **current cycle ending** date is the last day of the cycle, including all unbilled orders submitted prior to and including that date.

The **total amount due** shows the total of all unbilled orders submitted prior to and including the ending date.

**Postal**, **email**, and **fax** columns display a check mark to indicate preferences of the customer to receive their bill in any one of those formats.

In the case where a billing cycle has reached completion more than once without being processed, the orders in all billing cycles up to the current one will be included.

Upon processing orders in a billing cycle, a message will appear asking if all processed orders should be marked as billed. All orders will be marked as billed, causing them to no longer appear in the billing area.

**To Create an Invoice from a Billing Cycle**

1. Select the desired billing cycle from the list
2. Click the button labeled **Add to Invoice**

All orders within that billing cycle will be added to a single invoice and marked as billed. The billing cycle entry will be removed from the list.
To Mark an Entire Billing Cycle as Billed

1. Right-click the desired customer billing cycle in the list
2. Select Mark as Billed

All orders included in the selected billing cycle will be marked as billed and will disappear from the list.

Unbilled Shipments

The Unbilled Shipments list displays all unbilled orders that have a status of completed or cancelled billable.

The column labeled Created represents the date and time that the order was submitted into the system. The amount represents the total cost of the order, including base price and price modifiers.

Double-clicking on an order in this list will open the order’s details for editing.

Options to view and send information about a selected order are available in the toolbar across the top of the Unbilled Shipments list:

- **Preview**: Displays the selected order(s) in a printable report format
- **Print**: Prints the selected order(s) to a specified printer
- **Email**: Sends the selected order(s) to an email address. The customer’s email address (if specified) will be automatically loaded and displayed for confirmation. If necessary, the email address may be changed before sending. The bill is attached to the email as an Adobe Acrobat PDF file. Further customization to this email is accessible via the Email tab in General Options
- **Fax**: Faxes the selected order(s) to a fax number. The customer’s fax number (if specified) will be automatically loaded and displayed for confirmation. If necessary, the fax number may be changed before sending

To Create an Invoice from an Unbilled Shipment

1. Select one or more desired shipments from the Unbilled Shipment list
2. Click the button labeled Add to Invoice

All selected orders will be added to a single invoice and marked as billed. The selected shipment(s) will be removed from the list.

*Note:* Orders from different customers cannot be merged onto the same invoice. All orders on an invoice must belong to the same customer.
Filter and Grouping

By default, the **Unbilled Shipments** list only shows orders that have not been marked as billed. To see all orders, including ones that have been marked as billed, de-select the filter button:

![Filter Billed Button]

**Note**: If the same order is added to more than one invoice, OnTime will display a warning to help to avoid double billing customers.

The button to the right of the filter will group unbilled shipments by customer name, which help when assembling invoices.

**To Mark an Individual Order as Billed**

1. Select the desired order in the list
2. Right-click and select **Mark as Billed**

The order will be marked as billed and will disappear from the list.

**To Create a New Invoice**

1. Right-click an unbilled order
2. Select **Add to Invoice**. A window will appear:

![Add to Invoice Window](image_url)

3. The window is separated into two portions: upper and lower. The lower portion, titled **Add to an existing invoice for...**, is used to modify existing invoices. The upper portion, titled **Add to a new invoice**, is used to create new invoices. Fill out the following sections as needed to create a new invoice from **Add to a new invoice**:

   - **Invoice date**: This section automatically indicates the date that the invoice is generated. The default is the current date. Adjust this section to display an alternative date to the customer.
   - **Invoice number**: This section contains a sequential number that identifies the invoice. OnTime will automatically generate a number, which can then be accepted or altered manually.
   - **Due date**: This section contains the date that payment on the invoice is due
   - **Template**: This section contains the date that payment on the invoice is due

   - **Template**: Choose the template to be used to render this invoice:
     - **Standard**: This option will utilize a full invoice template with several details per order. Approximately three orders will fit on one printed page.
     - **Simplified**: This option will utilize a basic invoice template with only a few details per order. Several orders will fit on one printed page.
To Make Changes to an Existing Invoice

1. Double-click the desired invoice in the list
2. Make any desired modifications
3. Click Save & Close

To Remove an Order from an Invoice

1. Right-click on the order
2. Choose remove from invoice.

Viewing and Sending Invoices

OnTime supports four methods for outputting invoices: Preview, Print, Email, & Fax.

Preview

A print preview can be displayed on screen, displaying exactly what the customer will see. From here, modifications may be made to the layout and the invoice may be saved to many file formats, including PDF.

Print

Use this option to send the invoice directly to a printer.

Email

This option will create a PDF file of the invoice and attach it to a message addressed to the billing email address on file for the appropriate customer. An OnTime administrative user will be prompted to confirm the email address and name of the recipient before the email is sent.

Fax

This option will create a fax version of the invoice and send it to the fax number on file for the appropriate customer. An OnTime administrative user will be prompted to confirm the fax number and name of the recipient before the fax is sent.

Posting Invoices to QuickBooks

OnTime can connect directly to QuickBooks and export invoice data. Please see the Connecting to QuickBooks, Sending Transactions to QuickBooks, and Customize the Information on QuickBooks Invoices sections later on in this guide for more information.
**Processing Received Payments**

Recording customer payments in OnTime can help to keep track of customers' balances.

**Posting Payments to QuickBooks**

OnTime can connect directly to QuickBooks and export payment data. Please see the Connecting to QuickBooks, Sending Transactions to QuickBooks, and Customize the Information on QuickBooks Invoices sections later on in this guide for more information.

**To Post a Payment**

1. Click the **receive payment** link:

2. In the resulting window, select which customer made the payment; all open invoices will be listed.
3. Check the invoice associated with the payment. If the payment applies to multiple invoices, split the payment by manually reporting multiple received payments.

![Payment window](image)

4. Click the **Save & Close** button.

Once an invoice has been paid in full, that invoice will no longer appear in the “open invoices” list.
Locations

OnTime maintains a list of locations which help to keep track of all of the addresses that have been serviced in the past. These addresses are tagged with information such as the zone they belong to and the longitude/latitude coordinates. All addresses used by OnTime will be stored in the Locations list.

To access this list, click the Locations navigation button and select Locations as the view type:

Location records include the following fields:

- **Name**: The name of the location (business or personal name)
- **Contact**: The name of the primary contact at the location
- **Phone**: The location’s phone number
- **Email**: The location’s email address. Notifications may be sent to this address.
- **Categories**: A list of categories that the location may belong to. Separate items with commas. This list is used for reference only.
- **Zone**: The zone associated with the location. If unassigned, OnTime will automatically attempt to assign a zone based on the postal code.

**Note**: When using zone-to-zone pricing, be sure that the Zone assignment is made.

- **Position**: If the location has been successfully geocoded, the longitude and latitude of the location will appear in this section. Right-click a location on the main list and select Geocode to reattempt geocoding at any time.
- **Address line 1**: The first line of the location’s address.
- **Address line 2**: The second line of the location’s address
- **City**: The location’s city
• **State/Province:** The location’s state
• **Postal code:** The location’s postal code
• **Country:** The location’s country
• **Comments:** Private notes about the location may be entered in this section

**Using the Search Box to Find Addresses**

**TIP:** Save time by entering the first part of an address into the yellow search box:

The address will be properly formatted and geocoded, allowing for mileage calculation to and from the address. For example, by typing in the street and city, OnTime automatically formats and fills out the whole address:

- **201 pine st, rogue river**
  - Address line 1: 201 Pine St
  - City: Rogue River
  - State/Province: OR
  - Postal code: 97537
  - Country: US

If an ambiguous address is typed in, OnTime may find multiple matches. In such cases, click on the search icon to view all possible matches:
Routes

OnTime Management Suite allows frequent stops and driver schedules to be organized into routes. A route is assigned to a specific driver. Each day, the route is evaluated and all stops that are scheduled to occur on that day are assigned to the driver as orders. The driver can then see these orders from OnTime Mobile.

To Create a New Route

1. From the Routes area, right-click in the center column and select New

2. Assign a Route Name and a Driver to the new route
3. Select a Color to differentiate the new route from other routes (when all are displayed together)
4. Check the box this route is actively scheduled to queue it for daily evaluation during scheduling
5. Uncheck this box to temporarily suspend the scheduling of a route

To Add a Route Stop

1. Right-click in the desired route’s stops list and choose New Stop

2. Fill out the order as completely as possible in the resulting window. Be sure to specify a Customer, Service Level, Description, Options, and Collection/Delivery Locations
3. Set the **Schedule** to match the needs of the route stop

![Route Stop Recurrence](image)

This schedule would schedule the route stop to occur every Monday, Wednesday, and Friday

4. Specify the time of day that the route stop should occur under the collection and delivery location, as shown here

![Time of Day](image)

5. If the specified delivery will occur over multiple days, set the **Spanning** box to reflect that number of days

6. Click on the **Advanced** button to specify additional detailed information about the route stop

7. Click **Save**

**Using Occupied Zone Schedules**

**Occupied Zones** represent the time of day the assigned driver is expected to be in particular zones. OnTime can consult this schedule later on when dispatchers need a recommendation for the appropriate driver for an order.

**To Add a Zone Listing**

1. Right-click in the box labeled **Zone Schedule on Selected Route**
2. Select **New Zone**

![Zone Schedule on Selected Route](image)

3. Choose a zone

4. Indicate when the driver is expected to enter and leave that zone

![Occupied Zones](image)

An example which indicates that the driver is expected to be in the Ashland zone for 1 hour and 15 minutes, from 8:00 AM to 9:15 AM

**Managing Routes**

Once several route stops have been added, a calendar visual showing how stops relate to one another will become available.

To access this calendar, click on the **Calendar** button and choose to view by **Week** or **Month**:

![Calendar View](image)
To Create Exception in a Schedule for a Given Route Stop from the Calendar View

1. Select the desired route stop instance
2. Drag that instance to a different date

To Skip a Single Instance of the Schedule

1. Select the desired route stop instance
2. Press the delete key on the keyboard

Show Stops in All Routes Button

Specifying different colors for each route can help to visually differentiate stops. In the view displayed after selecting **Show Stops in All Routes**, the stops may be redistributed by clicking-and-dragging a specific stop onto a different route.

**Scheduling Routes**

- To schedule a route stop more than once in a day, create additional route stops with appropriate schedules
- To schedule a route stop, OnTime considers the previous time that the stop was scheduled and then will determine if the stop should be added to the schedule that day. If the stop shouldn’t be scheduled that day or has already been scheduled that day, the route will be skipped by OnTime
- Scheduling is enacted either automatically or manually

**To Have Scheduling Done Automatically**

1. Enter **General Options** in **OnTime Management Suite**
2. Select the **Routes** tab
3. Activate the Automated Route Scheduler
4. OnTime will automatically attempt to schedule all route stops once a day. Set the **time of day** that the scheduler should run. We recommend a time of 12:00 AM or soon after
5. The **user identity** indicates which user automatically generated orders will have listed as the creator
To Have Manually Scheduled Route Stops

1. Check that OnTime is synchronized with the server
2. Click on the schedule items link. A list of route stops will appear. Route stops that have already been scheduled for that day will not reappear in this list
3. Check the desired items in the list that to be scheduled
4. Click the Schedule Now button

To View the Results of a Manual or Automated Scheduling

Click the View Scheduling Log link. A window will appear with a list of orders that have been scheduled, the routes stops that they originated from, and the tracking numbers assigned to those orders.

Scheduling Routes Stops Across Multiple Days

Route stops may span multiple days. OnTime makes this functionality possible by allowing the number of days that the route stop should span to be set.

This flexible approach will allow OnTime to calculate the total amount of time between the latest pickup time and the latest delivery time, plus the number of days. To continue using routes stops that are same-day, then enter
zero (0) in the **Spanning** box. To have one or more days elapse in between the pickup and delivery times, enter the desired number of day(s) in the **Spanning** box:

An example indicating that two day should elapse between pickup and delivery times
Reports

OnTime provides a number of pre-made reports. Alternately, OnTime provides a report designer for creating custom reports.

The Reports Area

The Reports area contains a dashboard with several key metrics for business revenue and user compensation. Graphs outline the data for the past several weeks of operation and include the date of each piece of data. Hover the cursor over a bar or dot on a graph to see the exact amount for that day.

Near the bottom, three lists show the most profitable customers, most compensated users, and a list of other reports.

**Note:** Double-click on an item in the other reports list to view instructions regarding how to locate that report within OnTime. You will find most reports within OnTime are provided contextually, meaning that they will tend to be in the same area as the subject of the report.

Modifying Existing Reports

Modifications may be made to reports using the report designer built into OnTime.

1. Load a preview of the desired report. If the report may be customized, a Modify button will appear in the toolbar of the preview window as shown here:

   ![Modify button](image)

   **Note:** If the Modify Report button does not appear, the report cannot be customized.
2. Click the **Modify Report** button to launch the report designer.

**Formatting and Layout**

When a report is open in the report designer, all of the text on the report is outlined. Each piece of text sits within a text box or table. Moving those boxes or tables moves the text within to a different position on the report.
To Move a Box

1. Select the box on the report:

2. Blue squares will appear around the text box to indicate that it’s been selected. The selected text box may be dragged and dropped to another position. If two boxes overlap, the report will color the overlapping boxes in red, as illustrated here:

Improper formatting should be corrected before saving the report.

To Resize a Box

1. Select the box
2. Click on one of the blue dots around it
3. Drag:
To Add Text and Images to a Report

Drag the desired element from the tool box on the left-hand side of the report designer window:

To add a text box, drag the label control onto the report:

Double-click on a label within a report to edit the text.
To add an image, drag the picture box control onto the report:

Click on the small arrow in the upper right-hand corner of the picture box within the report to open the smart tag:

From this popup, browse to the desired image file and select it. We recommend setting the sizing mode to **Zoom Image**:

**Zoom Image** will automatically scale the image to fit inside of the picture box. The picture box may be adjusted to the desired size.
To Add Data Fields to a Report

1. Select the desired fields from the Field List on the right-hand side of the report designer:

![Field List]

2. Drag the desired field from the Field List to the desired location on the report. Dragging fields on to the report will automatically create a label.

**Note:** To differentiate between these special bound fields and normal static labels, a small orange cylinder appears on data bound fields. The name of the data bound field will also appear in square brackets. *Do not edit this text.*

![Data Bound Field Example]
3. Exit the report designer and save changes once modifications are complete.

4. Exit the print preview window and reload the report to see modifications.

**To Reset a Report to Default State**

1. Open a preview of the desired report.
2. Click the *Reset* button in the ribbon of the preview window:

![Reset button](image)

**Authoring Custom Reports**

New reports may be made using the report authoring tools in OnTime.

**Note:** Report authoring requires experience with report authoring tools, such as Crystal Reports or SQL Server Reporting Services. Knowledge of report layouts and formatting techniques is also necessary. In order to query the right data for the report, a good understanding of creating SQL queries is needed. Retain someone with these qualifications to make use of the report authoring tools.

To create a custom report, a report database must be built.
To Start a New Custom Report

1. Change the view to **Report Authoring**
2. Click the link labeled **Author Custom Report**
3. A blank report will open in a new report designer window:

4. At this point, the easiest way to create a new report is to use the wizard. Start the wizard by clicking on the **File** menu and choosing **New with Wizard**.
5. Create a standard report. Press **Next**.

6. Enter the name to be used to identify the dataset. This name can be any simple name, such as "MyData". A dataset is the container, or set, of data that will be used in the report. Press **Next**.

7. Accept the default connection. Press **Next**.
8. Choose **Query** as the default data source. Press **Next**.

![Query button selection]

9. Enter the SQL query required to retrieve the data necessary for the report. Click the **Apply** button to test the query. Once the query is finalized, click **Next**.

![Query setup]

```
SELECT Company, Name, Phone, Email FROM Customers WHERE (Archived <> 1) ORDER BY Company
```
10. The fields from the table(s) selected in the previous step will be displayed. Any the fields that need to be referenced in the report should be added to the list on the right. Once all of the appropriate fields have been added, press **Next**.

11. Group fields as necessary. Once grouping is complete, press **Next**.
12. Choose the layout of the report. Keep the defaults to get a columnar layout. Press **Next**.

13. Choose a style to set the visual design of the report. Press **Next**.

15. The wizard will close and the report will be created.
16. Click the **Preview** button at the bottom of the report designer to view the finished report, which will show a list of all customers and their phone numbers:

![OnTime Report Designer](image)

My OnTime Report

<table>
<thead>
<tr>
<th>Company</th>
<th>Name</th>
<th>Phone</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>test</td>
<td></td>
<td>test1234567</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>Name</td>
<td>Phone</td>
<td>Email</td>
</tr>
<tr>
<td></td>
<td>Adrienne</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>Name</td>
<td>Phone</td>
<td>Email</td>
</tr>
<tr>
<td></td>
<td>AllPriceSets</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>Name</td>
<td>Phone</td>
<td>Email</td>
</tr>
<tr>
<td></td>
<td>API New Customer</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additional resources, including videos, are available on the OnTime website ([https://www.ontime360.com/support.aspx](https://www.ontime360.com/support.aspx)) to help with report authoring. For answers to specific questions, contact technical support.
Zones

A zone is a defined area used for price calculations, and can appear in a price set grid. Zones may be defined in whatever manner best suits a particular company’s needs; however, they may correspond directly to postal code or zip code boundaries.

All locations created that contain a zip code assigned exclusively to one zone will be associated with that zone. Locations created containing a zip code assigned to multiple zones may need to be assigned by a manager or dispatcher.

Deleted zones are archived, not removed from the system. If a new zone is added with the same name as an archived zone, a prompt will appear asking to restore the archived zone. Create zones with unique names to avoid this conflict.

Merging Zones

One of the problems with rearranging zones is that thousands of addresses and locations may have already been tied to a zone. Manually changing those locations to another zone is time-consuming and tedious.

OnTime allows zones to be merged easily and automatically.

To Merge Zones

1. Click on the Locations area
2. Select Zones as the Current View:
3. Select the zones to be merged from the list
4. Right-click the selected zones
5. Choose **Merge**

![Image of Zones window with Merge option highlighted]

6. In the resulting window, enter a name for the zone that will be created after the merge:

![Image of Merge Zones window]

7. If desired, check the **Automatically update locations to use the new merged zone** box to make OnTime update all locations associated with these merged zones
8. Click **OK**

The selected zones will be merged into a new zone and the old zones will be removed.
Time Clock Features

The built-in time tracking and auditing features in OnTime Management Suite help to simplify the process of gathering user activity from OnTime Dispatch and OnTime Mobile.

The system records a start time based on when a user clocks in. A timer runs until the user clocks out. The information gathered is permanently recorded by OnTime as a session with the user’s name attached. When a pay detail report is run, all sessions that fall between the selected dates selected are gathered to calculate appropriate time and wages.

If a session is spread across more than one day, the session will be split in two. The first session will stop at 12:00 AM and the second session will start at 12:00 AM.

Time clock sessions can be edited.

To Edit a User’s Time Sheet:

1. Go to the Users area
2. Right-click on the desired user
3. Choose View Time Sheet

Choose a date range to change clock in and clock out times as well as miles driven during that session on this form.

Any users clocked into the system show an ONLINE status. These users include drivers and dispatchers clocked in using OnTime Mobile or OnTime Dispatch, respectively.

**Note:** Clocking in and out should not be confused with signing in and out of the applications. When signing into OnTime Mobile or OnTime Dispatch, the user is gaining access to the system, not necessarily clocking in. The user needs to explicitly clock in, which indicates to the system that the user is on the time clock.

Time Clock Features in OnTime Dispatch

By default, OnTime Dispatch will automatically clock the user in and out when the program is started and closed.

To Change Automatic Time Clocking

1. Click the File tab in the upper left-hand corner of the program
2. Choose Option
3. Select the General tab
4. Change the setting under the **Time Clock** group

![Time Clock settings](image)

*OnTime Dispatch* records the time spent as a dispatcher and the number of orders entered and submitted while the user is clocked in.

The time clock button in the upper left-hand corner under the **General** tab will show whether a user is clocked in or out of *OnTime Dispatch*:

![Clock In-Out](image)

**Time Clock Features in OnTime Mobile**

*OnTime Mobile* will **not** automatically clock the user in and out when the program or session is started and ended.

**To Clock In or Out when Using OnTime Mobile for Android or iOS**

1. Go to the menu and choose **Clock In/Out**
2. Choose a **vehicle** from the list
3. Enter the current **odometer** reading for that vehicle
4. Choose **Clock In** or **Clock Out**

**To Clock In or Out when Using OnTime Mobile for Windows Mobile**

5. Go to the **Tools** menu
6. Choose Time Clock
7. Choose a **vehicle** from the list
8. Enter the current **odometer** reading for that vehicle
9. Choose **Clock In** or **Clock Out**

**To Clock In or Out when Using OnTime Mobile WAP Edition**

1. Select the **clock in** or **clock out** link
2. Choose a vehicle from the list
3. Enter the current odometer reading for that vehicle
10. Choose Clock In or Clock Out

OnTime Mobile will record the time spent as a driver and the number of orders handled while the user is clocked in.

**Accessing Time Clock Data**

The results of the time clock data can be viewed and edited in OnTime Management Suite.

- From the Users list, right-click a user to see his past 30 days of data by choosing View Time Sheet
  - Choose a different date range and click Calculate Time to view more data
  - The user’s activities appear. Each day is on one line and a breakdown of activities as a driver and activities as a dispatcher is displayed
- Potential inconsistencies in the activity or time of a user will be flagged by a red cell

- Double-click on the cell find the problem. Resolve the conflict manually

- Once you have evaluated workers’ activity, view the compiled information in the Time and Activity reports
Employees, Subcontractors, Agents, and Partners

Tips

- Make use of the time clock features, letting OnTime track the activities of personnel, to easily determine pay later on.
- Temporary workers and agents may be given accounts to log in for as long as they are working with an organization.
- Real-time results, such as POD information for customers, can be preserved when trusted partners and agents use OnTime.
Importing Data

OnTime can import records contained in Microsoft Excel (XLS, XLSX, and XLSB) files and Comma Separated Value (CSV) files. Because these two file types are common and easy to work with, any information from an existing system can usually be converted into one of those formats. For example, QuickBooks only exports data in the Tab Separated Value (TXT) file format. To convert a QuickBooks file, open the TXT file in Microsoft Excel and save it as an XLS or CSV file.

Records may be imported as the following types:

- Customers
- Locations
- Shipments
- Zones

Customers and shipments can be combined into one import.

How to Import a File to OnTime:

1. Select File > Import Data
2. Click the Browse button
3. Choose an Excel (XLS) or CSV file
   - If an Excel file is chosen, select the appropriate worksheet in the file
4. Select which list data should be imported to
5. Click on the Imported Field column list to see a drop-down menu
6. Select the field from the resulting drop-down menu, which should correspond to the **OnTime Field**. Not all fields need to be mapped, but only mapped fields will have data imported.

7. Click the **Import Now** button

**Note:** If any records fail to import during the process, none of the imported records will be saved.

**Note:** OnTime will try to remember the mapping set up for a list.

**Note:** Dates and times may be imported as either UTC (or Greenwich Meantime) or your local time. If necessary, adjust dates and times before importing.
Exporting Data

Virtually all data can be exported from OnTime. Here are two ways:

1. Within virtually every list of data in OnTime Management Suite, records may be exported by right-clicking the desired records and choosing Export. Enter a file name and save the selected records to a comma separated value (CSV) file.

2. Within virtually every list of data in OnTime Management Suite, records may be exported by selecting the desired records and pressing CTRL + C (or right-clicking and choose Copy). The records may then be pasted into a compatible spreadsheet program such as Microsoft Excel.
User Defined Fields

OnTime allows for up to 50 different types of custom fields (text, date, number, and check box fields).

To Setup the User Defined Field List

1. Click on **User Defined Fields** under the **Home** tab in the ribbon:

2. Click on the **Define fields...** link for shipments:

3. Check the box next to a field to activate that field

4. Double-click a cell in the **field name** column to specify a name for the field:
Once setup, these custom fields are available throughout OnTime. In *OnTime Dispatch*, dispatchers will see these fields under the **Additional Details** view. Customers will see the fields listed on the order entry form in the *OnTime Customer Web Portal*. Custom fields can be accessed and modified at any time from within the tracking view in either *OnTime Dispatch* or *OnTime Management Suite*. Open an order and select the **Custom Fields** section to view or change custom fields:

<table>
<thead>
<tr>
<th>User Defined Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shipment Carrier</td>
<td>UPS</td>
</tr>
<tr>
<td>Customer Number</td>
<td>123456789</td>
</tr>
<tr>
<td>Return Trip</td>
<td>No</td>
</tr>
<tr>
<td>Signature on Delivery</td>
<td>Yes</td>
</tr>
<tr>
<td>Signature on Collection</td>
<td>No</td>
</tr>
<tr>
<td>Waybill Received</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Workflow Designer

Automated notifications that are sent to dispatchers, drivers, customers, and others can be customized within OnTime. These notifications may contain a variety of information and can be sent out via different methods. Notifications are configured within the OnTime Workflow Designer.

Email and SMS Notifications

Customized messages can be sent via email and SMS text message through the OnTime Workflow Designer. For directions on how this is done, see Step 5: Setup Notifications under Chapter 3: Setting Up an OnTime Account.

Webhook (HTTP POST)

An HTTP POST, or Webhook, is an easy way to receive push notifications. A webhook is like an API endpoint but inverted; instead of making a call to the OnTime API, you define a callback URL to which OnTime will HTTP POST information as events in the OnTime Workflow happen. Your callback URL can then execute code based on the POSTs. You can think of it as defining an API endpoint for your app that will receive output from OnTime.

The OnTime Workflow Designer makes it possible to setup Webhooks that are automatically posted with dynamic information whenever the subscribed event occurs. This is accomplished by including dynamic data in the query string of the URL as it is posted.

Webhooks are widely compatible with virtually any programming language, web site, or software system.

Create a Webhook

1. Go to the Home tab on the ribbon and choose Workflow Designer
2. Click on the New button
3. Give the Webhook a name
4. Choose the desired event to trigger the Webhook
5. Choose HTTP POST (Webhook) from the Action list
6. Enter the URL you want to POST to in the Content > Post to box
7. **Special fields** may be entered to specify dynamic content within a notification. **Special fields** are in special tags with orange text. OnTime display a list of special fields when the button labeled **Insert Special Field** is clicked. You will receive a dialog that looks like this:

![Dynamic Data Fields](image)

8. Choose the field that contains the information to be inserted into the query string of the URL
Webhook Example

The following image shows a Webhook that will trigger whenever an order is delivered. It will POST to the URL of http://www.mycompany.com/webhook.aspx. The query string includes two parameters: “tn” and “cn”. The value of “tn” will be the tracking number of the order and the value of “cn” will be the company name of the shipper, or customer.

![Webhook Example Image](image-url)
Checking the Status of Webhook POSTs

Any and all issues with HTTP POSTs are listed under **Pending Notifications**, available under the **Home** tab of the ribbon:

This window will show any problems with Webhooks including:

- The order involved
- The number of times the Webhook attempted to post
- The error encountered when posting
- The workflow action (or Webhook) involved

By default, OnTime will immediately attempt to post the Webhook 10 times; if these attempts are unsuccessful, the URL will be attempted once an hour.

Once the error is corrected, forcibly repost all the Webhooks in the queue by clicking the **Process All Messages Now** button. To remove a Webhook from the queue and ensure that posting attempts are no longer made, right-click the desired Webhook(s) and choose **Remove Item**.

To view the results of a successful Webhook post, open the **Sent Notifications** window located under the **Home** tab. Locate the post in the list and double click it to view details. This will show the URL that was posted to as well as the final query string that was submitted.
Chapter 5: OnTime Dispatch

OnTime Dispatch provides the tools and features that dispatchers need to fulfill assignments such as entering orders, messaging drivers, and managing orders.

Orders

When entering new orders, there are four different views available: General, Additional Details, Map Driver, and Map Route.

The following sections list details about some of the fields contained in these views.

General

Customer: The name of the customer who is placing the order.

Requested by: The name of the person who is requesting the order.

Collection Location: The location for an order’s pickup can be assigned in two ways. The first method is to search for a specific destination in the Find a Contact pane and drag that address to the Collection Location box. The second method is to pick a destination from the Recent box located under Collection Location. This section also contains two date/time boxes to set a window for the arrival time.

Delivery Location: The location for an order’s drop off can also be assigned in two ways. The first method is to search for a specific destination in the Find a Contact pane and drag that destination to the Delivery Location box. The second method is to pick a destination from the Recent box located under Delivery Location. This section also contains two date/time boxes to set a window for the arrival time.

Description: A statement outlining the order. The description entered will be publicly viewable.

Quantity: This field designates the number of items the order contains.

Weight: The weight of the order.

Distance: The distance from the Collection Location to the Delivery Location. This number is calculated automatically.
Dimensions: The dimensions of the order, expressed in Height, Width, and Length.

Reference number: Any reference number that may need to be associated with the order.

Purchase order number: Any purchase order number that may need to be associated with the order.

Vehicle Required: Allows a dispatcher to specify a special vehicle when required.

Assigned to: The name of the driver who is assigned to collect the shipment.

Service Level: A combination of the price set and price modifiers that will be used with the order. Certain modifiers will be listed under Standard Options.

Base Price

Zone based: Calculates the base price using the set zone-to-zone values. Additional instructions from the company may appear directly under the price set selection box (if programmed in).

Distance based: Calculates the base price using the distance of the order. For this price to be calculated, a distance base price modifier must be associated with the price set.

Flat rate: This field is for charging a flat rate that becomes the base price for the order.

Misc. adjustment: This field is for making miscellaneous price adjustments to the order.

Standard Options: A list based on the modifiers in the Service Level selected. Select a modifier by filling the box beside its name.

Additional Details

Date submitted: Specifies the date of the order; may be used to pre-date orders.

Declared value: An amount representing the customer’s declared value of the shipment.

Incoming tracking number: An alphanumeric string up to 50 characters long. This field is usually filled with a tracking number or bar code that the originating shipper provides for tracking purposes.

Outgoing tracking number: An alphanumeric string up to 50 characters long. This field is usually filled with a tracking number or bar code that the receiving shipper provides for tracking purposes.

Collect on delivery: The Collect on delivery (COD) option indicates to the driver that funds for the order should be collected at either the collection or delivery locations.

Collect at: This option specifies whether the COD should be collected on delivery or pickup.

Amount to collect: This specifies the cost for the COD to be picked up.

Comments: Additional notes or comments regarding the order. These are kept private and not shown to the customer.
Map Driver

The Map Driver feature shows the last known location of the driver on a street map. In order for this feature to work, a specific driver must be selected for the order via the Assigned To field.

Map Route

The Map Route feature shows a detailed map of the route for the selected order and calculates the mileage for the order.

Order Entry through OnTime Dispatch

Features and tips for using the order entry functions:

- Create a new shipment by clicking the New Order button in the upper left.
- The tabbed interface allows multiple orders to be open at once, which is very useful when certain order entry needs to be put on hold temporarily.
- Most fields have auto completion built in: appropriate entries will be suggested when typing.
- The Recent drop-down boxes show the previous 10 locations that were either shipped from or to.
- The Directory drop-down box may be used to search for any address in the system by company name.
- The Find a Contact pane offers a more advanced search. Drag and drop a selected customer or address onto the order entry form to quickly populate the contact information.
- Locations that are not already in the address book can be added by clicking the New Location button or the plus sign (+) in the appropriate lookup box.
- In the Assigned To box, assign a driver by typing or choosing one from the list. OnTime will suggest an appropriate driver when the ellipsis button in the Assigned To box is pressed.
- View the selected driver’s last known location on a map by clicking the Map Driver button.
- Once a customer, pickup location, and delivery location have been populated, pricing will become active.
- Select the Service Level, which may change the available Standard Options and delivery arrival window.
- Select the method for arriving at the Base Price for the shipment.
- Fill in remaining fields. The price will change in real-time as adjustments are made.
- If the selected customer is given a rate adjustment, the prices will reflect that percentage. The Total Cost will reflect the percentage increased or discounted. This adjustment rate only applies to predefined pricing. The amount entered into the Flat Rate base price field or the Misc. Adjustment field is not affected by this adjustment.
- Additional order options can be accessed by clicking on the Additional Details button.
- To manually set the submission time of an order, make adjustments in the Date Submitted box.
- Items in a shipment can be listed individually by adding them to the Item Details list. Note that this will also change the total weight and volume of the shipment.
- View the suggested route for the selected shipment by clicking on the Map Route button.
- The Map Route view will assist with judging distance, which can help to determine price. Turn-by-turn directions may be copied to the comments section of the order. This section can be made available to drivers if they need assistance to locate either a pickup or delivery location.
• Click the **Submit Order** button to enter the order into the system, where it will then be processed. Click the **Submit All Open Orders** button to quickly submit all open orders simultaneously.

• Click the **Submit Completed** button to place the order into the system with a completed status. This option is especially useful when entering orders that were processed outside of OnTime at an earlier time.

• Click the **Place on Hold** button to freeze the order. The screen will clear and an entry will appear on the left. This order can be accessed at any point in the future to resume, edit, and/or submit. This feature can also be used to create order templates for use when expecting several similar orders from a particular customer.

• If desired, a cut off time of day may be specified. This option will automatically set the due date of orders to the next day. In *OnTime Management Suite*, go to **General Options** to edit the cut off time.

**Unassigned Shipments**

• Clicking on the **Dispatching** area of *OnTime Dispatch* will show a list of all available drivers and a list of all orders that have not been assigned to a driver.

• Double clicking on a driver will display information about that driver and a list of his or her current assignments.

• Orders can be assigned to drivers by dragging the name of the driver on top of the order.

• Once a driver has been assigned, click the **Confirm All Changes** button to submit the changes to the server or click **Cancel All Changes** to undo the assignments.

• Be sure to synchronize with the OnTime server to ensure all data is transferred.
Dispatching Options

The system is able to monitor driver activity, location, synchronization, assignments, and more in the dispatching area:

The dispatching area contains three tabs:

- Driver List
- Driver Positions
- Unassigned Shipments

**Driver List**

This section lists all users that are assigned the driver role in *OnTime Management Suite*.

A green circle next to a driver’s name indicates that the driver is clocked in. A grey circle next to a driver’s name indicates that the driver is clocked out.

**Last Known Location** shows the last order drop off the driver had completed.

**Last Sync** displays when the driver has synced all orders with the *OnTime Mobile* software.

Double-clicking a name will pop up a dialog that will show more information regarding the driver such as Name, Email, SMS Address, Assignments, and mobile phone number. Right-clicking a driver brings up a menu with options for sending messages to that driver by SMS or by email.

**Driver Positions**

This section displays a map with the last known location of all drivers. Locations are updated every 60 to 90 seconds. Hover the cursor over a pin on the map to display the associated driver’s name.
Unassigned Orders

This section lists all unassigned orders that have been created in OnTime Dispatch. These orders can be assigned by dragging a driver’s name from the Driver List onto the specific order in the Unassigned Orders section. These assignments must be committed by clicking the Confirm All Changes button. More details can be found by double-clicking on an order. Drivers may be given the ability to assign unassigned shipments to themselves with the OnTime Mobile software.

Messages

The OnTime messaging feature allows messages to be sent to drivers in the field on their mobile devices. These messages are viewed using the OnTime Mobile application. With this feature, drivers can be warned of weather conditions and construction sites, or notified of special information regarding pickups and deliveries.

To Send a Message

1. Click New Message.
2. Choose the desired method to send the message. Choices include SMS text message, email, or through OnTime Mobile as a general message.
3. Select a driver to send the message to from the drop down list.
4. Enter the message to be sent.
5. Click Send.

Messages to Drivers

- Communicate with drivers by sending messages through OnTime.
- A new message may be sent out to a single driver or to everyone.
- After sending, it’s possible to see if and when a driver has read a message. There will be a check mark under the read by recipient column if the message has been read.

Be sure to synchronize with the OnTime server to ensure that message information is up to date.
Program Options

This window offers access OnTime Dispatch setting changes.

General

This section allows changes to be made to general settings throughout all areas of the program.

Close driver message after sending: This option closes driver messages after they have been sent to a driver in the Messages area of the program.

Only show drivers that are clocked in: When checked, drivers that are not currently clocked in will be filtered out of some lists.

The time clock is essential for tracking hours that the dispatcher has spent using the dispatch program. If these options are not checked, dispatchers must click the clock in/clock out option on the ribbon in the general tab for their time to be logged.

Clock in at startup: If this option is checked, the user signing into Dispatch will automatically clock in on sign in.

Clock out when program exits: If this option is checked, the user signed into Dispatch will be clocked out once the program is exited.

Always use last pickup location on new orders: When checked, new orders in the order entry screen will automatically load the last pickup location used on a submitted order for the specified customer.

Always use last delivery location on new orders: When checked, new orders in the order entry screen will automatically load the last delivery location used on a submitted order for the specified customer.

The option to play sounds determines if sound effects should be played on the computer when certain events occur, such as new orders coming in. Uncheck the box to silence these sound effects. If you wish to use your own sound effects, click the link labeled play custom sound when new items arrive. Sound effects can be selected if they are in the WAV audio file format. Return to the default sound effects at any time by clicking the link labeled use default sound.

The user interface of the program can be adjusted to use different color schemes. The available color schemes are blue, silver and black.

Customized user interfaces are preserved when any OnTime application is closed and restored when the application starts up. If there is a need to reset the user interface to its default settings, click the link labeled reset primary user interface layout.
### Startup

This section changes options for actions that occur when the program is started.

**Check for program updates:** When this option is selected, OnTime will check for any available updates and display a prompt if one is found.

**Automatically sign in:** When enabled, this option will automatically log in with same company ID, user name, and password that were last used to sign in. Uncheck this option to have the OnTime pause at the sign in screen to enter different credentials. We recommend not checking this option when using a public computer.

### Mapping

This section contains options to change the preferences of the mapping feature.

**Distance unit:** Which units the distance will be measured in when displaying the map. Valid choices are miles and kilometers.

**Route type:** The type of route can be *shortest*, *fastest*, or *preferred roads*. This preference will determine default routes.

### Tracking

**Automatically optimize the number of days of data displayed in the Tracking view:** The number of orders displayed in the Tracking view can grow larger over time. To ensure optimal performance, keep this option enabled. To override this optimization and manually set the number of days’ worth of data to display, uncheck this option and enter a value for *Manually set the number of days of data displayed*.

**Limit searching and filtering to data displayed:** When selected, this option will limit searching and filtering to orders within the “number of days of data displayed.” When this option is disabled, searching or filtering will reference ALL orders and will ignore the “number of days of data displayed.” Performance can be significantly improved by enabling this option.

### Color Coding

This section contains settings which relate to the tracking view. Three colors can be defined which correspond to time spans in relation to deadlines.

**Orders past the collection time** will change the color of an order’s row when the time is later than the window for picking up the order allows.

**Orders past the delivery due date** will change the color of an order’s row when the time is later than the window for delivering the order allows.

**Orders within XX hours of the due date** is a custom field which will change the color of an order’s row when the time gets to be within the number of specified hours of the latest time in the window for delivering the order.
Synchronization

To allow OnTime the unique ability to work in both an online and offline state, data added and changed on one computer is synchronized with all computers running OnTime within the organization. This section provides options regarding how synchronization works on a particular computer.

- How do you want to keep this computer in sync with OnTime
  - **Automatically**: Any changes made will be automatically sent to everyone.
  - **Let me manually control when synchronization occurs**: This option causes a synchronization button to appear in the ribbon, allowing manual control over when synchronization with the OnTime service occurs.

- Optimize synchronization with the server for
  - **Slow Internet connections**: Select this option for slower or unstable internet connections. Information is transmitted in smaller chunks to improve reliability, but can slow down synchronization.
  - **Fast Internet connections**: Select this option for faster and stable internet connections, such as DSL or cable. Information is moved in larger chunks, which improves the speed of synchronization.

- If you and another user change the same record at the same time and there is a conflict
  - In a system such as OnTime, two or more people could edit the same record of data at the same time. While OnTime usually automatically resolves this conflict, sometimes a decision needs to be made regarding whose version of the data should be used. Users may use three options to determine when OnTime automatically assesses conflict and when the program prompts the user to decide a course of action:
    - **Ask me in each case**: A dialog box showing the two versions of data will appear every time that a conflict occurs. Select this option to stop OnTime from automatically resolving these conflicts.
    - **Always use the changes on the server**: If a conflict occurs, the changes made by others will always take precedence. Your changes will be overwritten.

Resources

This section contains information about the program and other resources, such as links to web sites.
Chapter 6: OnTime Customer Web Portal

Note: The OnTime Customer Web Portal is only available to Enterprise level or higher subscribers.

The OnTime Customer Web Portal (CWP) offers a real-time view of a customer’s orders. Here are some highlights:

- For quick access, the CWP can be viewed inside of OnTime Management Suite
  - The location should already be set and can be viewed under Tools > Connections
- Customer can log in using either their email address or account number and password
- Orders can be self-dispatched by clicking on the Dispatch link
  - This interface is very similar to OnTime Dispatch
  - Pickup and Delivery locations include a history of addresses previously delivered to, as well as the option to add new addresses
  - Any address can be edited from the Address Book link later
  - The desired service level and preferred pickup and delivery times can be selected in the service section
  - The current time zone is indicated
  - Customer can choose the options desired for the shipment
  - Required options will appear grayed out and cannot be unchecked
  - Dispatching the shipment will take customers to their tracking view where they can then see the live status and print out shipping labels if required
- The addresses that appear in a customer’s address book are designated by how that customer and those locations are linked. From either the customers or locations list, right click on a record and choose to link one to the other.

Customizing the OnTime Customer Web Portal

The OnTime Customer Web Portal is a web application that can be linked to any company’s existing web site. This website offers customers access to tracking, self-dispatching, address book, and other features directly from a company’s web site. The Customer Web Portal comes with a generic default theme. The theme may be customized to match an existing web site.

Change the Layout

The layout refers to the position of elements in a web page. Changing the layout refers to moving those elements or blocks to another location on the web page.

The OnTime Customer Web Portal makes use of ASP.NET Master Pages; thus, all features of that technology can be employed in customizing the site. More information on ASP.NET Master Pages can be found at the Microsoft web site. Making changes to the master page allows the layout of elements to be changed on every web page in the site.
The master page files are located in Theme folder, which is located in the OnTime Customer Web Portal site. The file that should be edited is named MasterPage.master. Because making changes to the master page file can cause problems if the changes are done incorrectly, we recommend making a backup copy of the file before editing it.

**Change the Style**

The style refers to the visual elements of the web page such as font, size, and color. Changing the style refers to altering those fonts, sizes, and colors to match the graphical needs of a design.

The OnTime Customer Web Portal makes use of industry standard CSS style sheets. Making changes to the CSS files will allow the appearance of elements to be changed on every web page in the site.

The CSS files are located in Theme folder, which is located in the OnTime Customer Web Portal site. The primary file that should be edited is named baseStyle.css. Because making changes to the CSS file can cause problems if the changes are done incorrectly, we recommend making a backup copy of the file before editing it.

**Making Changes to the Master Page and CSS Files**

Changes are made to the layout (MasterPage.master) and style (baseStyle.css) files from within OnTime Management Suite:

1. Click **General Options** from under the **Home** tab.
2. Click **Customer Web Portal**.
3. Under the **Appearance** section, ensure that **Advanced Customization** is selected.
4. Click the link labeled **Edit Master Page and CSS**.
5. The current state of both files will appear under tabs labeled **Master Page** and **CSS** at the top of the window. Make changes to the files as needed or choose **Reset to Default** to recover the files back to their original, default state.
6. Click **OK** to save the changes. Note: Due to caching, some changes may take a few minutes to resolve.
Chapter 7: OnTime Mobile

OnTime offers the option to use the mobile hardware desired. With OnTime Mobile, virtually any mobile device with internet access can make use of OnTime’s features.

Using OnTime Mobile for iOS

A high performance app is available for couriers using Apple devices such as iPhone, iPad, and iPod Touch. Features include the ability to work online or offline, barcode scanning, capture signatures and photos for proof of delivery, order editing, transfers, time clock, and much more.

To Install OnTime Mobile for iOS

1. Start the App Store on your device
2. Choose the option to search for an app and search for: OnTime 360
3. You should find OnTime Mobile within the list of search results. Open the OnTime Mobile product page and tap the GET button
4. Once installed, open OnTime Mobile. Once OnTime Mobile starts up, sign in with your driver credentials

Using OnTime Mobile for Android

A high performance app is available for couriers using Android devices. Features include the ability to work online or offline, barcode scanning, capture signatures and photos for proof of delivery, order editing, transfers, time clock, and much more.

To Install OnTime Mobile for Android

1. Start Google Play on your device
2. Choose the option to search for an app and search for: OnTime 360
3. You should find OnTime Mobile within the list of search results. Open the OnTime Mobile product page and tap the INSTALL button
4. Once installed, launch OnTime Mobile from your list of installed apps. Once OnTime Mobile starts up, sign in with your driver credentials

Using OnTime Mobile Web

- OnTime Mobile Web can be used on any device with a web browser, including most mobile devices. A good connection to the internet is required.
- Access OnTime Mobile Web on the mobile device by navigating to the URL supplied by Vesigo Studios.
• Log in using the appropriate user name and password.
• Features such as working with shipments and receiving messages from dispatchers are accessible after log in.

Using OnTime Mobile WAP Edition

• To use OnTime Mobile WAP Edition a mobile device which is either WAP enabled or has a web browser with access to the internet is required.
• Access OnTime Mobile WAP Edition by navigating to the URL supplied by Vesigo Studios on the mobile device.
• Log in using the appropriate user name and password.
• Basic features such as working with shipments and receiving messages from dispatchers are accessible after log in.
• Because mobile devices’ WAP interfaces vary, OnTime Mobile WAP Edition will generally appear differently on different devices.

Using OnTime Mobile for Windows Mobile

• Windows Mobile 2003 or later devices have enhanced functionality with many more features available.
• A built-in database stores all information locally on the device allowing work to be done whether or not an internet connection is available, a common scenario when using cellular networks.
• Windows Mobile devices with touch screens can be used for capturing digital signatures.
• Barcode scanning devices can be used to automate the scanning of shipments.
• Assignments and route stops contains a list of all orders assigned to the driver.

• Appropriate options for the driver are available from the Menu at the bottom of the list.
• Orders that require a signature or COD will automatically alert drivers when they pick up or deliver.
• Messages will display a list of messages sent by a dispatcher to the driver. The driver can respond by choosing the Reply option.
• Choosing Synchronize will prompt data from the device to be sent to the server and all new data will be sent to the device.
• Run a scan allows barcode features to be entered manually or with a barcode scanner attached to the device.
• Select **Key in** to manually enter part of a tracking number in. Choose **Done** to search both locally assigned shipments and others that are on the server. Pick a shipment from the list and then click **Done** to access the shipment’s options.

• If appropriate, the option to **log check point** will be available. This option allows a **location** and **notes** to be entered. This information can be viewed by dispatchers in the tracking view.

• Connection status and options for reconnecting after being offline can be viewed from the **Tools** menu under **Connection Status**.

**The Home Screen View in OnTime Mobile for Windows Mobile**

The home screen in *OnTime Mobile for Windows Mobile* can be customized to show only desired items in the desired order:

1. In *OnTime Mobile for Windows Mobile*, go to the **Tools** menu, select **Options**, and then the **Home Screen** tab.
2. Check items to appear and uncheck items to hide.
3. Select an item and then tap the **Move Up** or **Move Down** button to change the order in which the items appear.
4. Press **OK** to save the settings.

**Time Clock Features in OnTime Mobile**

*OnTime Mobile* will **not** automatically clock the user in and out when the program or session is started and ended.

**To Clock In or Out when Using OnTime Mobile for Android or iOS**

1. Go to the menu and choose **Clock In/Out**
2. Choose a **vehicle** from the list
3. Enter the current **odometer** reading for that vehicle
4. Choose **Clock In** or **Clock Out**
To Clock In or Out when Using OnTime Mobile for Windows Mobile

1. Go to the Tools menu
2. Choose Time Clock
3. Choose a vehicle from the list
4. Enter the current odometer reading for that vehicle
5. Choose Clock In or Clock Out

To Clock In or Out when Using OnTime Mobile WAP Edition

1. Select the clock in or clock out link
2. Choose a vehicle from the list
3. Enter the current odometer reading for that vehicle
6. Choose Clock In or Clock Out

OnTime Mobile will record the time spent as a driver and the number of orders handled while the user is clocked in.
Chapter 8: Become Familiar with OnTime’s Advanced Features

As explored thus far in this guide, OnTime software is equipped with a multitude of useful features. This chapter more thoroughly explores some of the more advanced aspects of our programs.

Tracking and Modifying Orders

OnTime Management Suite and OnTime Dispatch can both access the same tracking information, allowing users to view the status of any shipment, active or inactive. This accessibility also allows certain properties of a shipment to be edited. For example, changing address information and accessorrial items.

Overview of the Layout

By default, all orders within OnTime are displayed in the main content area, including orders that have been completed, cancelled, or billed. This layout was built to ensure that users can access any order in any situation. Even orders that are accidently deleted may be recovered.
The columns in the below list can be rearranged by dragging left or right and dropping them into place.

The list can be sorted by a specific column by clicking on the name (or column header) of the desired column. Clicking on the column header a second time will reverse the sorting order. Sort by multiple columns by right-clicking on a column header and choosing Sort Ascending or Sort Descending from the context menu.

By default, most of the 50+ available columns are shown in the Tracking view. Unnecessary columns can be hidden to improve the performance of the Tracking view. To customize the columns, right-click on any column header and choose Show/Hide Columns. A window (pictured below) will open with a list the available columns. Utilize the checkboxes to add and remove columns.
Available columns from “Show/Hide Columns” window

The orders can be grouped by common fields such as **Status, Currently Assigned To, Route, Customer, and Collection/Delivery Location**. Click on the **Group By** button in the **Tracking** tab of the ribbon. Then select the desired column.
Group by any other column by right-clicking a column’s header and choosing **Group By This Column** in the context menu, as shown here:

Group by multiple columns by repeating the steps above.

When grouping by one or more columns, the column(s) will disappear from the list and appear in the **Group By Box**. The **Group By Box** will display columns currently used for grouping, their relationship to one another, and their current sort order.

By default, OnTime will automatically calculate the optimal number of orders displayed in the tracking view to improve performance. If the number of orders is limited in any way, a note will appear at the bottom of the list as illustrated here:
To quickly print the current contents of the Tracking view, click the link labeled Print Current View... under Tasks.

Reports and exporting options may be accessed by right-clicking on a selected order. The appropriate items will be available in the menu that appears, as shown below:

**Searching the Tracking View**

Advanced searching capabilities are available within the tracking view. This functionality ensures that desired information is readily available.
Clicking on **Advanced Search** will cause the filter row to appear across the top of the tracking view:

![Filter Row

The advanced searching area

All orders are returned if the filter row is left empty. To filter data within a specific column, enter text or make a selection in the filter row for that column. For example, to show only orders containing “123” in the tracking number, using the following:

<table>
<thead>
<tr>
<th>Tracking Number</th>
<th>Collection Location</th>
<th>Delivery Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td></td>
<td></td>
</tr>
<tr>
<td>99912345-Test</td>
<td>Costco - Medford</td>
<td>Bi-Mart - Medford</td>
</tr>
<tr>
<td>14123</td>
<td>Kerry API Test</td>
<td></td>
</tr>
</tbody>
</table>

Or to see every order assigned to “John Smith”:

![Submitted By

To display only orders currently set to the **Submitted** status:

<table>
<thead>
<tr>
<th>Submitted By</th>
<th>Status</th>
<th>Currently Assigned To</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>John Smith</td>
</tr>
</tbody>
</table>

To see orders submitted on a certain day:

<table>
<thead>
<tr>
<th>Delivery Location</th>
<th>Date Submitted</th>
<th>Submitted By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location 2 A5</td>
<td>9/10/2019</td>
<td>OnTime Route Scheduler</td>
</tr>
</tbody>
</table>

Combine multiple criteria to create more complex filters. For example, all orders assigned to John Smith with a date of 9/10/2019:

<table>
<thead>
<tr>
<th>Date Submitted</th>
<th>Submitted By</th>
<th>Currently Assigned To</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/10/2019</td>
<td></td>
<td>John Smith</td>
</tr>
</tbody>
</table>
Comparing Values with Criteria Operators

An icon representing a criteria operator appears on the left side of each filter row’s column. A criteria operator determines how a search should be performed, how values should be compared with each other. Clicking on the criteria operator’s icon displays a list of available operators to choose from.

The list of available criteria operators may change based on the type of data contained within the column. For example, the following operators appear when filtering on a date-based column:

To clear all filtering within the tracking view, click the Clear Search button under the Tracking tab.
Advanced Filtering using the Filter Editor

Complex filtering requirements can be addressed using the powerful filter editor. The filter editor makes it possible to combine multiple criteria, group criteria, make use of logical operators, and use powerful calculation functions. To open the filter editor, click the Advanced Filter button under the Tracking tab.

The filter editor presented in two views: A user friendly Visual view and an advanced scripting mode within the Text view.

The Filter Editor: Visual View

To create and customize filter criteria, use the + and x buttons and context menus supported by editor elements.

A filter condition group is a set of conditions combined by the same logical operator. The following filter expression contains two groups combined by the logical OR operator:

\[
\text{[Customer Name]} = 'DS Labs' \ \text{AND} \ \text{[Status]} = 'Cancelled' \ \text{OR} \\
\text{[Customer Name]} = 'Aspire Enterprise' \ \text{AND} \ \text{Contains([Service Level], 'Routine Medical')}\]
This can be represented within the filter editor as follows:

**Add Conditions**

To add a condition to a logical group, do one of the following:

- Focus any condition within the group or the group’s logical operator, and then press INS on the keyboard
- Click the + button for the group
- Click the group’s logical operator and select Add Condition

To add a group of conditions to another group, do the following:

- Click the group’s logical operator and select Add Group

To add a condition or a group of conditions that have been copied to the Clipboard, press CTRL + V or SHIFT + INSERT. The new condition will be added to the focused group.

**Delete Conditions**

To delete a condition, do one of the following:

- Focus the condition and press DELETE
- Click the X button
To delete a group of conditions, do one of the following:

- Focus the group’s logical operator and press DELETE
- Click the group’s logical operator and select **Remove Group**

To delete all conditions, do one of the following:

- Focus the topmost logical operator and press DELETE
- Click the topmost logical operator and select **Clear All**

To cut a condition/group of conditions to the Clipboard, focus this condition/the group’s logical operator and press CTRL+X or SHIFT+DELETE.

**Work with the Clipboard**

To copy a condition/group of conditions to the Clipboard, focus this condition/the group’s logical operator and press CTRL+C or CTRL+INSERT.

To cut a condition/group of conditions to the Clipboard, focus this condition/the group’s logical operator and press CTRL+X or SHIFT+DELETE.

To paste a condition/group of conditions from the Clipboard to the focused group, press CTRL+V or SHIFT+INSERT.

**Change a Column in a Filter Condition**

To change a condition’s column, invoke the column list by doing one of the following:

- Click the current column
- Focus the current column via the keyboard and press SPACE or ALT+DOWN ARROW

Then, choose the required column from the list to be invoked.

**Change an Operator in a Filter Condition**

To change a condition’s operator, invoke the operator list by doing one of the following:

- Click the condition’s current operator
- Focus the current operator via the keyboard and press SPACE or ALT+DOWN ARROW

Then, choose the required operator from the list to be invoked.
**Edit a Condition’s Value**

To edit a condition’s value, click the value editor box and type text.

To activate the value’s edit box without changing the value, click the value or focus the value via the keyboard and press F2, SPACE, ENTER or ALT+DOWN. To close the active edit box, press ENTER. To discard changes to the value and close the active edit box, press ESC.

**Compare a Condition’s Column with Another Column**

A condition may include a comparison of two columns within the same record instead of a value. To compare two columns, do one of the following:

- Click the toggle button:
  ![Filter Editor](image)

- Press CTRL+Q

Then, specify the column via the value’s edit box.

![Filter Editor](image)
The Filter Editor: Text View

The filter editor contains a **Text** view, which can be activated by selecting the **Text** tab.

---

The **Text** view presents a scripted, or expression based, version of the current filter.

Many advanced functions are available within this view that are not possible in the **Visual** view. As a result, not all scripting can be displayed within the **Visual** view. In such cases, **Visual** view will display the following message: Cannot create a tree for this expression.

The Text view offers syntax checking, auto complete, and recommendations as you type. Many built in functions are available including those for string and date manipulation and numeric calculations.

For example, the following image illustrates using the **AddDays** function to locate orders submitted seven days ago:
Constructing Filter Criteria Consisting of Multiple Different Logical Operators

Some filter criteria contain multiple logical (Boolean) operators combining simple filter conditions. To build such criteria via the Filter Editor, first, you need to identify groups of filter conditions. A filter group is a set of simple filter conditions or other groups combined by the same logical operator. Consider the following filter criteria:

\[
\text{[Customer Name]} = 'DS Labs' \text{ AND } \text{[Status]} = 'Cancelled' \text{ OR } \text{[Customer Name]} = 'Aspire Enterprise' \text{ AND } \text{Contains([Service Level], 'Routine Medical')}
\]

Identify groups to make the criteria more logical and readable:

\[
\text{[Customer Name]} = 'DS Labs' \text{ AND } \text{[Status]} = 'Cancelled'
\]

\text{OR}

\[
\text{[Customer Name]} = 'Aspire Enterprise' \text{ AND } \text{Contains([Service Level], 'Routine Medical')}
\]

This expression contains two groups of filter conditions combined by the OR operator. In each group, filter conditions are combined by the AND operator. This example would be rendered in the filter editor’s Visual view as follows:

![Filter Editor Visual View](image)
The same example would appear in the **Text** view as follows:

```
([Customer Name] = 'DS Labs' And [Status] = 'Cancelled') Or ([Customer Name] = 'Aspire Enterprise' And Contains([Service Level], 'Routine Medical'))
```

**Quick Views**

Advanced searches in the tracking view can take a bit of time to construct and make work in the desired fashion. The **Quick Views** feature allows searches to be saved and returned to at a later point.

After filtering data in the desired manner, click the button labeled **Save as Quick View** under the Tracking tab.

When prompted, provide a **name** to easily identify the search later:
The saved view will appear on the left-hand side after a search has been saved:

A saved view can be reloaded at any time by selecting from this saved view list. A saved view not only saves the search criteria, but also the column sorting, visibility, and layout.

Saved views are extremely useful in customizing the tracking view to be exactly what you need and provide a quick way to back to that information in the future. Views are also the standard way of providing workers the data they need to see to accomplish their jobs. Saved views accommodate their needs by allowing them to see only the data they need, in the format they need it.
To Manage Existing Saved Views

1. Click on the Modify View List button in the Tracking tab of the ribbon, as shown here:

![Modify View List button](image)

2. The window that appears will allow existing saved views to be renamed and removed. Saved views are saved locally to the computer they are created on (not automatically synchronized to other computers); however, the import and export features may be used to move a saved view between computers. The export option allows the selected saved view to be saved as a (.OTSV) file. The import option will import one of the exported files (.OTSV).

![Modify Quick Views window](image)

Working with Shipments in the Tracking View

There are two primary ways of working with orders in the tracking view:

- Right-click on an order (or orders) and perform an action
- Double-click on an order and edit the contents of an order
Perform Actions on an Order

Some of the actions available within the context menu (access by right-clicking on orders) in the *Tracking* view are shown here:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Opens the order for editing</td>
</tr>
<tr>
<td>New Route Stop Based on This Order...</td>
<td></td>
</tr>
<tr>
<td>Create Duplicates of This Order...</td>
<td></td>
</tr>
<tr>
<td>Assign To...</td>
<td></td>
</tr>
<tr>
<td>Unassign</td>
<td></td>
</tr>
<tr>
<td>Change Status</td>
<td></td>
</tr>
<tr>
<td>Add to Invoice...</td>
<td></td>
</tr>
<tr>
<td>Calculate Distance</td>
<td></td>
</tr>
<tr>
<td>Update Prices</td>
<td></td>
</tr>
<tr>
<td>Locked</td>
<td></td>
</tr>
<tr>
<td>Route (Not Associated with a Route)</td>
<td></td>
</tr>
<tr>
<td>Process a Notification</td>
<td></td>
</tr>
<tr>
<td>Trigger Event</td>
<td></td>
</tr>
<tr>
<td>Reports</td>
<td></td>
</tr>
<tr>
<td>Send Status Update to CommerceHub</td>
<td></td>
</tr>
<tr>
<td>Export to CSV...</td>
<td></td>
</tr>
<tr>
<td>Export EDI Files...</td>
<td></td>
</tr>
<tr>
<td>Export POD to IPC...</td>
<td></td>
</tr>
<tr>
<td>Alero/Costco: Export to CSV...</td>
<td></td>
</tr>
<tr>
<td>Map Delivery Location</td>
<td></td>
</tr>
<tr>
<td>Export to MSD...</td>
<td></td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Export...</td>
<td></td>
</tr>
<tr>
<td>Group By</td>
<td></td>
</tr>
<tr>
<td>History...</td>
<td></td>
</tr>
<tr>
<td>Customize Current View...</td>
<td></td>
</tr>
<tr>
<td>Show Deleted Items</td>
<td></td>
</tr>
<tr>
<td>Refresh</td>
<td>F5</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
</tbody>
</table>

*Open*: Opens the order for editing
Create Duplicates of This Order: Allows multiple copies of an order to be created. Specify the number of copies desired and modify the mask for the tracking number as necessary. Clicking the Generate Copies button will create the duplicates as new orders in the system. All duplicated orders will have unique tracking numbers, which will be listed in the results section.

Assigned To: Assigns the selected order(s) to a specific driver
When selecting a user to assign the order to, additional options appear at the bottom of the window:

- **Also assign as collection driver**: OnTime maintains a reference to the pickup, or collection, driver, which is important when calculating compensation for the driver. Check this box appropriately.
- **Also assign as delivery driver**: OnTime maintains a reference to the delivery driver, which is important when calculating compensation for the driver. Check this box appropriately.
- **Process workflow notifications**: Normally notifications created in the workflow designer will not be processed when assigning drivers from the Tracking view. To ensure that they process, check this box.

**Unassign**: Removes the currently assigned driver. This option places the order back into the unassigned queue.

**Status**: Changes the status on the selected order(s). Order status can be classified into one of 5 main categories:

- **Submitted**: The order has been submitted and is awaiting courier collection
- **In Transit**: The order has been collected by the assigned driver
- **Completed**: The order has been delivered to its destination
- **Canceled**: The order has been cancelled (only possible if the order's current status is submitted or in transit)
- **Canceled (Billable):** The order has been cancelled, but may still be subject to charges (only possible if the order’s current status is submitted or in transit)

To set the status of an order, choose Status > Set to... [The appropriate status] > **Normal**. For example, to manually change an order to be in transit:

The **Normal** option sets the status on the order and nothing more. **Status labels** are available to add comments accompanying the status change. The **Custom** menu item is listed below the **Normal** menu item:

**Custom** sets the status and allows a time stamped comment about the status change to be entered. Shippers can see a historical view of the shipment and its progress, much like views available with large carriers such as FedEx and UPS.

Oftentimes, the same status labels are typed in repeatedly. OnTime allows users to pre-define a list of status labels. Labels can then be chosen from a list instead of being typed in by hand every time.

**To Enter a New Global Status Label**

1. Choose **Status Labels** from the **Home** tab in the ribbon:
2. Click on the **New** button at the bottom of the resulting window:

![Status Label window](image)

3. Enter a **name** by which to identify the status label. This **name** will appear to workers when they change the status on orders.

4. The **phase** indicates at which status this label should appear.

5. The **description** will appear to the shipper as a detail of what happened to the shipment at that point in time.

6. The variety of status labels that can be utilized provides a consistent and simple method to make status changes to customers’ shipments.

![Status Labels window](image)

**Route > Assign To**: If the selected order is part of a route, OnTime will assign all uncompleted orders on that route to a different driver.

**Trigger event**: Allows one or more events to be manually activated for the purpose of triggering all applicable notifications (created in the Workflow Notification Designer) associated with the selected order(s).
Check all of the events to be manually trigger for the selected order(s). Click OK and OnTime will process all corresponding notifications.

This option is useful when resending notifications. For example, if a customer missed a proof of delivery email, it can be re-sent by right-clicking on the appropriate order and selecting **Trigger Event > Order Delivered**.

Other functions available from the Tracking view context menu:

- **Update Distance**: Recalculates the distance on the selected order(s).
- **Update Prices**: Recalculates the total price on the selected order(s).
- **Copy**: Saves the list of orders displayed in the tracking view to the clipboard. This selection can then be pasted into a spreadsheet program, such as Microsoft Excel.
- **Export**: Saves the list of orders displayed in the tracking view to a CSV file.
- **Group By**: Groups the list of orders by the selected column. Additional columns may be used for grouping by right-clicking on a column header and choosing **Group By This Column**.
- **Refresh**: Reloads the current list of orders.
- **Delete**: Removes the selected order(s) from the system.
- **Reports**: Includes several reports, each one available in a preview mode and a direct print mode. If more than one order is selected to print, each one will be rendered separately. In the preview mode, a separate preview window will open for each order selected. In the direct print mode, as illustrated below, all selected orders will be sent to the printer for batch printing:

![Reports Menu](image)

- **Shipping Label**
- **Waybill**
- **Work Sheet**
Note: The default printer, as configured in Windows, is the printer used by print mode. To use a different printer to perform batch printing, adjust the default printer in Windows.

To Edit the Contents of an Order

1. Enter the tracking view and double-click on the desired order. The order’s details will appear.
2. Double-click on any row with an edit icon (as illustrated below) to edit the associated value in the resulting window.

<table>
<thead>
<tr>
<th>General</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracking number</td>
</tr>
<tr>
<td>Status</td>
</tr>
<tr>
<td>Date submitted</td>
</tr>
<tr>
<td>Source</td>
</tr>
<tr>
<td>Submitted by</td>
</tr>
<tr>
<td>Currency assigned to</td>
</tr>
<tr>
<td>Vehicle type</td>
</tr>
<tr>
<td>Route name</td>
</tr>
<tr>
<td>Signature required</td>
</tr>
<tr>
<td>Collect COD</td>
</tr>
<tr>
<td>Reference number</td>
</tr>
<tr>
<td>Purchase order number</td>
</tr>
<tr>
<td>Locked</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price set</td>
</tr>
</tbody>
</table>

Note: Changing a price set on an order may affect the pricing. OnTime will re-calculate the cost of the base price of the order with the new price set. The associated price modifiers (listed under options) will remain, but will attempt to use the new price set. Because these changes may cause issues, we recommend checking the base price and the pricing options before leaving an adjusted order.

The pricing on orders may be adjusted when price sets and modifiers are modified. In such cases, OnTime will continue to use the prices calculated upon order entry (the cached price).
To Use New Pricing on an Order

1. Open the order

2. The yellow box at the top of the window is an alert detailing where pricing adjustments are occurring. To use the new prices, click the blue link labeled “click here to use the new prices”

Order Details

The following sections are contained in the order details window.

General

This section provides general information about the order including the prices and customer profile.

Locations

This section details the collection and delivery location data, including the courier and arrival times.

Options

This section lists the options, or price modifiers, added to the order. Double-clicking some options within the list will allow for modification. To add new options to the order, choose either custom or add predefined charge.

Custom: Allows for a miscellaneous charge

Add predefined charge: A drop down list will show all available price modifiers linked to the price set active on the selected order

Signature: Configures the signature requirement on the order for pickup and/or delivery. This option is disabled if a signature type price modifier is not associated with the price set.

COD: Configures the Collect on Delivery (COD) requirement on the order for pickup or delivery. This option is disabled if a COD type price modifier is not associated with the price set.
Items
This section lists the items contained in the order as designated by the dispatcher.

Comments
Description: The public description of the order. Everyone, including the shipper, can view this text.
Comments: Private comments about the order. These comments are hidden from the shipper.

Signature/COD
This section details the results of the signature and/or COD requirements. An image file representing a signature for the pickup and delivery may be manually imported, which is especially useful for drivers who have mobile devices that are incapable of signature capture.

<table>
<thead>
<tr>
<th>Configure:</th>
<th>Signature Options</th>
<th>COD Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Signature is not required" /></td>
<td>Signature is not required</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import an image as the signature captured on collection..." /></td>
<td>Import an image as the signature captured on collection...</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Import an image as the signature captured on delivery..." /></td>
<td>Import an image as the signature captured on delivery...</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="COD was not requested for this order." /></td>
<td>COD was not requested for this order.</td>
<td></td>
</tr>
</tbody>
</table>

Right-clicking on a signature allows it to be copied to the clipboard and/or saved as a file.

Custom Fields
This section lists every active user defined field, along with each field’s respective set values. Double-click on the row of any value to make adjustments.

Transfer Log
This section will display a log of orders transferred between drivers in the field.
**User Compensation**

This section breaks down user compensation for the selected order. Adding *time* or *money* to a user (using the buttons in the tool bar as shown below) allows for one-time adjustments to be made to the compensation of that user:

The compensation can be a positive or negative amount. Entering a number plainly (i.e.: $5.00) will indicate a positive value. To enter a negative value, place the value between parenthesis (i.e.: ($5.00)). Further information about the one-time adjustment may be entered into the **Description** field. For example, if we wanted to provide a $5.00 bonus to a driver on this order because of a job well done, we could add this:

However, if we need to deduct $10.00 because of a mistake by the driver, we can do this:

When the user’s **Time and Activity** report is generated, these one-time adjustments will be automatically included. Double-clicking on a one-time adjustment in the user compensation list will allow for modifications to be made.
Attachments

Files may be attached to orders, helping to keep scanned paperwork connected with related orders. Any number of files may be attached to an order; however, each file's size must be less than 100 kb.

To attach a file to an order, drag and drop the desired file into the list from Windows. Alternately, right-click in the list and select Attach File:

Other users of OnTime Management Suite and OnTime Dispatch will be able to access and download attached files. To download an attached file, right-click and select Save As. Shippers using the OnTime Customer Web Portal will also be able to see attached files and can download them directly with a web browser.

Note: We recommend using common file formats, such as PDF, to ensure that customers experience minimal issues opening the files.

History

This section provides a list of all of the changes that have happened to an order. A time stamp and name of the person who made the change appears on every record. The list is sorted chronologically, with the most recent changes at the top. Because this history cannot be altered, the information provided can help to audit issues with an order.

Status Changes

This section lists the status changes added to the selected order. Double-click an existing status to manually change it. Click the button in the toolbar labeled Add Custom Status Change to enter in a custom status label.
Reporting

OnTime offers several options to report and analyze data. While OnTime is fully capable of communicating with third party reporting and analysis tools, such as Crystal Reports, there are also several robust tools included within OnTime Management Suite.

Locating Reports in OnTime

While many courier software solutions only allow access to printable reports from a single location, the OnTime Suite presents reports throughout its programs contextually. Reports are rarely more than a right-click of the mouse away.

A popular report that is available from virtually every major list in OnTime can be found clicking link labeled Print Current View on the left:

Choosing these options will simply print the chosen list as it appears. This list will reflect any column sorting, reordering, or resizing that has been done.
Other reports can usually be found by right clicking on a list and choosing the **Reports** menu as illustrated here:

This same Reports menu is available under several of the lists. Here are some of the reports that can be generated in OnTime:

- User Time and Activity Summary
- User Time and Activity Summary
- User Current Assignments for Today
- User Current Assignments across Date Range
- Zone to Zone Price Sheet
- Customers: All Shipments by Date Range
- Driver Route Stop Sheet
- Shipping Label
- Driver Assignment Work Sheet
- Bill of Lading
- Billing Cycle Orders
- Individual Order
- Invoice
Customize Reports

Modifications may be made to reports using the report designer built into OnTime.

1. Load a preview of the desired report. If the report may be customized, a Modify button will appear in the toolbar of the preview window as shown here:

Note: If the Modify Report button does not appear, the report cannot be customized.
2. Click the **Modify Report** button to launch the report designer.

**Authoring Custom Reports**

For information on how to author custom reports, please see the section titled Reporting under chapter 3 of this guide.
Billing and Accounting

OnTime can help to simplify the important processes of invoicing customers and posting payments received. Because all of the details and pricings of orders have already been entered, OnTime is able to convert that information into an invoice. The generated information can then be transferred into QuickBooks, keeping accounting up-to-date.

Billing Cycles

Each customer can have a unique billing cycle, which helps to accommodate specific billing schedules required by customers.

Set a Customer’s Billing Cycle

3. Open the customer record
4. Select the Billing tab
5. Click Set Billing Cycle. A window in which the schedule can be defined will appear:

![Billing Cycle Schedule](image)

Sample billing cycle schedule showing once a month on the last day of each month

At the end of each billing cycle, OnTime will automatically aggregate orders entered for the customer during that cycle and display them under the Billing Cycles view, as illustrated here:

![Billing Cycles View](image)
If a previous billing cycle was not invoiced to the customer, that billing cycle will be added to the current one and reflected in the **Cycles Included** column. To generate an invoice of the current billing cycle, right-click on the row and choose **Add to Invoice**.

**Invoices**

OnTime can create invoices for customers with the information already entered into orders. OnTime also keeps track of which orders have been invoiced and which ones have not, ensuring that nothing of importance is overlooked during the billing process.

**Creating Invoices from Billing Cycles**

A billing cycle for a customer may be turned into an invoice by right clicking on the billing cycle row and choosing **Add to Invoice**:

![Image showing Add to Invoice button]

**Creating Invoices from Individual Orders**

An invoice can be created from one or more orders by manually selecting them, right clicking on the row, and choosing **Add to Invoice**. To add more than one order to an invoice, select more than one item at a time by holding down either the SHIFT or CTRL key while clicking the mouse on the desired items. When selecting more than one invoice in this manner, select only orders that belong to the same customer. Invoices cannot be generated for mixed orders with different customers; the **Add to Invoice** option will be disabled.
Adding Order to an Invoice

After selecting the source of the orders that will appear in the invoice, the following window will appear:

This window offers the choice to add the selected orders to either a new invoice or an existing invoice for that customer. Choose the appropriate selection and click OK. The invoice will now be created.
Switch to the Invoices view to see the invoices created:

By default, all **Open Invoices** will be displayed, which are invoices that have yet to be paid. Change the view by selecting **All Invoices** or **Overdue Invoices** from the **Filter By** menu, as shown below:

Several options are available to send invoices directly from OnTime to customers: Preview, Print, Email, and Fax.
- **Preview**: Select the desired invoice and click the **Preview** button to open a print preview of that invoice. This method also allows for the selected invoice to be exported to a file, such as PDF.

![Export/Print Options](image)

- **Print**: Select the desired invoice and click the **Print** button to send that invoice directly to a printer.
• **Email:** Select the desired invoice and click the **Email** button to send that invoice to the associated customer’s billing email address. Confirmation of the name and email address of the customer is required before sending. The invoice will be attached to the email as a PDF file. To customize the text that appears in the body of the email, select the **Home** tab and then choose **General Options > Billing > Email Template**.

![Email Template](image1)

• **Fax:** Select the desired invoice and click the **Fax** button to send that invoice directly to the associated customer’s fax machine number. Confirmation of the name and fax number of the customer is required before sending.

![Confirm Fax](image2)

Note: Faxing may cost an additional fee per page. Click on **More information on faxing services** to learn about our low-cost faxing alternative.
Connecting to QuickBooks

To export transactions from OnTime to QuickBooks, QuickBooks must be informed that OnTime is a trusted program that is permitted to transfer data. QuickBooks will usually display a window when OnTime attempts to communicate data; however, manual configuration of QuickBooks may be required. Try the following steps if a message appears indicating that “QuickBooks could not be started,” “QuickBooks is not installed,” or “OnTime could not find QuickBooks.”

**Note:** Administrative access to QuickBooks is necessary to adjust some of the settings below. If that access is unavailable, contact your QuickBooks administrator to change these settings.

1. Open the desired company's file in QuickBooks.
2. From *OnTime Management Suite*, attempt to post an invoice or payment to QuickBooks.
3. If a window similar to the one pictured below appears, select **Yes, whenever this QuickBooks company file is open** and click **Continue**.

4. If posting to QuickBooks is still unsuccessful or the window shown above does not appear, continue to step 5.
5. Close all programs and restart the computer. This may help to clear out cached settings in QuickBooks preventing third party programs from properly connecting.
6. Once the computer has restarted, open QuickBooks and the desired company’s file.
7. Open the **Edit** menu in QuickBooks and choose **Preferences > Integrated Applications**.
8. Select the Company Preferences tab. The check box labeled **Don't allow any applications to access this company file** must be **unchecked**.
9. A check mark must be next to the OnTime entry in the list box as illustrated below:

![Preferences dialog box with OnTime entry selected](image)

10. With the OnTime entry selected in the list box, click the **Properties** button.
11. Access rights must be selected as illustrated below:

![Access Rights](image)

12. Click **OK** to save the changes in QuickBooks and close all windows.
13. Attempt to post an invoice or payment from OnTime.

If problems persist, contact OnTime Customer Support.
Sending Transactions to QuickBooks

OnTime can transfer invoices and payments into QuickBooks 2002 Pro and higher.

Minimum requirements: OnTime requires QuickBooks 2002 Pro or higher. OnTime does not support QuickBooks Basic versions.

How to Export an Invoice to QuickBooks

1. Launch QuickBooks.
2. Open the desired file. The company’s file open in QuickBooks is the one that OnTime will connect with.
3. From the Billing area in OnTime Management Suite, choose the Invoices list.
4. Select one or more invoices from the list, right-click, and choose Post to QuickBooks.
5. A window will appear listing the invoices selected to transfer. If the list is complete, click the button labeled Send to QuickBooks.
6. If prompted, give OnTime permission to communicate with QuickBooks.
7. Answer any further onscreen prompts to ensure that all information is successfully copied to QuickBooks.

OnTime keeps track of invoices that are transferred to QuickBooks and will issue an alert if the same invoice is sent multiple times. These alerts will not impede users from deleting invoices within QuickBooks and re-importing those invoices from OnTime.

The invoice number in OnTime will be used as the invoice number in QuickBooks. If desired, the invoice number may be changed in QuickBooks.
OnTime requires that the **company name** of a customer exactly matches the **customer name** in QuickBooks. If a match is not found, OnTime can create a new customer record. Keeping the names of customers consistent between OnTime and QuickBooks can help to minimize duplicate customers.

Line items in invoices must be assigned to an **Item** in QuickBooks. OnTime creates a new **service item** in QuickBooks that corresponds to the name of the price set that is assigned to each order. If the **service item** does not exist in QuickBooks and OnTime creates it, it will automatically be assigned to the **Other Income** account in QuickBooks. If the created **service level** should be assigned elsewhere, QuickBooks offers the option to retroactively assign those transactions to the new account.

**How to Export a Payment to QuickBooks**

1. Launch QuickBooks.
2. Open the desired file. The company's file open in QuickBooks is the one that OnTime will connect with.
3. From the **Billing** area in OnTime Management Suite, choose the **Payments** list.
4. Select one or more invoices from the list, right click, and choose **Post to QuickBooks**.
5. A window will appear listing the payments selected to transfer. If the list is complete, click the button labeled **Send to QuickBooks**.
6. If prompted, give OnTime permission to communicate with QuickBooks.
7. Answer any further onscreen prompts to ensure that all information is successfully copied to QuickBooks.

OnTime keeps track of payments that are transferred to QuickBooks and will issue an alert if the same payment is sent multiple times. These alerts will not impede users from deleting payments within QuickBooks and re-importing those payments from OnTime.

The reference number in OnTime will be used as the payment number in QuickBooks. If desired, the payment number may be changed in QuickBooks.

OnTime requires that the **company name** of a customer exactly match the **customer name** in QuickBooks. If a match is not found, OnTime can create a new customer record for you. Keep the names of customers consistent between OnTime and QuickBooks in order to minimize duplicate customers.

OnTime will automatically attempt to apply payments to invoices as you've specified; however, this is subject to those invoices existing in QuickBooks so that the payment in QuickBooks can be applied correctly.
Customize the Information on QuickBooks Invoices

To customize the information that is put into invoices sent to QuickBooks via OnTime, utilize the Options button as shown below:
After clicking the **Options** button, a list of fields will appear. These fields will appear in each line item in the invoice under the *description*. Check the items in the list to be included:

To rearrange a field’s order of appearance in the list, select and drag the field to the desired placement:

**Invoice line item date**: May be either the submission date or delivery date of the order

**Place options on separate line items**: Creates a line item on the invoice for the order and lists the base price. A new line item will then be added for each price modifier on the order, with prices listed individually.
Always ask before creating new customers: OnTime will try to find exact matches for customers already in QuickBooks. If an exact match is not found, OnTime will automatically create the customer in QuickBooks. If this option is checked, a prompt will appear each time a new customer needs to be created in QuickBooks.

Always ask before creating new service items: OnTime will try to find exact matches for service items already in QuickBooks. OnTime treats price modifiers on an order as service items in QuickBooks. If an exact match is not found, then OnTime will automatically create the service item in QuickBooks. If this option is checked a prompt will appear each time a new service item needs to be created in QuickBooks.

Click OK to save the changes.
Administration and Customization

Every company’s specific business methods vary slightly. This section describes some ways that OnTime may be changed to adhere to specific company business styles.

Starting OnTime Dispatch with Command Line Arguments

OnTime Dispatch may be started using command line arguments that contain log in information. This functionality makes logging into different accounts quicker and helps to frequently switch between company accounts. This option allows OnTime Dispatch to launch from another application.

The following arguments are available:

- \( c: \)
The Company ID

- \( u: \)
The User Name

- \( p: \)
The Password

To Launch OnTime Dispatch Using Command Line Arguments

Launch the OnTime Dispatch executable file, which is OTDispatch.exe, in the following format:

```
OTDispatch.exe -c:"MyCompanyID" -u:"MyUsername" -p:"MyPassword"
```
Chapter 9: Troubleshooting

OnTime may occasionally behave in unexpected ways. Gathering information for troubleshooting is an important step to help find a solution. Information gleaned through attempted troubleshooting can also help to explain the issue if contacting OnTime Technical Support becomes necessary. This section includes some practical troubleshooting suggestions.

How to Rebuild the Data File

The data file may need to be rebuilt on occasion. This rebuild may help your computer to take advantage of new features that OnTime will sometimes implement and often resolve synchronization issues.

**Note:** If any information from OnTime has been added, modified, or removed since the last time OnTime was synchronized with the OnTime service, be sure to perform such synchronization to ensure that those changes are saved.

The number of pending changes is viewable in the **Data File Maintenance** area, as shown here:

![Data File Management](image)
**Note:** If both *OnTime Management Suite* AND *OnTime Dispatch* are installed on the same computer, the data file does not need to be rebuilt in both programs. Because both programs share the same data file, it can be rebuilt in either one of the programs.

**How to Rebuild the Data File in *OnTime Management Suite***

1. Go to the **Data** tab in the ribbon
2. Click on the **Advanced** button
3. Click **Rebuild Data File**

4. The following message will appear asking for confirmation

5. Click **OK** to continue
6. At this point, the rebuild may proceed and a progress indicator will appear in the lower right corner of the application. Once it reaches 100% the rebuild should be completed
7. If a lock cannot be made on the data file, another message box may appear asking to restart the program to complete the process. If that message appears, close down all OnTime applications running on the computer – both *Management Suite* and *Dispatch*
8. Open and sign in to the OnTime Management Suite program only. Do not start both programs. Once signed in, a message indicating that the rebuild is in progress should appear. The rebuild will be completed when the progress indicator in the lower right corner of the application window has reached 100%.

**How to Rebuild the Data File in OnTime Dispatch**

1. Go to the Data tab in the ribbon
2. Click on the Advanced button
3. Click Rebuild Data File

4. The following message will appear asking for confirmation

5. Click OK to continue
6. At this point, the rebuild may proceed and a progress indicator will appear in the lower right corner of the application. Once it reaches 100% the rebuild should be completed
7. If a lock cannot be made on the data file, another message box may appear asking to restart the program to complete the process. If that message appears, close down all OnTime applications running on the computer – both Management Suite and Dispatch.
8. Open and sign in to the *OnTime Management Suite* program only. Do not start both programs. Once signed in, a message indicating that the rebuild is in progress should appear. The rebuild will be completed when the progress indicator in the lower right corner of the application window has reached 100%.

**Troubleshooting Networking and Internet Issues**

OnTime desktop applications’ built-in network diagnostic tools offer assistance with troubleshooting networking problems. If the performance of OnTime across your network and internet connection is inadequate, running the test in the utility will help to diagnose the problem’s source. This information also helps Vesigo technical support personnel resolve connectivity issues.

If problems with connection to the OnTime service are possible, run this utility and then contact Vesigo technical support with the details. To access this feature:

From *OnTime Management Suite*:

1. Start *OnTime Management Suite*
2. From the **Help** tab in the ribbon, choose **Troubleshoot Network Problems**
3. On the resulting window, click the **Start Test** button. It may take a few minutes to complete
From OnTime Dispatch:

1. Start OnTime Dispatch
2. From the Help tab in the ribbon, choose Troubleshoot Network Problems
3. On the resulting window, click the Start Test button. It may take a few minutes to complete